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Notices

BioTek Instruments, Inc.

Highland Park, P.O. Box 998

Winooski, Vermont  05404-0998  USA

All Rights Reserved

© 2013, BioTek® Instruments, Incorporated.  No part of this publication may be
reproduced, transcribed, or transmitted in any form, or by any means electronic
or mechanical, including photocopying and recording, for any purpose other
than the purchaser’s use without written permission of BioTek Instruments, Inc.

Trademarks

BioTek® is a registered trademark and 405™ Microplate Washer LS is a
trademark of BioTek Instruments, Inc.

Microsoft®, Internet Explorer®, Windows®, Windows 7, Windows Vista®,
Windows XP, and Excel® are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

All other trademarks are the property of their respective holders.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a
commitment by BioTek Instruments, Inc. Changes made to the information in
this document will be incorporated in new editions of the publication.  No
responsibility is assumed by BioTek for the use or reliability of software or
equipment that is not supplied by BioTek or its affiliated dealers.

405™ Microplate Washer LS



Notices| iii

Contents

Notices ii
All Rights Reserved ii
Trademarks ii
Restrictions and Liabilities ii

Contact Information viii
Customer Service and Sales viii
Service/TAC viii
European Coordination Center/Authorized European Representative viii

Document Conventions ix
Document Revision History ix
Intended Use Statement ix
Quality Control x
Warranty and Product Registration x
Repackaging and Shipping x
Warnings x

Hazards and Precautions xi
Hazards xi
Precautions xii

CE Mark xiv
Directive 2004/108/EC: Electromagnetic Compatibility xiv
Directive 2006/95/EC Low Voltage (Safety) xv
Directive 2002/96/EC: Waste Electrical and Electronic Equipment xv
Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use) xv

Electromagnetic Interference and Susceptibility xv
USA FCC CLASS A xv
Canadian Department of Communications Class A xvi
User Safety xvi

Safety Symbols xvii
Introduction 1
Introducing the 405™ Microplate Washer LS 2
Instrument Models 3

BioStack Compatibility 3
Package Contents 5
Waste and Dispense System Accessories 6

Optional Accessories 7
Physical Specifications 9
Performance Specifications 10
BioTek's Customer Resource Center 12

Installation 13
Unpack and Inspect the Instrument 14
Remove the Shipping Hardware 14
Setting Up the 405 LS 18
Install the Microplate Carrier 18
Connect the Vacuum Pump, Tubes, and Bottles 18
Waste System 19

BioTek Instruments, Inc.



iv | 405 LS Operator's Manual

Install the Vacuum Line Filter 21
Install the Fluid Supply System 22
Final Check 24
Attach the Mist Shield 24

Install Software/Connect to Computer 25
Connect to Host Computer 25

Connect to Power 26
Define Instrument Settings 26
LHC Users Only 26
Standard Vacuum Pump Users 27
Define Startup Preferences (LHC users only) 27

Verify Performance 29
Verify the Washer 30
Run the Verify Test ("Q" Models Only) 30

Repacking the 405 Washer 32
Operation 37
Basic Operation 38
About the 405 LS Wash Step 38

Optimize Performance 39
405 Recommendations for Priming the Washer 39
Optimize protocols to improve evacuation 40
Running Predefined Protocols 41
Creating Protocols: Washing, Aspirating and Dispensing Fluid 41
LHC Users Only: Customize the Predefined Protocols 41

Predefined Protocols Listing 43
Predefined Sample Protocols 44
Introducing the 405 LS Keypad 46
Quick Wash (Keypad only) 47
Quick Prime (Keypad only) 48
Create or Edit a Protocol (Keypad Only) 48
How to name a protocol (Keypad only) 49
Define the Plate Type and Plate Map (or Partial Plate) 50
How to shake the plate 51
How to enter negative numbers (Keypad only) 52
How to copy a protocol 52
How to delete a protocol 52

Using LHC to Control the 405™ Washer 54
Introducing the LHC Workspace 54
Communications Port 55
405 Steps 55

LHC Protocols 56
LHC Protocols Explained 57
Target Instrument Settings 58
How to define a Protocol (LHC only) 59
How to use the Adjust Utility- LHC 60
Upload-Download Protocols (LHC Only) 62
Wash Step Parameters Table 62

405™ Microplate Washer LS



Notices| v

Shake/Soak Step Parameters 66
Pre-Dispense 67
Washer Flow Rates 68
How to define a Final Aspiration step 69
Add a secondary aspiration to a wash cycle 70
Bottom Wash 70

Verify Performance 72
Handling the Verify Test Plate 73
Verify™ Technology Flowchart Diagram 75
Verify Test Corrective Action 75
About Verify™ Technology 76
Sensitivity: Verify Sensor vs. Absorbance Reader 78

Configure Verify™ Technology Utilities 79
Operating with the BioStack 81
BioStack Alignment Utility 82

Cell Wash 84
Cell Wash Strategies 85

Biomagnetic Separation - Magnetic Bead Assays 89
Perform Magnetic Bead Assays 90
Optimize Magnetic Bead Protocols 90
Flat Magnets 91
Ring Magnets 92
Magnet Height Offset 93
Determine Magnet Height Offset 93

Manifold Stop Screw Adjustment Kit 94
Vacuum Filtration for Filter Plate Assays 97
Install the side bracket 98
Set up the Vacuum Filtration module 99
Enable Vacuum Filtration 101
Create a Vacuum Filtration Protocol 101
Install Vacuum Filtration Plate Carrier 103
Control the Vacuum Level 104

Washer Settings 105
Change the Washer Manifold Setting (Keypad) 107
Change the Plate Carrier Setting (Keypad) 107
Change the Plate Clearance Setting (Keypad) 108

Adjust Utility 108
Run the Adjust Utility (Using the Keypad) 109

Plate Types and Processing Patterns 110
Plate Types Table 111
About Wash Processing Patterns 111

Maintenance 115
Overview 117
Recommended Maintenance Schedule 119
Daily Maintenance 121
Overnight/Multi-Day Maintenance 121
AutoPrime 122

BioTek Instruments, Inc.



vi | 405 LS Operator's Manual

AutoPrime for Overnight-Weekend Maintenance 123
Turn on AutoPrime for the Washer 123

Removing Protein Residuals and Fungi Growth 124
AutoClean the Washer 125
Quick Clean (Keypad Only) 126
Create an AutoClean protocol 127

Periodic Maintenance 128
Clean the Bottles 128
Clean the Plate Carrier 129
Clean the Vacuum Filtration Carrier 129
Clean the exterior surfaces and mist shield 130
Clean the Buffer Bottle Filter 130

Remove and clean the washer manifold 131
Maintaining the Vacuum Filtration System 133
Clean the Vacuum Filtration Carrier 133

Maintain the Verify™ Technology Components 133
Clean the Verify™ Level Sensor 133

Replacement Procedure for Verify Test Plate 134
Volume coefficients - Slope and Offset 137

Decontamination 138
Tools and Supplies 138

Decontaminate Exterior Surfaces 139
Decontaminate Tubing and Manifold 140
Alternate Decontamination Procedure for Tubing and Manifold 141

Decontaminate the Vacuum Filtration System 142
Long Shutdown Procedure (Prepare for Storage or Shipment) 143
Storing the Instrument 144
Replace Components 144
Remove/Change Wash Manifold 145
Replace the Vacuum Pump Fuse 145
Vacuum Filtration Carrier: Replace the Gasket 146

Qualification 147
Qualification Overview 148
Qualification Schedule 149
System Self-Test, Verify Information 149
Record Basecode 150

Sensor Test: Fluid, Waste, Plate Detection 150
Ultrasonic Cleaner Test 151
Liquid Testing the 405™ Microplate Washer LS 152
Which Tests to Perform? 152
Important Recommendations for All Liquid Tests 153

Washer Liquid Tests 154
Dispense Precision Test 154
Evacuation Efficiency Test 154
Predefined Test Protocols 154
Washer Qualification Test Materials 155
Dispense Precision Test (96) 157

405™ Microplate Washer LS



Notices| vii

Evacuation Efficiency Test (96) 158
Evacuation Diagnostic Test 159
Buffer Switching Dispense Test 160
Dispense Precision Test (192) 161
Evacuation Efficiency Test (192) 162
Evacuation Diagnostic Test (192) 163

Vacuum Filtration Evacuation Efficiency Test 165
Qualify the Verify™ Technology Sensor 167

Troubleshooting 179
Troubleshooting 180
General Operation Troubleshooting 182
Washer Problems 183
Communication Errors 188

Error Codes 191
System Error Codes 192
405 LS-LHC Software Error Codes 200

205

BioTek Instruments, Inc.

maddenm
Typewritten Text

maddenm
Typewritten Text
Index .............................................................................................................

maddenm
Typewritten Text



viii | 405 LS Operator's Manual

Contact Information

BioTek Instruments, Inc.
Highland Park, P.O. Box 998

Winooski, Vermont  05404-0998  USA

Customer Service and Sales

Internet: www.biotek.com

Phone: 888-451-5171 (toll free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-655-7941

E-Mail: customercare@biotek.com

Service/TAC

Phone: 800-242-4685 (toll free in the U.S.)

802-655-4740 (outside the U.S.)

Fax: 802-654-0638

E-Mail: tac@biotek.com

European Coordination Center/Authorized European Representative

BioTek Instruments GmbH

Kocherwaldstrasse 34

D-74177 Bad Friedrichshall

Germany

Internet: www.biotek.de

Phone: +49 (0) 7136 9680

Fax: +49 (0) 7136 968 111

E-Mail: info@biotek.de
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Document Conventions

This manual uses the following typographic conventions:

nThis note format calls attention to important information.

Warnings are presented in this style to call attention to potential hazards and other
safety concerns.

This icon calls attention to important safety information.

Tips and suggestions for improving performance are formatted this way.

Navigation instructions: how to get to the function being described

nWater: Daily maintenance is the key to keeping the liquid handler performing
to specifications. In the maintenance procedures provided in this manual, the
requirement to use distilled (dH2O) or deionized (DI) water can be met by
numerous water purification methods, including MilliQ™. A minimum water
purity of 2mOhm is expected.

Document Revision History

Rev Date Changes

A 5/2012 First issue

B 1/2013 Added content about BioTek's Verify™ Technology, including the Plate
Detection sensor and new shipping hardware. Added instructions for running
the Verify test, analyzing its test results, maintaining the device, replacing
the test plate and qualifying the device. Note: the vacuum filtration plate
carrier was modified to accommodate the Verify device. Pinch hazard
warning label updated. Packing materials modified for all models.

Intended Use Statement

l The 405™ Microplate Washer LS provides microplate priming, washing, and dispensing
for ELISA™, fluorescence and chemiluminescence immunoassays, cellular and
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agglutination assays.

l If the instrument has an "IVD" label it may be used for clinical and non-clinical purposes,
including research and development. If there is no such label the instrument may only be
used for research and development and non-clinical purposes.

Quality Control

It is considered good laboratory practice to run laboratory samples according to
instructions and specific recommendations included in the assay package insert for
the test to be conducted. Failure to conduct Quality Control checks could result in
erroneous test data.

Warranty and Product Registration

Please take a moment to review the Warranty information that shipped with your
product. Please also register your product with BioTek to ensure that you receive
important information and updates about the product(s) you have purchased.

You can register online through BioTek’s Customer Resource Center (CRC) at
www.biotek.com or by calling 888/451-5171 or 802/655-4740.

Repackaging and Shipping

If you need to ship the instrument to BioTek for service or repair, contact BioTek
for a Return Materials Authorization (RMA) number and use the original packing
materials. Other forms of commercially available packaging are not recommended
and can void the warranty. If the original packing materials have been damaged or
lost, contact BioTek for replacement packing.

Warnings

Operate the instrument on a level, stable surface away from excessive
humidity.
When operated in a safe environment, according to the instructions in this
document, there are no known hazards associated with the 405 LS. However,
the operator should be aware of certain situations that could result in serious
injury; these vary depending on the instrument type. See Hazards and
Precautions.

Strict adherence to instrument maintenance and qualification procedures is
required to ensure accurate dispense volumes and risk-free operation.

405™ Microplate Washer LS
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Hazards and Precautions

Hazards

The following hazards are provided to help avoid injury:

Warning! Power Rating. The instrument’s power supply or power cord must
be connected to a power receptacle that provides voltage and current within the
specified rating for the system. Use of an incompatible power receptacle may
produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a two-prong plug adapter to
connect primary power to the external power supply. Use of a two-prong
adapter disconnects the utility ground, creating a severe shock hazard. Always
connect the power cord directly to an appropriate receptacle with a functional
ground.

Warning! Service. Only qualified technical personnel should perform service
procedures on internal components.

Warning! Accessories. Only accessories which meet the manufacturer’s
specifications shall be used with the instrument.

Warning! Lubricants. Do not apply lubricants to the microplate carrier or
carrier track. Lubricant on the carrier mechanism will attract dust and other
particles, which may obstruct the carrier path and cause the instrument to
produce an error.

Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage into
internal components creates a potential for shock hazard or instrument
damage. If a spill occurs while a program is running, abort the program and
turn the instrument off. Wipe up all spills immediately. Do not operate the
instrument if internal components have been exposed to fluid.

Warning! Unspecified Use. Failure to operate this equipment according to
the guidelines and safeguards specified in this manual could result in a
hazardous condition.

Warning! Direct Drain Waste. If installed, the direct drain waste system
pumps waste fluids from the washer directly into a sink or tank, and, potentially
into public waste water systems. Because the waste may be a biohazard, you
must ensure that you are in compliance with your local or national
government’s laws regarding safe disposal of the waste.

Warning! Ultrasonic Energy. Ultrasonic energy is present in the ultrasonic
cleaner reservoir (if equipped) when AUTOCLEAN/Quick Clean programs are
running. Avoid putting your fingers in the bath. Ultrasonic energy can be
destructive to human tissue.

Warning! Software Quality Control. The operator must follow the

BioTek Instruments, Inc.
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manufacturer’s assay package insert when modifying software parameters and
establishing washing or dispensing methods. Failure to conduct quality
control checks could result in erroneous test data.

Warning! Internal Voltage. Always turn off the power switch and unplug the
power supply before cleaning the outer surface of the instrument.

Warning! Potential Biohazards. Some assays or specimens may pose a
biohazard. Adequate safety precautions should be taken as outlined in the
assay’s package insert. This hazard is noted by the symbol shown here. Always
wear safety glasses and appropriate protective equipment, such as chemically
resistant rubber gloves and apron.

Warning! Pinch Hazard. Some areas of the instrument or its components can
present pinch hazards when the instrument is operating. Depending on the
instrument or component, these areas are marked with the symbol shown here.
Keep hands/fingers clear of these areas when the instrument is operating.

Precautions

The following precautions are provided to help avoid damage to the instrument:

Caution: Service. The instrument should be serviced by BioTek authorized
service personnel. Only qualified technical personnel should perform
troubleshooting and service procedures on internal components.

Caution: Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and accessories may result in
a loss of warranty and potentially impair instrument performance or cause
damage to the instrument.

Caution: Environmental Conditions. Do not expose the instrument to
temperature extremes. For proper operation, ambient temperatures should
remain within the range listed in the Specifications section. Performance may
be adversely affected if temperatures fluctuate above or below this range.
Storage temperature limits are broader.

Caution: Sodium Hypochlorite. Do not expose any part of the instrument to
the recommended diluted sodium hypochlorite solution (bleach) for more than
20 minutes. Prolonged contact may damage the instrument surfaces. Be certain
to rinse and thoroughly wipe all surfaces.

Caution: Buffer Solution. Although many precautions have been taken to
ensure that the instrument is as corrosion-proof as possible, the instrument is
not sealed and liquids can seep into sensitive components. Make sure that any
spilled buffer solution is wiped off the instrument. Prolonged exposure to salt
solution may corrode parts of the microplate carrier, movement rail, springs,
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and other hardware.

Caution: Chemical Compatibility. Some chemicals may cause irreparable
damage to the instrument. The following chemicals have been deemed safe for
use in the instrument: buffer solutions (such as PBS), saline, surfactants,
deionized water, 70% ethyl, isopropyl, or methyl alcohol, 40% formaldehyde,
and 20% sodium hydroxide. Never use acetic acid, DMSO, or other organic
solvents. These chemicals may cause severe damage to the instrument.
Contact BioTek for more information and prior to using other questionable
chemicals.

Caution: Bovine Serum Albumin. Solutions containing proteins, such as
bovine serum albumin (BSA), will compromise the instrument’s performance
over time unless a strict maintenance protocol is adhered to. See
Maintenance procedures regarding BSA.

Caution: Power Supply. Only use the power supply shipped with the
instrument. Operate this power supply within the range of line voltages listed
on it.

Caution: Disposal. This instrument contains printed circuit boards and wiring
with lead solder. Dispose of the instrument according to Directive 2002/96/EC,
“on waste electrical and electronic equipment (WEEE),” or local ordinances.

Caution: Warranty. Failure to follow preventive maintenance protocols may
void the warranty.

Caution: Shipping Hardware. All shipping hardware (e.g., shipping bracket
etc.) must be removed before operating the instrument and reinstalled before
repackaging the instrument for shipment.

Caution: High Flow Pump Installation. DO NOT plug the High Flow vacuum
pump cable into a wall outlet!  Use the adapter provided with the pump to
connect the pump to the accessory outlet on the back of the washer. See the
Installation instructions.

Caution: Waste Sensor Port on 405 LS.  (For customers who have
purchased the BioStack Microplate Stacker.) Although the waste sensor port on
the back of the 405 LS is the same type as the 24-VDC power connector on the
back of the BioStack, if an external 24-VDC power supply is plugged into the
405 LS’s port, it will permanently damage internal components.

Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the user’s
responsibility to ensure that a compatible electromagnetic environment for this
instrument is provided and maintained in order that the device will perform as
intended.

BioTek Instruments, Inc.
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Caution: Electromagnetic Compatibility. Do not use this device in close
proximity to sources of strong electromagnetic radiation (e.g., unshielded
intentional RF sources), because these may interfere with the proper operation.

CE Mark

Based on the testing described below and information contained
herein, this instrument bears the CE mark.

nNote: See the Declaration of Conformity for specific information.

Directive 2004/108/EC: Electromagnetic Compatibility

Emissions—Class A

The system has been type-tested by an independent, accredited testing
laboratory and found to meet the requirements of EN 61326-1: Class A for
Radiated Emissions and Line Conducted Emissions.

Verification of compliance was conducted to the limits and methods of EN 55011
(CISPR 11) Class A. In a domestic environment it may cause radio interference,
in which case, you may need to mitigate the interference.

Immunity

The system has been type-tested by an independent, accredited testing
laboratory and found to meet the requirements of EN 61326-1 and EN 61326-2-6
for Immunity. Verification of compliance was conducted to the limits and
methods of the following:

EN 61000-4-2, Electrostatic Discharge

EN 61000-4-3, Radiated EM Fields

EN 61000-4-4, Electrical Fast Transient/Burst

EN 61000-4-5, Surge Immunity

EN 61000-4-6, Conducted Disturbances from RFI

EN 61000-4-8 Power Frequency Magnetic Field Immunity Test

EN 61000-4-11, Voltage Dips, Short Interruptions and Variations

405™ Microplate Washer LS



Electromagnetic Interference and Susceptibility| xv

Directive 2006/95/EC Low Voltage (Safety)

The system has been type-tested by an independent testing laboratory and was
found to meet the requirements of this Directive. Verification of compliance was
conducted to the limits and methods of the following:

EN 61010-1, “Safety requirement for electrical equipment for measurement,
control and laboratory use. Part 1, General requirements.”

Directive 2002/96/EC: Waste Electrical and Electronic Equipment

Disposal Notice: This instrument contains printed circuit boards and wiring with
lead solder. Dispose of the instrument according to Directive 2002/96/EC, “on
waste electrical and electronic equipment (WEEE)” or local ordinances.

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use)

l Product registration with competent authorities.
l Traceability to the U.S. National Institute of Standards and Technology (NIST).

EN 61010-2-101 Particular requirements for in vitro diagnostic (IVD) medical
equipment.

Electromagnetic Interference and Susceptibility

USA FCC CLASS A

RADIO AND TELEVISION INTERFERENCE

NOTE: This equipment has been tested and found to comply with the limits
for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment
generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference, in which case the user
will be required to correct the interference at their own expense.

In order to maintain compliance with FCC regulations shielded cables must be
used with this equipment. Operation with non-approved equipment or

BioTek Instruments, Inc.
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unshielded cables is likely to result in interference to radio and television
reception.

Canadian Department of Communications Class A

This digital apparatus does not exceed Class A limits for radio emissions from
digital apparatus set out in the Radio Interference Regulations of the Canadian
Department of Communications.

Le present appareil numerique n'émet pas de bruits radioelectriques depassant
les limites applicables aux appareils numerique de la Class A prescrites dans
le Reglement sur le brouillage radioelectrique edicte par le ministere des
Communications du Canada.

User Safety

This device has been type-tested by an independent laboratory and found to meet
the requirements of the following:

l Underwriters Laboratories UL 61010-1 “Safety requirements for electrical
equipment for measurement, control and laboratory use; Part 1: general
requirements.”

l Canadian Standards Association CAN/CSA C22.2 No. 61010-1 “Safety
requirements for electrical equipment for measurement, control and
laboratory use; Part 1: general requirements.”

l EN 61010 Standards, see CE Mark on page xiv.

405™ Microplate Washer LS
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Safety Symbols

Some of these symbols appear on the instrument or accessories:

Alternating current
Courant alternatif
Wechselstrom
Corrientealterna
Correntealternata

Both direct and alternating current
Courant continu et courant alternatif
Gleich - undWechselstrom
Corriente continua y corrientealterna
Corrente continua e
correntealternata

Direct current
Courant continu
Gleichstrom
Corriente continua
Corrente continua

Earth ground terminal
Borne de terre
Erde (Betriebserde)
Borne de tierra
Terra (difunzionamento)

On (Supply)
Marche (alimentation)
Ein (VerbindungmitdemNetz)
Conectado
Chiuso

Protective conductor terminal
Borne de terre de protection
Schutzleiteranschluss
Borne de tierra de protección
Terra diprotezione

Off (Supply)
Arrêt (alimentation)
Aus (TrennungvomNetz)
Desconectado
Aperto
(scon-
nessionedallaretedialimentazione)

Caution (refer to accompanying
documents)
Attention (voir documents
d’accompanement)
AchtungsieheBegleitpapiere
Atención (vease los
documentosincluidos)
Attenzione, consultare la doc annessa

Warning, risk of electric shock
Attention, risque de choc électrique
Gefährlicheelektrischeschlag
Precaución, riesgo de
sacudidaeléctrica
Attenzione, rischiodiscossaelettrica

Warning, risk of crushing or pinching
Attention, risqued’écrasement et
pincement
Warnen, Gefahr des Zerquetschens
und Klemmen
Precaución, riesgo del
machacamiento y sejeción
Attenzione,
rischiodischiacciareedintrappolarsi

Warning, hot surface
Attention, surface chaude
Warnen, heißeOberfläche
Precaución, superficiecaliente
Attenzione, superficiecalda

Warning, potential biohazards
Attention,
risquesbiologiquespotentiels
Warnung!
MoeglichebiologischeGiftstoffe
Atención, riesgosbiológicos
Attenzione, rischiobiologico

In vitro diagnostic medical device
Dispositif médical de diagnostic in
vitro
Medizinisches In-Vitro-Diagnostikum
Dispositivo médico de diagnóstico in
vitro
Dispositivo medico diagnostico in

Separate collection for electrical and
electronic equipment
Les équipements électriques et
électroniques font l’objet d’une
collecte sélective
Getrennte Sammlung von Elektro-
und Elektronikgeräten

BioTek Instruments, Inc.
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vitro Recogida selectiva de aparatos
eléctricos y electrónicos
Raccolta separata delle
apparecchiature elettriche ed
elettroniche

Consult instructions for use
Consulter la notice d’emploi
Gebrauchsanweisung beachten
Consultar las instrucciones de uso
Consultare le istruzioni per uso
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Introduction

Thank you for purchasing the 405™ Microplate Washer LS.
This chapter describes the instrument's features and
specifications and includes important contact information.
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Introducing the 405™ Microplate Washer LS

Let's get started by identifying the main components of the 405 LS microplate
washer:

Component Description

1 Washer manifold 96- or 192-tube devices to aspirate and dispense fluid.

2 Priming trough and
ultrasonic bath, when
equipped.

Certain models support BioTek's patent-pending Ultrasonic
Advantage™ ultrasonic cleaning of the wash manifold.

3 Microplate (Plate) Carrier Holds standard microplates for processing and
accommodates a magnet for biomagnetic-separation
assays.*

4 Keypad One of two ways to control the instrument; the other way is
LHC.

405™ Microplate Washer LS
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*The special vacuum filtration carrier must be installed to perform filtration assays.

Instrument Models

A label on the side of the 405 LS identifies its model. BioTek distinguishes the
variations between instrument models using this letter scheme:

R “Standard” model to wash 96-well microplates. It has one manifold with 96 sets of
dispense and aspirate tubes.

U Dual-Action™ or “Select” models to wash 96- and 384-well plates. It has two sets of 96
dispense and aspirate tubes arranged in two manifolds that move independently of
each other and support overflow wash and overfill protection for the most demanding
assays.

HT 384-well microplate washer that is ideal for high throughput washing. It includes
BioTek’s patented Dual-Action manifold fitted with 192 aspirate and dispense tubes and
allows overflow wash and overfill protection for the most demanding assays.

V “V” models are equipped with Buffer Switching valves that support up to four separate
reagents for complex assay requirements and to automate maintenance routines.

S “S” models are equipped with BioTek’s patent-pending Ultrasonic Advantage™
feature—a built-in ultrasonic cleaner (or sonicator) for enhanced maintenance of the
manifold tubes. A stainless steel cleaning reservoir with an ultrasonic transducer
bonded to its bottom is mounted on the washer.

Q “Q” models are equipped with BioTek’s Verify™ Clog Detection Technology that uses a
liquid-level sensor to quickly detect clogs in the wash manifold’s aspirate and dispense
tubes. Requires BioTek's Liquid Handling Control™ (LHC) software.

BioStack Compatibility

The 405 LS is compatible with BioTek’s BioStack Microplate Stacker. The BioStack
can rapidly transfer microplates one-at-a-time to and from the instrument, and
includes:

l Removable stacks (one input and one output).

l Optional restacking of plates to maintain correct sequencing.

l The ability to continue processing plates following the aborting/failure of
one plate.

l The ability to pause processing to allow the user to add more plates to the
input stack or to remove some from the output stack.

BioTek Instruments, Inc.
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If you have purchased the BioStack to operate with the 405 LS, refer to the BioStack
Operator’s Manual for instructions on configuring the 405 LS to run with the
BioStack. To help you get started: See Operating with the BioStack on page 81.

If you are interested in purchasing the BioStack, contact your local BioTek dealer
for more information or visit our website at www.biotek.com.

405™ Microplate Washer LS
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Package Contents

nPart numbers and package contents are subject to change and vary according
to instrument model. Please contact BioTek Customer Care if you have any
questions.

Description PN

Power cord (part numbers vary by country of use) Varies

USB cable (USB Virtual COM Port Driver Software & instructions) 75108

Microplate carrier Varies

Mist shield 1172017

Accessory kit 1170012

Stylus: for cleaning washer manifold aspirate tubes 7102108

Stylus: for cleaning washer manifold tubes 2872304

Stylus: for cleaning 192-tube dispense manifold 7102139

Shipping bracket - model dependent 7102138
1242018 or
1242021
1242032 and
1242019

Hex wrench: 9/64” 48434

Spare fuses (5) 46055

Verify Test Plate for "Q" models only 01588

Manifold Stop Screw Kit (Required for Vacuum Filtration, 384-Well
PCR processing and magnetic bead assays.)

1170011

405™ LS Getting Started Guide (and Operator's Manual on CD - PN
11710015)

1171014

nSome components are model specific, they ship only with certain instrument
models.

BioTek Instruments, Inc.
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Waste and Dispense System Accessories

Part
Number Description

Standard Vacuum Pump Systems:

1170530 Complete Dispense/Waste System 115V/230V, 4L Bottles, including:

7100746 Waste: 4L bottles (2, one with sensor)

1170529 Dispense: 4L bottles with filters (2)

7100746 Complete Waste System 115V/230V, 4L Bottles, including:

7100543 Waste: 4L bottles (2, one with sensor)

7103024 Vacuum pump 115V/230V

1170535 Complete Dispense/Waste System 115V/230V, 10L Bottles, including:

1170534 Waste: 10L bottle (1), 4L bottle with sensor (1)

1170528 Dispense: 10L bottles (2)

1170534 Complete Waste System 115V/230V, 10L Bottles, including:

7100582 Waste: 10L bottle (1), 4L bottle with sensor

7103024 Vacuum pump 115V/230V

High Flow Vacuum Pump Systems:

1170532 Complete Dispense/High Flow Waste System 115V/230V, 4L Bottles,
including:

7100753 Waste: 4L bottles (2, one with sensor)

1170529 Dispense: 4L bottles with filters (2)

7100753 Complete High Flow Waste System 115V/230V, 4L Bottles, including:

7100543 Waste: 4L bottles (2, one with sensor)

7100754 High-flow vacuum pump 115V/230V

1170533 Complete Dispense/High Flow Waste System 115V/230V, 10L Bottles,
including:

1170531 Waste: 10L bottle (1), 4L bottle with sensor

1170528 Dispense: 10L bottles (2)

1170531 Complete High Flow Waste System 115V/230V, 10L Bottles, including:

405™ Microplate Washer LS
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Part
Number Description

7100754 High-flow vacuum pump 115V/230V

7100582 Waste: 10L bottle (1), 4L bottle with sensor (1)

Direct Drain Vacuum Pump Systems:

1170536 Complete Dispense/Direct Drain Waste System 115V/230V, 4L Bottles,
including:

1170529 Dispense: 4L bottles with filters (2)

Direct drain vacuum pump & tubing

1170537 Complete Dispense/Direct Drain Waste System 115V/230V, 10L Bottles,
including:

1170528 Dispense: 10L bottles with filters (2)

Direct drain vacuum pump & tubing

Notes:

1) Models with Buffer Switching receive a dispense system. Only a waste system must be
ordered separately.

2) High-flow waste system may be necessary for 384-well washing with buffers not
containing surfactant.

3) Direct Drain Waste System: use restricted to 96-tube single manifold models (i.e. 405
LS).

Optional Accessories

nPart numbers and package contents are subject to change and vary according
to instrument model. Please contact BioTek Customer Care if you have any
questions.

General Instrument Accessories

Description PN

BioTek liquid testing solutions for
instrument qualification tests

Wetting
Agent

7773002

Blue Test
Dye

7773001

BioTek Instruments, Inc.
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Description PN

Liquid Handling Control™ Software LHC2

BioStack™ Microplate Stacker and integration kit Biostack

Installation-Operational-Performance Qualification (IQ-
OQ-PQ) package

1170543 

Magnetic Bead Assay Accessories

Accessory PN

Magnets:

384-well Flat Magnet 7103017

384-well Ring Magnet 7102215

96-well Flat Magnet 7103016

96-well Ring Magnet 7102216

Vacuum Filtration Kit

Description PN

-- 96-well Only 1170008

-- 96- and 384-well 1170009

Verify™ Technology Accessories

Description PN

Verify Test Plate Replacement Kit 1240001

Miscellaneous Accessories

Description PN

96-tube Manifold Kit - Replacement kit for 405 Select to support
384-well non-surfactant buffer washing (Tube-in-Tube).

1172046S

96-Tube 7-Degree Dual Manifold Upgrade Kit - Additional
manifold for 405 HT for 96-well washing. (Tube-in-Tube)

1170010

4L Dispense Bottle w/filter 1173031

Cap for 4L Dispense Bottle w/filter 1173003

405™ Microplate Washer LS
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Description PN

10L Dispense Bottle w/filter 1173000

Cap for 10L Dispense Bottle w/filter 1173002

Dispense Tubing Set - 1 Buffer 7100538

Dispense Tubing Set - 4 Buffers (For Buffer Switching models.) 7100537

4L Waste Bottle 7100534

Cap for Waste Bottle, 4L (Also fits 10L and 20L bottles.) 7100531

Waste Bottle with Level Sensing, 4L 7100542

Cap for Waste Bottle with Level Sensing, 4L 7100544

10L Waste Bottle and Tubing 7100557

20L Waste Bottle and Tubing 7100556

Waste Tubing Set 7100533

Vacuum Line Filter for Waste Tubing 48294

Vacuum Gauge/Regulator (For use with house vacuum.) 4030551

Silencing Muffler for Vacuum Pump (For use with P/N 7103024
pump.)

01113

Fluid filter for dispense bottles (does not include stainless steel
adaptor 1172031)

01310

Physical Specifications

Labware

Microplates 96-well, 384-well that comply with SBS microplate standards 1-
2004, 2-2004, 3-2004, and 4-2004.

Microstrips 1 x 8, 1 x 12

Microwells Flat, round, "V” bottom

Hardware & Environmental

User Interface 2-line x 24 character LCD screen, 26 alphanumeric soft keys

Power Supply The instrument uses two internal power supplies: 24-volt 60 watt and
48-volt 60 watt. These supplies are compatible with 100-240 V~; 50-

BioTek Instruments, Inc.
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Hardware & Environmental

60 Hz.

Accessory Outlet ≤ 5.0 A, used for vacuum pump

Dimensions
(W x D x H)

14 x 17 x 10 inches (36 cm x 43 cm x 25 cm)

Weight (≤) 32 lb (14.5 kg)/36 lb with Buffer Switching (16.3 kg)

Operating
Conditions

10° - 40°C (50° - 104°F)

Relative Humidity The instrument should be operated in a non-condensing humid
environment having a maximum relative humidity of 80% at
temperatures up to 31°C decreasing linearly to 50% relative humidity
at 40°C.

Manifold Type

96-tube Single or Dual manifold with 96 sets of aspirate and dispense tubes
arranged in an 8x12 array. Single manifolds can only process 96-well
microplates; dual manifolds can process 96- and 384-well plates.

192-tube Dual manifold with 192 sets of aspirate and dispense tubes arranged
in a 16 x 12 array can only process 384-well plates.

Waste bottle volume 4, 10, or 20 liters, depending on the accessory package, (2
bottles, one with sensor)

Supply bottle volume 2 4L or 10L bottles (4 bottles w/ Buffer Switching)

Performance Specifications

Average Residual Volume (Evacuation Efficiency)

96-Tube Manifold
(Single and Dual)

Average residual volume in the microwells is ≤ 2 µL per well after a
3-cycle wash, when 300 µL of deionized water with 0.1% Tween 20®,
or buffer equivalent, is dispensed per well into a Costar® 96-well
flat-bottom plate. The aspirate height adjustment is optimized for the
plate prior to testing.

192-Tube
Manifold

Average residual volume in the microwells is ≤2 µL per well after a 3-
cycle wash, when 100 µL of deionized water with 0.1% Tween 20, or
buffer equivalent, is dispensed per well into a Costar 384-well flat-
bottom plate. The aspirate height adjustment is optimized for the

405™ Microplate Washer LS
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Average Residual Volume (Evacuation Efficiency)

plate prior to testing.

Vacuum Filtration Evacuation Efficiency

96-Well Filter Plates Average increased weight of the plate is ≤ 1.2 grams after
dispensing 300 µL of deionized water per well into a Millipore®
MSHVN4450 96-well 0.45µm plates (PN 98258) and vacuum
aspirated for 30 seconds and blotted on a paper towel.

384-Well Filter Plates Average increased weight of the plate is ≤ 4.0 grams after
dispensing 80 µL of deionized water per well into a Millipore®
MZFCN0W10 384-well 1.2µm plates (PN 98287) and vacuum
aspirated for 10 seconds and blotted on a paper towel.

Dispense Precision

96-Tube Manifold ≤ 3.0% CV when dispensing 300 µL per well of deionized water with
0.1% Tween 20, with FD&C #1 blue dye at rate 6 into a Costar 96-well
flat-bottomed plate. The absorbance of the solution is read at 630 nm
and 450 nm reference.

192-Tube
Manifold

≤ 4.0% CV when dispensing 80 µL per well of deionized water with
0.1% Tween 20, with FD&C #1 blue dye at rate 7 into a Costar 384-
well flat-bottomed plate. The absorbance of the solution is read at 630
nm and 450 nm reference.

Verify™ Clog Detection Technology

Timing A Verify test shall be completed in less than 5 minutes from initiation
until test results are displayed.

Performance The Verify level sensor measurement shall have a repeatability standard
deviation of σmeasurement <0.14 mm (9.0 µL for 8X8 square well plate),
where the σmeasurement applies to a relative volume measurement, i.e.
the delta between two volumes.

BioTek Instruments, Inc.
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BioTek's Customer Resource Center

BioTek's Customer Resource Center (CRC) continues our tradition of superior
service and support. After an easy registration process, you can access lots of
useful information about your BioTek microplate instrumentation and software. On
the secure CRC website, you can:

l Track orders

l Access warranty information, user manuals and software updates

l Download technical and application information

l Maintain equipment inventory (product registration)

l Request service and technical support

l View service history

l And much more!

Register at https://customer.biotek.com

405™ Microplate Washer LS
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Unpack and Inspect the Instrument

Important: Save all packaging materials. If you need to ship the instrument or
accessories to BioTek for repair or replacement, you must use the original packaging.
Using other forms of commercially available packaging is not recommended and can void
the warranty. Improper packaging that results in damage to the instrument may lead to
additional charges. Refer to the operator's manual for repacking instructions.

Inspect the shipping box, packaging, instrument, and accessories for signs of
damage.

If the 405™ Microplate Washer LS is damaged, notify the carrier and your BioTek
representative. Keep the shipping cartons and packing material for the carrier’s
inspection. BioTek will arrange for repair or replacement of your instrument
immediately, before the shipping-related claim is settled.

1. Unpack the boxes containing the instrument and other equipment:

l 405™ Microplate Washer LS and accessories

l Vacuum Pump and accessories

l Vacuum Filtration Accessory Kit

2. Place all packing materials back into the shipping boxes for reuse if necessary.

Refer to the Package Contents on page 5 to make sure you have all expected
equipment.

Remove the Shipping Hardware

The 405 LS is shipped with a protective manifold shipping bracket. Remove this
bracket before using the washer and reinstall it prior to shipping to avoid
irreparable damage to the manifold. Failure to remove and reinstall the shipping
bracket may void your warranty.

Keep in mind that you must reinstall the shipping hardware and use the original
shipping material if it is necessary to return the instrument to BioTek for service or
repair.

405™ Microplate Washer LS



Remove the Shipping Hardware | 15

Remove the manifold shipping bracket

1. Use the 9/64” (3.57 mm) hex wrench
to unscrew the cap screws at the base
of the shipping bracket and remove
it.

2. Slide the bracket towards you and
remove.

nMost brackets are black, unlike
the one shown here.

3. Store the bracket: mount it on the
back panel, on the studs provided.

nDirect Drain Waste System: if you are
using the direct drain waste method,
wait till later to mount the shipping
bracket. For direct drain, an
intermediate collection bottle is
attached to the washer using the same
studs as the shipping bracket. See the
Direct Drain Kit instructions.

405 LS with Verify™ Technology "Q"
Models
"Q" Models
have three
shipping
brackets:
remove two
before
powering
up, and the
last one
after start
up.

BioTek Instruments, Inc.
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1. Use the 9/64” hex wrench to unscrew
the cap screws and remove the bracket
on the side of the wash manifold that
holds the Verify sensor in place.

2. Remove the large bracket in front
holding the wash manifold: Remove the
three screws. Slightly lift the manifold(s)
to release the bracket from the base, and
pull it away from the manifold(s).

3. Set the brackets, screws and washers
aside.

Follow instructions to set up the washer, e.g.
install the vacuum pump and tubing. Then,
perform Step 4, below.

4. When you're ready to power up the
instrument, plug it in and turn it on.
Release the latch on the left side of the
Verify™ sensor unit, and to lift it up to
remove the third shipping bracket.

5. For safe keeping, put the cap screws
and washers for the two thin brackets in
the studs provided on the longest, last-
removed bracket.

6. Put the manifold bracket's top screw
back in its hole. Save the two longer
screws for storing all the brackets on the
back of the instrument.

405™ Microplate Washer LS
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Layer the brackets on top of each
other on the studs on the back.

7. Store the brackets: mount them on the
back panel on the studs provided.
Beginning with the longest (3rd)
bracket, layer the brackets on top of
each other, and use the longest screws
to secure them in place.

BioTek Instruments, Inc.
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Setting Up the 405 LS

Important: Avoid excessive humidity. Condensation directly on the sensitive
electronic circuits can cause the instrument to fail internal self checks.

Install the instrument on a level, stable surface in an area where ambient
temperatures between 10°C (50°F) and 40°C (104°F) can be maintained.

The instrument should be operated in a non-condensing humid environment
having a maximum relative humidity of 80% at temperatures up to 31°C
decreasing linearly to 50% relative humidity at 40°C.

Install the Microplate Carrier

nMake sure the serial number on the underside of the plate carrier matches the
washer's serial number. If the numbers do not match, call BioTek
TAC immediately.

1. Line up the tab on the underside of the carrier with the slot on the carrier
transport block.

2. Put the two carrier rail guides onto the transport rail. The tab should sit in the
slot.

Connect the Vacuum Pump, Tubes, and Bottles

For optimal operation of the 405 LS, all tubing, cables, and fittings for the fluid
supply and waste systems must be properly connected. This image illustrates

405™ Microplate Washer LS
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the rear panel of the instrument and the locations of the ports and connections
for the fluid supply and waste systems.

Rear Panel

Waste System

Caution! Pump Installation. Do not plug the vacuum pump cable into a wall outlet!
Use the adapter provided with the pump to connect it to the Accessory Outlet on the
back of the instrument. This allows the 405 LS to regulate the pump, turning it on and
off as specified by the protocol.

When using a standard pump (rather than the high flow pump), set the instrument’s
Vacuum Dissipation Delay to prevent the pump from drawing excess current and
blowing the 5-amp fuse. See Define Instrument Settings  on page 26

nNote: The waste tubes have colored bands that match similarly colored dots
next to the inlet/outlet ports on the waste bottle caps to ensure the correct
connection of the tubing.

BioTek Instruments, Inc.
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Waste System

Three lengths of tubing are shipped with the waste module:

Tubing: Connects:
Short tube with yellow and green bands g The two waste bottles to each other

Long tube with green bands on both ends g Bottle without sensor to vacuum port

Long tube with yellow and orange bands g Bottle with waste sensor to the vacuum
pump

1. Locate the quick-release caps shipped inside the waste bottles and attach the
tubing to them as follows:

2. Connect the waste bottles to each other using the shortest length of tubing,
matching the colored bands on the tubing to colored dots on the caps.

3. Attach the waste sensor cable to the Waste Sensor port on the back of the
washer.

4. Attach the tube from the waste bottle with the waste sensor in its cap to the
vacuum pump.

405™ Microplate Washer LS
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5. Attach the tube from the waste bottle that does NOT have the waste sensor
in its cap to the Vacuum port on the back of the instrument.

6. Important!When installing BioTek’s vacuum pump, connect the pump’s AC
power cable to the vacuum pump Accessory Outlet on the back of the
instrument (Use the accessory outlet adapter provided, if applicable.)

7. Place the waste bottles and vacuum pump on the same horizontal plane as the
instrument or below it, such as the floor beneath the work surface. This will
help optimize performance.

8. Make sure the waste bottle’s caps are well sealed.

nBioTek strongly recommends installing the vacuum line filter to protect your
vacuum pump.

Install the Vacuum Line Filter

The optional vacuum line filter (PN 48294) can be installed halfway between the
last waste bottle (overflow bottle) and the vacuum pump.

To do this, cut the tubing and insert the filter, noting the direction of flow. The flow
arrow on the filter should point toward the vacuum pump.

In the event of a fluid overflow, the filter should prevent the destruction of the
vacuum pump’s internal components. If an overflow does occur, check the filter for
trapped fluid. If fluid is found in the filter, remove the filter and drain using the
small white nut on top of the filter. Tighten the white nut and reinstall the filter.

BioTek Instruments, Inc.
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Install the Fluid Supply System

Prepare the supply bottles and tubing:

1. Remove the Quick Release Connector
from its bag inside the supply bottle
and connect it to the raw supply
tubing provided.

l You may need to cut the tubing to the
desired length.

2. Snap the connector into the top of the
supply bottle.

405™ Microplate Washer LS
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Make sure you hear the
connector click!

Attach the labels provided
with the washer to identify
the buffer bottles.

Note: To avoid spilling fluid when refilling bottles or changing reagents, first release the
Quick Connector from the bottle cap, use a paper towel to sop up the few drops in the
cap. Then, refill the bottle.

With Buffer Switching (4 Buffers):

1. Place the four supply
bottles on the same
surface as the
instrument.

2. Connect the tubing from
one of the supply bottles
to the “A” port on the
back of the washer.

3. Repeat step 2 with the
other three supply
bottles for “B,” “C,” and
“D” Buffers.

BioTek Instruments, Inc.
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Without Buffer Switching (1 Buffer)

1. Place the supply bottle(s) on the same
horizontal plane as the instrument.

2. Connect one the tubes to the Dispense
Fluid In port.

Final Check

l Verify that the tubing was not crimped during installation.

l Ensure that there are no loose fittings or cable connections.

Attach the Mist Shield

1. Position the mist shield so the
gaps align with the
thumbscrews. The top rests on
the two rubber pads above the
manifold.

Always lift the mist shield straight
up, not towards you, when
removing it.

405™ Microplate Washer LS
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405 LSs equipped with Verify™ Clog
Detection Technology ("Q" models) have a
smaller mist shield.

Install Software/Connect to Computer

If you purchased BioTek's Liquid Handling Control™ (LHC) Software to control the
405 LS using your personal computer (PC), please refer to the LHC Installation
Guide for complete installation and setup instructions.

Connect to Host Computer

Using the USB cable: Plug one end into the USB port labeled Computer on the
instrument and the other end into an available port on the computer.

l If the computer is connected to the Internet, turn on the instrument. Let
Windows® automatically locate and install the necessary USB drivers (follow
the online instructions), if applicable or open the link below to download the
drivers.

l Virtual Com Port (VCP) drivers for all Windows operating systems are
available at http://www.ftdichip.com/Drivers/VCP.htm

l If the computer is NOT connected to the Internet, install the drivers using the
supplied “Virtual USB Com Port” driver software CD.

nThe keypad must be displaying its “Main Menu” for the LHC to communicate
with the instrument.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You

can use USB to connect the 405 LS to the computer or the RS232 serial port to

BioTek Instruments, Inc.
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connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Connect to Power

Warning! Power Rating. The 405 LS must be connected to a power receptacle that
provides voltage and current within the specified rating for the system. Use of an
incompatible power receptacle may produce electrical shock and fire hazards.

Warning! Electrical Grounding. Never use a two-prong plug adapter to connect
primary power to the 405 LS. Use of a two-prong adapter disconnects the utility ground,
creating a severe shock hazard. Always connect the system power cord directly to a
three-prong receptacle with a functional ground.

The 405 LS supports voltage in the range of 100-240 V~ at 50-60 Hz. 

1. Plug the power cable into the power cable socket in the rear panel of the 405
LS.

2. Insert the three-prong plug into an appropriate receptacle.

Define Instrument Settings

LHC Users Only

When using the LHC to control the 405 LS, an important first step is
defining your instrument’s settings. After installing the LHC, you can use the
desktop icon or the Windows Start button to launch the LHC:

> All Programs> BioTek> Liquid Handling Control

1. Click the Name link on the main page and, if required, select the 405 LS.

2. Specify the COM Port used to connect the 405 LS to the computer (use the
drop-down list to select the port) and click Test Communication.

o Pass: proceed to the next step.
o Fail: check the Com Port setting. See “About Com Ports” in the LHC Help.

3. In the Target Instrument Settings dialog that opens, click Get actual settings now,
and click OK.

405™ Microplate Washer LS
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Standard Vacuum Pump Users

nDo not perform this step when using the High Flow vacuum pump (PN
7100754). High flow pumps are recommended when aspirating 384-well plates
with non-surfactant wash buffers (e.g., pure deionized or distilled water).

Perform this step ONLY if you are using the “standard” vacuum pump (PN
7103024): increase the Vacuum Dissipate Delay to match your waste container: 1
second per liter.  For example, if you have a 10 L waste bottle, set the delay to
10 seconds.

Using the LHC Using the Keypad

1. Select Tools>Instrument Utilities.

2. Under General Settings, increase the
Vacuum Dissipate Delay to match
your waste container: 1 second per
liter.

3. Click Send to download this new
setting to the instrument.

4. Click Exit to return to the main
screen.

1. Press Setup Menu.

2. g Select the arrow (for more
options) then, ADVANC.

3. Select VACDIS.

4. Use the number pad to set the
Vacuum Dissipate Delay to
match your waste container: 1
second per liter.

5. Press Main Menu upon
completion.

Define Startup Preferences (LHC users only)

You can save enormous time creating protocols by following these steps to define a
New Protocol template and use it at startup.

Create a protocol template

1. Click the New button or select File>New.

2. Click Name. Select the 405 LS and define its Port and Settings.

3. Optionally, select the Plate Type, fill in the text fields, and add any steps that
you want all new protocols to include.

4. Click Save and assign a unique name, e.g. Template.LHC.

5. Select Tools>Preferences>New Protocol.

6. Select the button for Protocol selected below to use as a template.

7. Click selected and select the protocol you created as a template.

BioTek Instruments, Inc.
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Define startup behavior:

8. After completing the steps above, select the Startup Options tab.

9. Select the button for New Protocol.

10. Click OK to save your new preferences.

405™ Microplate Washer LS
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Verify Performance

Before using the 405 LS for the first time, verify that it is operating properly.
l When using the LHC, make sure the 405 LS is connected to the PC and both are powered
up.

l When running standalone, turn on the 405 LS.

Using the keypad:

1. Select UTILS at the main menu.

2. Select TESTS > SLFCHK.

Using the LHC:

1. Click the Name link on the main page and, if required, select the 405 LS.

2. Define the COM Port used to connect the 405 LS to the computer and Test
Communication.

3. In the Target Instrument Settings dialog that opens, click Get actual settings now,
and click OK.

4. Select Tools>Instrument Utilities

5. On the General Settings tab, click the Perform Self-Check link.

Test results:
l Pass: no error message is displayed.

l Fail: an error message is displayed. If this happens, note the error code and refer to
Troubleshooting on page 180 to determine its cause. If the problem is something you can
fix, turn off the instrument, fix the problem, and then turn the instrument back on.
Otherwise, contact BioTek’s Technical Assistance Center.

The Qualification Chapter in the operator’s manual provides Installation and
Operational Qualification procedures to perform after the instrument is installed
and before the instrument is used in a laboratory environment. 

nNote: An instrument qualification package (PN 1170543) for the 405 LS is
available for purchase from BioTek. The package contains thorough
procedures for performing Installation Qualification, Operational Qualification
and Performance Qualification (IQ/OQ/PQ) and preventive maintenance (PM).
Extensive Checklists and Logbooks are included for recording results.

nImportant! Before operating the instrument, review Optimize Performance
on page 39. The guidelines include necessary steps to perform before running
a protocol, and issues to consider when creating or editing protocols.

BioTek Instruments, Inc.
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Verify the Washer

1. Fill the washer’s supply bottle (bottle “A” for buffer switching models) with
approximately one liter of deionized water.

LHC Keypad

1. Select File > Open.

2. Open the 405 LS and the Prime and
Maintenance Protocols folders.
Open the applicable "Buffer" folder,
and then open W-DAY_RINSE.LHC

You may need to reset the Com
Port.

3. When ready, click the Run button
to prime the tubing and manifold
with deionized water.

4. When finished, close the program.

1. Select RUN at the main menu.

2. Scroll (press Options) to DAY_
RINSE. Press ENTER to confirm
selection of the protocol and press
START to run the protocol.

3. When the protocol is completed,
press Main Menu.

Run the Verify Test ("Q" Models Only)

If your 405 LS is equipped with BioTek's Verify™ Technology, run the test:

Important! Before running the test:

Make sure the 405 LS is primed and ready to run:
l Fully prime the tubing/system, e.g. run Day Rinse.

l If necessary, empty waste vessel and tighten waste bottle cap.

Prepare to run the Verify test:
l Fill the supply vessel with at least 100 mL dH2O or DI water or buffer solution1.

l Put the Verify Test Plate on the standard-mag bead plate carrier (without a magnet)2 in
the proper orientation: "Front" label is readable (well A1 in the back, left of the carrier).
See also: Handling the Verify Test Plate on page 73.

1Do not use highly viscous fluids or wash buffers that are prone to leave significant residue on the plate.
2Vacuum filtration assays: You must uninstall the vacuum filtration plate carrier and install the standard-
mag bead plate carrier to run the test. For this temporary purpose, you do not need to change the
instrument's plate carrier setting to run the Verify test.
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Run the Verify test:

LHC

1. Select Tools>Instrument Utilities>Verify Manifold and click Run a new Test.

l Buffer: Select the bottle to use, if applicable.

l Prime: optionally, prime the manifold tubes to correct for evaporation loss.
40 mL of fluid is dispensed.

l %CV Threshold: optionally, change the %CV to match your lab's standard for
QC tests: 5-15%. The default value of 5% is recommended.

2. Press Start to run the test.

3. Assess the results: Verify Results.

Do not discard the Verify Test Plate. Reuse it for as long as possible. See
Replacement Procedure for Verify Test Plate on page 134 if it is damaged.

Contact BioTek TAC if any of the tests fail.

BioTek Instruments, Inc.
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Repacking the 405 Washer

Prior to sending your instrument to us for repair, log into the Customer Resource
Center (www.biotek.com) to submit a Service Request for a Return Material
Authorization (RMA). Your instrument's serial number is needed to process an
RMA.

nFailure to comply with the following instructions will void the instrument’s
warranty and result in additional charges if the instrument is damaged. If you
have lost the original packing materials, contact BioTek TAC to order Part
Number 1173009.

nDecontaminate the instrument before returning it: See Decontamination on
page 138.

Step 1: Install the shipping bracket: 

All models: Remove the shipping bracket(s) from the storage place on the back of
the washer.

Verify™ Technology ("Q") models:With manifold in its home position, install the
longest shipping bracket that secures the Verify sensor unit. Set aside the large
manifold bracket and smaller sensor bracket for later installation:

1. Release the latch and raise the Verify
sensor unit and install the longest
bracket. Lower the Verify unit when
finished.

2. Put the manifold in its "park"
position:

LHC 405 LS Keypad

1. Select Tools>Instrument
Utilities>Washer

2. Click the shipping bracket link
under Service Functions.

1. Press Setup Menu.

2. Select WASH > PARK.

405™ Microplate Washer LS

http://www.biotek.com/


Repacking the 405 Washer | 33

3. "Q" models only: Install the second,
smaller bracket which covers the
sensor on the side of the Verify unit.
Then, proceed with the regular
repacking instructions.

4. Install the manifold shipping bracket.
"Q" models: secure the manifold
bracket to the Verify unit bracket.

5. Remove the plate carrier and put it in
the accessories box.

6. 405 Touch: Tape the cardboard
protector on top of the touch screen.

Obtain an RMA number:
l Contact BioTek TAC to obtain a Return Materials Authorization number,

l Write "RMA" on the shipping box in large, clear letters,
l And, include the RMA number in the shipping address label:

BioTek Instruments, Inc.
ATTN: RMA# xxxxx
15 Tigan Street
Winooski, Vermont 05404 USA

BioTek Instruments, Inc.
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Step 2

After completing Step 1, installing
the shipping hardware:
l Put the washer in the plastic bag.

l Seat the washer in the foam base in
the inner box and slide it forward,
pushing the manifold into the foam
pockets.

Step 3

Slide in the cardboard and foam
shipping blocks (2) to cushion the
washer on both sides.
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Step 4

Put the mist shield in the space
provided.

Place the accessories in the shipping
tray and put the tray on top of the
washer in the inner box.

Tape the inner box closed.

Step 5

Put the corner blocks on the inner
shipping box and put it in the
outer shipping box.

Tape the box closed.

In large letters, write "RMA" on the
outer box and attach the shipping
address label, including your
assigned RMA number.

BioTek Instruments, Inc.
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Operation

This chapter provides instructions for controlling the 405 LS.
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Basic Operation

Two ways to control the 405 LS

You can control the 405 LS using its built-in keypad or with BioTek's Liquid
Handling Control™ (LHC) software.

To use the LHC to control the instrument, it must be attached to and
communicating with your personal computer (PC), and its main menu must be
displayed. Basic protocols can be created or modified using the LHC, and then
downloaded to the instrument for stand-alone operation. Learn about
transferring protocols from the LHC to the instrument in the LHC Help system:
select the Help menu or click a Help button in a window.

l Find instructions for using the LHC beginning page 54.

l Keypad instructions begin on page 46.

Two ways to wash a plate

The 405 LS offers two ways to wash a plate:
l Quick Wash: using the keypad you can wash a plate by defining a few parameters like
fluid volume and number of wash cycles and rely on default parameters for the more
advanced options. See Quick Wash (Keypad only) on page 47.

l Run a Wash Protocol: using either the keypad or the LHC you can run a wash protocol
to wash a plate. You can run a predefined protocol or define your own protocol to specify
the optimal parameters for your assay. See Running Predefined Protocols on page
41.

About the 405 LS Wash Step

Minimally, a wash step includes an aspirate step followed by a
dispense step. This is a wash cycle.
The default definition of a wash step includes 3 cycles, followed by a
final aspiration to evacuate the wells.
It is important to prime the washer manifold before running a wash.
You may also want to include a Pre-dispense or tip prime (over the
priming trough) to correct for evaporation and other minor fluid loss
to normalize the tips.
About the hardware: The 96- and 192-tube wash manifolds perform
both steps, aspirating and dispensing fluid to and from 96-well and
384-well plates.
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Optimize Performance

Here are some guidelines to ensure optimal performance and to prevent problems.

Keep the devices clean and the tubing wet

The most critical factor for ensuring optimal performance is to adhere to the
Recommended Maintenance Schedule on page 119. Enable AutoPrime to keep tubes
from clogging.

Prime the tubing to remove air bubbles
l See 405 Recommendations for Priming the Washer below

Best Practices
l Fill the supply bottles with sufficient fluid. Never run the 405 LS without the fluid filter
installed (on the end of the tubing inside the supply bottle).

l Note: To avoid spilling fluid when refilling bottles or changing reagents, first release
the Quick Connector from the bottle cap, use a paper towel to sop up the few drops
in the cap. Then, refill the bottle.

l Make sure the bottles, solutions, and tubing are clean and do not contain any particles or
mold. Solutions that are recycled over several days will grow algae, bacteria, molds, or
other undesirable organisms.

l Prime before dispensing. Priming the tubing is the most critical factor in assuring optimal
performance.

l Empty the waste bottles and firmly seat the bottles’ caps and quick release connectors.
To make sure fluid does not back up into the vacuum pump during operation keep the
waste sensor cable installed and the waste detection sensor activated (see Sensors
Enabled on page 1). If fluid collects in the overflow bottle, thoroughly rinse the fluid-
level switch and bottle.

l Check the external tubing connections for kinks and clogs.

l When equipped with BioTek's Verify™ Technology ("Q" models), before processing your
assay plates, take five minutes to run the Verify routine to ensure the manifold tubes are
not clogged.

l Put microplates on the carrier with well A1 in the left rear corner as you face the
instrument, and firmly seat the plate in the carrier.

405 Recommendations for Priming the Washer

These recommended prime volumes are required to achieve 95% or higher purity
when changing wash buffers.

BioTek Instruments, Inc.
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Model Buffer Switching One Buffer

405 TS/LS 300 250

HT 300 250

Buffer Switching models have four buffer valves; otherwise, only one reagent bottle
may be connected to the washer. For Select models (with Cell Wash (CW)
capability), the recommended prime volume is the same with and without Buffer
Switching.

Model Quick Prime Prime step

Select 300 Main Low Flow

150 150

Manifold Prime: 50 mL is recommended to clear air from the manifold only and to
wet the tips. This is recommended before running a protocol to correct fluid loss
due to evaporation.

Dead Volume

BioTek's recommended prime volumes are based on purity testing and measured
dead volumes. Generally, priming with three times the dead volume assures
purity.

Model Dead Volume

405 TS/LS 108 mL

HT 108 mL

Select 129 mL

For models with buffer switching tubing, dead volume is ± 2 mL additionally.

Optimize protocols to improve evacuation

When a wash protocol leaves too much residual fluid in the wells, optimize the
protocol with these recommendations:
l Add a secondary aspiration to a wash cycle on page 70, including Final Aspirate,

l Decrease the aspirate Travel Rate,

l Add a Delay to the Aspirate and/or Final Aspirate step ,

l Lower the aspirate height (Z-axis position).
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Running Predefined Protocols

BioTek provides numerous predefined protocols for maintaining the instrument
in top condition and for qualifying its performance. Review the Predefined
Protocols on page 43.

To run a defined protocol:

LHC Keypad

1. Select Open and locate
the 405 LS folder.

2. Open the 405 LS folder.
Find the desired protocol
for your instrument model.

Important: Be sure to Customize
the Predefined Protocols below

1. At the main menu, press RUN.

2. Press Options to scroll to the desired
protocol or use the arrow and number
keys to enter its number.

3. Press ENTER and follow the prompts.

Creating Protocols: Washing, Aspirating and Dispensing Fluid

In addition to the quick routines available from the keypad’s main menu, you can
define and run protocols. Protocols offer more parameters, giving you the ability to
fine-tune instrument performance, and perform more complex processing.

Keypad Control

Find instructions for creating and modifying protocols using the keypad
beginning page 48.

Liquid Handling Control™ (LHC) Software

Launch the LHC software to create or modify protocols, see page 54

Select Help>Help Topics to learn about the LHC.

LHC Users Only: Customize the Predefined Protocols

BioTek provides predefined protocols for maintenance routines and instrument
qualification tests. You can quickly customize the protocols for regular use.

BioTek Instruments, Inc.
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The LHC keeps track of the last-used COM port for an instrument type. For example,
when an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406
is used, the LHC applies the same COM port setting. You can disable this feature by defining
your Ports preference: select Tools>Preferences>Ports.
To correct the COM port for the current protocol, click the Port link and use the drop-down
list to select the correct value. The LHC stores the COM port value in the protocol file.

With the 405 LS connected to and communicating with the host computer (i.e.
make sure the instrument is turned on and not busy):

1. Click the Open button, locate the 405 LS folder and click Open.

2. Open the Maintenance or other folder and select the desired protocol.

3. Change the COM port if necessary: click Port and enter the correct value
or select from the drop-down list.

4. Click Settings, which opens the Instrument Settings dialog.

5. Under Get settings from: click the instrument link.

6. Click Validate.

A "Validation successful" message is displayed unless the protocol cannot be
run on your instrument. See LHC Protocols Explained on page 57.

7. Save the protocol.
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Predefined Protocols Listing

LHC Users: Folders named 4Buffers and 1Buffer contain customized protocols for
models with and without Buffer Switching, respectively.
Keypad Users: The protocol names onboard the washer do not include the W- prefix and
some protocols include the model name, e.g. 405HT or 405Select, when appropriate.

Maintenance Protocols

Daily
Maintenance Description

W-DAY_
RINSE

Simple one-step protocol to fully flush the system with water or reagent to
keep the manifold tubes clog-free. Defined for use with Buffer A; 500 mL
total volume.

W-
OVERNIGHT_
LOOP

Protocol designed to keep the manifold in a wetted condition overnight or
for a long downtime period; manifold tubes are submerged in fluid for 4-
hour intervals between primes in this virtually endless loop. Defined to use
Buffer A.

W-RINSE_
AND_SOAK

Identical to W-DAY_RINSE with one addition, the manifold tubes are
submerged and soaked for 5 minutes in the fluid.

Periodic Maintenance

W-Decontaminate
DECON (onboard)_
STEP1, STEP2,
STEP3

Two/three stage protocol to decontaminate the washer, first flushing
lines with disinfectant and then rinsing them with deionized or distilled
water. Buffer switching models flush and then rinse all four lines.
Manifold tubes are submerged and soaked for 20 minutes during each
pass. Prompts guide the user through the process.

W-LONG_
SHUTDOWN
PURGE_WITH_AIR
(onboard)

Helps implement the routine recommended for preparing the
instrument for storage. This protocol includes prompts for running
disinfectant from Buffer A, then water from Buffer B, and lastly, air
through the system - remove bottle from Buffer C valve.

W-CLEAN
(LHC Only)

Combines priming and AutoClean steps to clean and rinse the
manifold. For units with the Buffer Switching module it is defined to
obtain cleaning fluid from Buffer B, and rinse fluid from Buffer A. Units
without Buffer Switching are prompted to change fluids.

W-PRIME_250/300 Simple prime routine; defined for Buffer valve A only. For LHC only.

PRIME_ALL_
BUFFRS

Consecutively primes each of the Buffer Switching valves beginning
with D. Designed for use in the annual instrument verification test of
the Buffer Switching module.
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QC (Quality Control) Protocols

Manifold-Specific

QC_96_DISP_TEST Dispense precision test protocol for 96-tube manifold.

QC_96_EVAC_TEST Evacuation efficiency test protocol for 96-tube manifold.

QC_192_DISP_TEST Dispense precision test protocol for 192-tube manifold.

QC_192_EVAC_TEST Evacuation efficiency test protocol for 192-tube manifold.

QC_96_VAC30_
TEST

Vacuum filtration evacuation efficiency test for 96-well filter plates
and also recommended for use in maintenance procedures.

QC_384_VAC10_
TEST

Vacuum filtration evacuation efficiency test for 384-well filter
plates and also recommended for use in maintenance procedures.

Predefined Sample Protocols

The "Sample" protocols are provided to facilitate learning. Some samples are model
specific.

Keypad Users: The protocol names onboard the washer do not include the W-
prefix and some protocols include the model name, e.g. 405HT or 405Select, when
appropriate.

LHC users: First open the folder that matches your washer model, e.g. 405 Select.
You may need to customize the protocols (as described on page 41) to match your
instrument's settings.

Cell Wash

W-CELLWASH_
96

Cell wash protocol designed to minimize cell layer disturbance in 96-
well plates. Aspirate height increased to 50 steps (6.35 mm above plate
carrier) resulting in increased residual, approximately 100 µL.

W-CELLWASH_
384

Cell wash protocol designed to minimize disturbance to cells in 384-well
plates. Aspirate height increased to 50 steps (6.35 mm above plate
carrier) will cause increased residual volume but help to preserve the
cell monolayer.

Microplate Manufacturers

W-Corning_
FLAT

Standard wash protocols modified to best position the manifold tubes
for dispensing and aspirating to Corning Costar flat-bottomed and
round-bottomed wells.

W-Corning_
ROUND
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W-NUNC_384 Standard wash protocols modified to best position the manifold tubes
for dispensing and aspirating to Nunc® flat-bottomed wells, round-
bottomed wells, and 384-well plates.W-NUNC_FLAT

W-NUNC_
ROUND

Bead Assays - Biomagnetic Separation and Bottom Filtration

W-Luminex_
MAG_plate_96

Biomagnetic separation wash protocols designed for optimal bead
recovery in 96-well round- or flat-bottomed plates and 384-well plates
when using BioTek's Flat magnets. Begins by soaking the plate for 1
minute to let the beads settle at the bottom of the wells, then performs a
2 cycle wash with 30 second soaks between cycles.
Recommendation: Determine Magnet Height Offset on page 93 and apply
it for the plate you are using, especially when using 384-well plates.

W-Luminex_
MAG_384

W-Luminex_
VAC_96

Vacuum filtration wash protocols for Luminex® xMap polystyrene bead
assays using filter-bottom plates, 96- and 384-well. Protocol begins with
a 5 second bottom aspiration, followed by a 200 µL dispense for 96-well
plates and 75 µL dispense for 384-well, and a two cycle 200/75 µL wash.W-Luminex_

VAC_384
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Introducing the 405 LS Keypad

The keypad on the 405™ Microplate Washer LS features 26-keys and a 2 x 24-
character LCD. The main menu is shown below.

Starting at the top of the keypad, note the main menu and the Soft-keys. Use the
Soft-keys to make selections. To return to the main menu, press the Main Menu key.

At the main menu, the top line displays AP when AutoPrime is enabled and BIO
when the washer is set to interface with and control the BioStack.

l RUN - to run a previously defined protocol. Use the Options key to select a
protocol or enter its number. See Predefined Protocols Listing on page 43.
o Turn On/Turn Off the Vacuum Pump to drain the priming trough. At the Quick
menu:

l Press Shift+1 to turn on the vacuum pump.

l Press Shift+2 to turn off the vacuum pump.

l Use these key sequences to manually control the vacuum pump
when dispensing fluid. At times the priming trough fills up and is
not emptied automatically. This option gives you control in that
situation.

l QUICK - leads to simplified wash, prime and Ultrasonic Advanatage™
options.
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l DEFINE – leads to the protocol creation and editing mode: Create or Edit a
Protocol on next page.

l UTILS – to run system tests, the Adjust Utility, and to define AutoPrime
parameters.

l Setup Menu: press this key to access the instrument’s general settings and the
settings for the BioStack.

l The Options key (and sometimes the arrow keys) scroll through the available
options or settings for the current focus. Shift+Options reverses the scrolling
direction.

Quick Wash (Keypad only)

Select QUICK>WASH at the main menu to perform a quick wash.

96 WASH:003 VOL:0300 A
PLATE CYCLE BUFFER 

Quick Wash Menu

nOnly options applicable to your model are displayed.

l 96 in the above example is the plate type. Select PLATE to change it; scroll
through the compatible choices for plate washing with the currently installed
hardware and press Enter to select the desired plate. 

l WASH:003 is the number of wash cycles (one aspirate and dispense step per
cycle). Select CYCLE to change the number of cycles to perform.

l VOL:0300 uL shows the dispense volume per well in microliters.

To change the dispense volume, use the arrow keys to move the
cursor to the desired number position. The cursor appears to underline a number:
0010. When the correct position is selected, use the number pad to enter the desired
value. Or, press Options to increment the value, Shift+Options to decrease the value.

l Buffer is offered on washers with Buffer Switching to select the buffer valve.
The current selection is displayed in the top right corner of the LCD.

l PLATE lets you change the selected plate type and define a partial plate run,
if applicable. See Define the Plate Type and Plate Map (or Partial Plate)
on page 50.

When the desired values are entered, put a plate on the carrier and press
Start to run the routine.
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If Quick Wash is too limited to satisfy your assay requirements, use the LHC or the
keypad to define a wash protocol. All wash parameters can be defined during
protocol creation, including those designed for special assays.

Quick Prime (Keypad only)

Priming removes air bubbles from the tubing, ensuring optimal performance. Fluid
is dispensed to and aspirated from the priming trough. You can use Quick Prime
to comply with the daily maintenance recommendations.

Select QUICK>FULPRM or MANPRM to prime the washer.

FULL PRIME VOL:0300 A
BUFFER  (300...999)

Quick Prime Menu

l Choose FULPRM to flush all the tubing, when changing fluids, for example. The valid
volume range is displayed, 300 to 999 mL in the above example.

l Choose MANPRM prior to running a protocol to correct for evaporation, i.e. to normalize
the dispense tips and remove any air from the manifold.

l VOL:0300 mL shows the dispense volume per well in milliliters.

To change the dispense volume, use the arrow keys to move the
cursor to the desired number position. The cursor appears to underline a number:
0010. When the correct position is selected, use the number pad to enter the desired
value. Or, press Options to increment the value, Shift+Options to decrease the value.

l Buffer is offered on washers with Buffer Switching to select the buffer valve.
The current selection is displayed in the top right corner of the LCD.

When the desired values are entered press Start.

See 405 Recommendations for Priming the Washer on page 39.

Create or Edit a Protocol (Keypad Only)

At the main menu:

1. Select DEFINE, and then, CREATE or EDIT.

CREATE EDIT

2. Name the protocol and select the
Plate Type. Press Enter after
making selections to proceed. See

Select the protocol to edit: enter
its number or use the Options key
to scroll through the stored
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 How to name a protocol
(Keypad only) on the facing
page

protocols to select one. Then, you
can edit the name and plate type,
if desired. Press Enter to proceed.

3. Define or modify the plate type using the Previous and Next buttons to
scroll through the supported Plate Types (if applicable).

4. Select ADD to define the first
step: then, select the wash action
or SHAKE to mix or soak the
plate’s contents.

EDIT the first step or press the
Options key to scroll to the step
you want to change in a multi-step
protocol.

5. Define the step’s parameters.  Press Enter to proceed.

6. Keep Added Step? Save Step Changes?

Select Yes or No using the Soft-keys to save or discard your inputs for
the current step. 

*
Press Main Menu to end the session at any time. Then, select RUN
and select the protocol to run it.

How to name a protocol (Keypad only)

NAME:
- % & _

At the Name screen when you are creating or editing a protocol, you can enter
up to 16 alphanumeric characters to name the protocol:

l Press Shift + the number key for A-H, or scroll through the alphabet with the
Options key for A-Z.

l Press Shift +Options to reverse direction. 

l Use the arrow keys ◄ ► on either side of the Options key to move the
cursor within the display.

l Press its Soft-key to add one of the four symbols (- % & _) in the display to
the protocol name.

l Press ENTER when you are finished to store the protocol name.

n If the name already exists, an Invalid Protocol Name message displays and
you must enter a unique name.
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Define the Plate Type and Plate Map (or Partial Plate)

Washing and dispensing to a part of the plate is limited by the foot print of the
hardware. When washing 384-well plates, you can choose the sectors to be
processed or skipped. This requires defining a “plate map.” By default, the whole
plate is processed.

Quick Wash

l When defining a quick routine, select Plate with the Soft-key to set the plate
type, and to define the plate map.

Protocols: Wash and Dispense

l When creating or editing a protocol (Define mode), set the Plate Type after
naming the protocol. Use the Next or Previous button to scroll through the
options.

l To define the plate map:
o Wash step: select OPTS > FORM. First choose the processing mode Sector or
Plate (described below). Then, proceed to the plate map screen.

To change the plate type:

l DEFINE mode: When defining a protocol, press Next or Previous to specify the plate
type.

g g g g

—
Sector: 01 . . 04 386

l
The two-line display changes to show a representation of the current plate type’s
sectors in the top line, with each sector as a filled or empty square; empty
sectors will not be washed. Press the Options button to toggle the sector to filled
or empty.

Press the Clear button once to empty all the columns. Press it again to fill all the columns.
This is useful when you want to dispense to only a couple columns.

To change the plate map (selected columns):

1. When defining a protocol, press Enter until the plate map screen is shown.

2. 34 Use the arrow keys to move the cursor to the column/sector you want to
change. The cursor underlines the currently selected column and its number is
shown in the display. (In the top example, column 2 is currently selected.)
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3. Press the Options key to toggle between filling the column or not. When the
image of the column is filled it will be dispensed to. Conversely, when the
column image is blank or unfilled, the column will not be dispensed to.

4. Press Enter to save the settings and continue.

Wash Step Format: Plate or Sector

When washing a high-density plate you can choose between two processing
methods, Plate or Sector:
l Plate format performs each wash cycle to the entire plate before it starts the next
cycle.

l Sector format performs the entire wash step to each sector of the plate before it
moves to the next sector. A sector is defined by the manifold's footprint:

o 96-tube manifolds process 384-well plates in 4 evenly spaced sectors (quadrants);

o 192-tube manifolds process 384-well plates in two sectors: even and odd
numbered columns.

Use sector mode when you are concerned about the fluid drying out before the
procedure is completed. To learn more See About Wash Processing Patterns on page
111

How to shake the plate

These instructions are for keypad control.

The shake command is tied to the Soak option. These instructions apply to soaking
or incubating the plate at room temperature, as well as shaking.

There are two ways to specify a shake period:

l During a wash cycle: To shake (and/or soak) in between every wash cycle,
select OPTS when defining Wash Step Parameters and then select MIDCYC,
and follow the prompts to specify parameters.

l Shake step: create a protocol to shake the plate, it can be a one-step, shake-
only protocol, or you can ADD a Shake step before or after another step.

nSee Create or Edit a Protocol (Keypad Only) on page 48

nSoak is not the same as "submerge" the tips. You must define a prime step or
use the AutoPrime feature to soak the tips in the priming trough.

nSoak is equivalent to incubating the plate at room temperature or delaying the
protocol.
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nShaking and soaking the plate is also an option when defining a Wash step.

How to enter negative numbers (Keypad only)

Some protocol parameters, like Horizontal Dispense Position (X-axis), require
inputting a negative number to improve performance.

To enter a negative value:

1. Using the number pad, start at 00 (zero) and press Shift +Options to display
the minus sign.

2. Use the number pad to enter the desired value. The minus sign will remain,
making it a negative value.

How to copy a protocol

You can save significant time creating protocols by copying a protocol that shares
some of the same protocol parameters and then editing the copy to meet your
needs.

LHC users: Open the protocol you want to copy and select File>Save As. Assign
unique file and protocol names to it. Consult the Help to learn more.

Keypad users:

1. Select DEFINE at the main menu.

2. Select Copy.

3. Choose the type of protocol you want to copy.

4. Use the Options key or enter the protocol number to select it.

5. Enter a unique name for the new protocol you are creating.

6. Select Yes to copy the protocol. Then, you can edit the protocol, as needed.

How to delete a protocol

You can delete protocols to prevent other users from running them.

LHC users: use Windows Explorer or My Computer to delete the protocol file from
your PC.

Keypad users:
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1. Select DEFINE at the main menu.

2. Select DELETE.

3. Use the Options key or enter the protocol number to select it.

4. Select Yes to delete the protocol.
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Using LHC to Control the 405™Washer

BioTek's Liquid Handling Control (LHC) software offers another way to design
protocols and control the instrument. The washer must be attached to and
communicating with your personal computer (PC) for the LHC to function.

Predefined Protocols

BioTek provides predefined protocols for maintenance routines, instrument
qualification, and other purposes like serial dilutions.

Click the Open button and locate the 405 LS folder to open a predefined
protocol. Learn how to Customize the Predefined Protocols on page 41.

Introducing the LHC Workspace

Instrument Settings: Click the Name link and select your instrument.

405 Steps on the facing page
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Define a Protocol: select Help>Help Topics to learn how.

Communications Port

Click the Port link in the main screen

The LHC needs to know the COM Port - Communications Port: USB or Serial component
on the instrument used to connect the washer to the computer.

nMake sure the 405 LS is connected to the computer, turned on, and not busy.

nLearn more About COM Ports in the LHC Installation Guide or select
Help>Help Topics.

Click Test Communications after entering the number to verify its accuracy. The
LHC will display a message.

If communication is unsuccessful:
l Check the cabling: make sure you're using a new/undamaged BioTek-supplied cable
and it is properly inserted into the instrument's USB or serial port.

l Turn on the washer: make sure the instrument is on and not busy processing a plate,
running AutoPrime, or performing a system test, for example.

l Retry: contact BioTek TAC if you are still unable to establish communication between
the instrument and the PC.

405 Steps

Click the action button and define the parameters to add that step to the
protocol:

W- for steps performed by theWasher.

Shake and soak

Each step is executed sequentially. Specific sequences are required when using
the BioStack. Any errors will be identified when you press the Validate button.

See How to define a Protocol (LHC only) on page 59
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LHC Protocols

BioTek provides predefined protocols for maintenance routines, instrument
verification, and general samples for common applications like serial dilutions.

Review the Predefined Protocols on page 43

Customize the Protocols

Typically, you must modify the predefined protocols to match your instrument
configuration and to meet your assay requirements.

Instrument Settings: In addition to action steps, every protocol file contains
instrument settings, including COM port, manifold type, and so on. Edit the
protocol to match your instrument's COM Port and other configuration details:
l Customize the Predefined Protocols on page 41

l Power Users: If you create protocols for multiple instruments or for other LHC users,
read this more detailed description of how the 405 LS validates a protocol to be run on a
specific instrument.

nRecommended: Before changing a predefined protocol, select File>Save As
and give it a unique name. This practice preserves the custom protocol in the
case of a future upgrade.

File Location

The LHC installs the protocols in the Windows Common Applications Data Folder:
l Windows® XP: C:\Documents and Settings\All Users\Application Data\

l Windows® Vista™ and Windows 7: C:\ProgramData\

The file location path continues:

[CommonAppDataFolder]\BioTek\Liquid Handling Control v.#\Protocols\405 LS

Three folders are provided:
l \Prime and Maintenance: the recommended daily and periodic maintenance routines;
the 405 provides distinct maintenance protocols for models with Buffer Switching
(4Buffer) and those without (1Buffer);

l \QC: some of the quality control or performance verification procedures;

l \Samples: examples of common applications, including washing 96- and 384-well
plates, performing serial dilutions, and a cell wash protocol.
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LHC Protocols Explained

Prerequisite

This discussion about 405 LS protocols will be easier to follow if you are already
familiar with the LHC. Read "Understanding the LHC" in the Help.

Protocol Files

In addition to the "Protocol Steps" (the actions you tell the 405 LS to perform to
process plates), each protocol file contains "Instrument Settings."

The LHC must know an instrument's settings in order to create a protocol that will
run on that instrument. This virtual "Target Instrument Settings" feature lets you
write protocols when the instrument is not connected to your computer.

Generally, and especially when you are managing only one instrument, the best
practice is to always match the instrument settings to your instrument. (Select "Get
actual settings" from the connected instrument. Unless the instrument is not
connected to the computer, then, you must specify the settings.)

The "Instrument Settings" stored in the protocol file include the COM port and
configuration details like the type of manifold installed and other details that are
critical to controlling the instrument.

The LHC keeps track of the last-used COM port for an instrument type. For example,
when an EL406 runs a protocol, the LHC logs the COM port used and the next time an EL406
is used, the LHC applies the same COM port setting. You can disable this feature by defining
your Ports preference: select Tools>Preferences>Ports.
To correct the COM port for the current protocol, click the Port link and use the drop-down
list to select the correct value. The LHC stores the COM port value in the protocol file.

Managing Multiple Instruments

The target instrument settings feature is useful for those managing multiple
instruments. In addition to the flexibility of being able to create protocols for non-
connected instruments, you can create and save an instrument settings file for each
of your liquid handlers, another time saver.
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Protocols are considered valid when an instrument can successfully perform the
protocol. The LHC will run a protocol even when the instrument settings do not
match the physical configuration of the instrument. For example, a protocol with
instrument settings that include Buffer Switching can be run by an instrument
without Buffer Switching when none of the steps actually call for different buffer
valves, i.e. all steps use the same buffer.

Validate versus Run

Validate checks the action steps against the protocol's Target
Instrument Settings.

Run talks to the instrument to check the action steps against the
instrument's onboard settings. 

Validate will catch errors when the Instrument Settings have been changed after the
protocol steps have been defined and there is a mismatch. Run performs a similar
validation before executing the protocol. Errors are not reported unless the steps
cannot be performed.

Target Instrument Settings

nFor LHC users only.

Click the Settings link in the main workspace

Actual Instrument or Simulated Instrument? That is the question for the Target
Instrument Settings dialog.

When the 405 LS is:
l connected to the computer: it is best to "Get (the) actual settings" from it;

l not connected to the computer: you must define the settings.

One vs. Multiple Instruments
l If you are running only one instrument, always "Get the actual settings" to identify the
exact configuration of your 405 LS to ensure it can successfully perform the wash
protocols.

l If you are managing multiple BioTek instruments (or one instrument with multiple
configurations): you can create and save a "settings file" for each instrument to help
create protocols for that instrument when you are not connected to it. See below.

The "instrument settings" tell the LHC what the instrument can do, e.g. fill a 384-
well plate or not. It is impossible to create a protocol without this information. Read
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this to understand the correlation between the Target Instrument Settings and the
protocol.

Get settings from:
l Instrument: BioTek configures and tests the 405 LS at the factory before shipping it. If
you have not changed the instrument's onboard settings, you can safely click the Get
actual settings now link to upload the correct settings from the instrument.

l Settings file: If you have previously saved the instrument's settings to a file (using the
Save link), click this link to import them.

l This screen: manually define the instrument's settings and click OK. This option does
not affect the instrument's onboard configuration settings. It lets you define protocols for
an instrument with the specified components.

Configured with: 

Select the appropriate devices to identify your instrument's components:
l Washer Manifold:

96-tube Single 96-well plates only

96-tube Double 96-well and 384-well plates

192-tube 384-well plates only

l Buffer Switching: when this external valve module is installed for automatically
switching wash buffers/reagents for either the washer or Syringe dispenser.

l Vacuum Filtration: when the instrument is equipped with the special carrier for
washing filter-bottom microplates.

l Ultrasonic Advantage: when the instrument is equipped with the stainless steel
reservoir and ultrasonic cleaning capability.

Save Settings File

If you have multiple instruments or use one instrument in multiple configurations,
you can create unique settings files for each configuration and save time when
defining protocols for that configuration.

Click the Save link and use Windows' file-saving dialog to create a .SET file based
on the currently-selected parameters. Then use the Get "settings from a previously
saved" link to load the parameters.

How to define a Protocol (LHC only)

nFor keypad instructions: Create or Edit a Protocol on page 48

In short:
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o Select the Plate Type and assign a unique Protocol Name Limit the name to 16
alpha-numeric characters if you want to run the instrument using the keypad
only, i.e. disconnected from the computer..

o Click a button in the Add Step area.

o Define the parameters for the step in the dialog that opens.

o Continue adding steps, if desired.

o Save the file and/or click Run to execute the protocol.

Double-click a step in the protocol to open it for editing.
 • Highlight a step and press Delete to remove it. 
• Click and drag a step to change its sequence order.

How to shake the plate

Add a Shake/Soak step to the protocol to shake the plate.

1. In the Protocol Steps box, highlight the step you want the shake to follow, and
click the Shake/Soak button.

2. Define an adequate duration and intensity to sufficiently mix the fluids in the
plate.

Leave the Soak option disabled when you only want to mix the plate contents, i.e.
perform a stand-alone shake step. Alternatively, enable the option and set a
duration to delay the process to allow the fluids to interact.

nSoak is not the same as "submerge" the tips. You must define a prime step or
use the AutoPrime feature to soak the tips in the priming trough.

nSoak is equivalent to incubating the plate at room temperature or delaying the
protocol.

nShaking and soaking the plate is also an option when defining a Wash step.

How to use the Adjust Utility- LHC

This page describes how to use the LHC to run the Adjust Utility. See Run the
Adjust Utility (Using the Keypad) on page 109.

nLearn about the Adjust Utility.

l Keep in mind the positional limits of the devices during operation.
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1. Put a plate on the carrier.

2. Select Tools>Instrument Utilities>General Settings and click Adjust Utility
under Instrument Functions.

3. Choose the Selected Device and the starting position to Measure offsetfrom using
the drop-down lists.

4. Set the Plate Type.

5. Click the Align now link.

The utility positions the plate according to your selections. Take a close look at
the current position of the selected device above the wells to determine the
required adjustments.

6. Use the radio buttons to select the Axis you want to adjust.

7. Use the Direction buttons to move one step at a time. Press the companion
button to reverse direction.

To move multiple steps at a time, use the numeric field next to the Go to now
link. Enter a positive or negative number of steps to move the device or plate
carrier and click the link.

The Offset is shown in number-of-steps and mm.

8. Repeat the process for each axis, as necessary, starting at step 6.

9. Jot down the Offset values so you can enter them when defining the protocol
step.

10. Click to end the session.
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Upload-Download Protocols (LHC Only)

The LHC lets you transfer protocols from your computer to your instrument and
back again.

Limitation: Protocols must contain only instrument-supported action steps to
qualify for download. That is, the protocol cannot contain any of the LHC provided
steps like Delay and Loop (buttons in the left column of the Add Step box in the
main view). And, a Protocol Name is required.

nThe instrument's main menu must be displayed for the LHC to communicate
with it.

1. Select Tools>Transfer Protocols.

2. Make sure the desired protocols are displayed: check the Protocol Folder path
for This computer. Refresh the list of protocols onboard the Instrument by clicking
the Settings link.

3. Highlight one or more protocols in a display box. (Hold the Ctrl or Shift key to
simultaneously select multiple files.)

4. Optionally, at the top left corner of the screen, choose to Disable Editing of
transferred protocols to lock the protocols from editing or deleting when they
are onboard the instrument.

5. Click the applicable Upload or Download button.

The LHC will confirm the transfer or prompt you for more information. When the
transfer is complete, you can manipulate the files as you normally would in their
new location.

Wash Step Parameters Table

See Plate Types Table on page 111 for default Z-axis values or dispense heights.

Minimally, a wash step includes an aspirate step followed by a dispense step.
Select and define each option to customize the parameters for your assay.

Keypad
name Option Description/Values range Default

values

CYCLES Number of
wash cycles:

Each wash cycle first aspirates and then
dispenses fluid to and from the plate.

3

ASPIR Aspirate Vacuum Filtration: Select standard
aspiration (Top) or Vac for filtration.
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Keypad
name Option Description/Values range Default

values

Filtration
Time:

When applicable, specify duration of
vacuum filtration in seconds. 5-999

30

Travel Rate: The rate at which the washer manifold
travels down into the wells. The selection
range is 1 to 5 for non-cell-based assays,
from slowest to fastest. With these rates,
the tubes slow their descent as they
approach the defined aspirate height (Z
Position) to aid complete evacuation of
the well.

3

For delicate, cell-based assays, the range
is 1CW (cell wash) to 4CW and 6CW.
These rates minimize turbulence in the
wells. The tubes descend at a constant
rate to the specified height. Rate 6CW
creates the least disturbance and
performs fastest.

Delay: Amount of time the tubes stay at the
aspirate height before lifting out of the
wells. Define a delay between 0 - 5000
ms. Increasing the delay may improve
evacuation of the wells.

0

Positioning: X- and Y- horizontal axes, Z- height
(vertical) axis can be adjusted to improve
performance. Default Z-axis for 384-well
plates is 22 steps, 2 for 384-well PCR
plates.

Z = 29 for
96-well
plates;
X & Y = 0

Secondary
aspirate:

Also called Crosswise Aspiration. First the
wells are aspirated using the position
defined above. The aspirate tubes rise and
then descend to the secondary position to
aspirate again.

No

DISP Dispense

Flow Rate:
96-tube &
192-tube
manifolds

The rate at which the fluid is dispensed
from the tubes. For cell-based assays, use
rate 1 or 2 for gentle washing with the 96-
tube manifold only. For normal
dispensing, the range is 3-11, 3 is slowest
and 11 is fastest.

7

BioTek Instruments, Inc.



64 | Chapter 3: Operation

Keypad
name Option Description/Values range Default

values

Volume: µL/well dispensed range:
96-tube manifold: 50-3000
192-tube manifold: 25-3000

µL/well:
96= 300
384= 100

Buffer: Buffer bottle selection. A-D A

Positioning: X- and Y- horizontal axes, Z- height
(vertical) axis can be adjusted to improve
performance. Default Z-axis for 384-well
plates is 120 steps; 83 for 384-well PCR
plates.

Z = 121 for
96-well plate

Vacuum
Delay

Suspends the vacuum pump until a certain
volume is dispensed. This feature is
critical to cell wash operations. It delays
normal aspiration until the specified
volume has been dispensed to the wells.
The range is 10 to 350 µL/well.

10

OPTS Options

PRE Pre-wash options: Pre-dispense, Bottom
wash (if applicable)

MIDCYC Mid-cycle options: Shake, Soak, Pre-
dispense between cycles,

POST Post-wash option: Final Aspirate

FORM Format for washing 384-well plates: Plate
or Sector

PRE Pre-wash Actions performed before the wash cycles
begin

Pre-dispense Quick, small prime to condition the tips
before dispensing.

No

Flow Rate: 96-tube & 192-tube manifolds: The range
is 3-11, 3 is slowest and 11 is fastest.

9

Volume: µL/tube dispensed range:
96-tube manifold: 50-3000
192-tube manifold: 25-3000

µL/tube:
96 = 50
192 = 25

Bottom wash Bottom washing adds an initial wash cycle
to the specified number of cycles. Fluid is

No
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Keypad
name Option Description/Values range Default

values

simultaneously dispensed and aspirated to
create cleaning turbulence (at the
specified height). The manifold descends
to aspirate again and ends with a final
dispense to fill the wells.

Rate: Valid range is 3-11. The cell wash rates, 1
CW and 2 CW, which use low-flow tubing,
are available but not recommended. Cell
wash options are designed for gentle
washing, while bottom wash is designed
for vigorous washing.

Wash
Volume:

25-3000 µL/well dispense 250

Positioning: X- and Y- horizontal axes, Z- height
(vertical) axis can be adjusted.
Repositioning the tubes to harder-to-reach
areas of the wells may the improve
results.

MIDCYC Between
cycles

Shake To mix the contents of the plate. No

Duration From one second to one hour. 5 sec.

Intensity Intensity Hertz
Slow 7
Medium 13
Fast 19

Medium

Soak Delays wash for the duration to allow
fluids in the plate to steep or incubate.

No

Duration From one second to one hour. 30

Home carrier To perform the shake or soak in the home
position or not. But, the plate carrier is
moved home when the total duration of
the shake and/or soak exceeds 1 minute.
The vacuum pump is turned off in this
scenario. Moving the plate home prevents
contaminating it with drops from the
manifold.

No
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Keypad
name Option Description/Values range Default

values

Pre-dispense
between
cycles

To wet or condition the manifold tubes
between cycles, which is only needed
after a long soak. Same parameters as
regular pre-dispense.

No

POST Post wash When all cycles are completed.

Final
Aspirate

A final aspiration is performed to
completely evacuate the wells. Same
parameters as regular aspirate step.

Yes

FORM Wash format Manner of processing large-format plates Plate

Sector Performs the entire wash step on one
sector of the plate before it moves to the
next sector.

Plate Performs each cycle to the entire plate
before it starts the next cycle.

Shake/Soak Step Parameters

Select the action to perform:
l Move carrier to home position first.
Regardless of selection, the plate carrier is moved home when the total time of the
shake and soak durations exceeds 1 minute. The vacuum pump is turned off in this
scenario. Moving the plate home prevents drops from contaminating the plate.

nNote: The Shake/Soak step is performed wherever the carrier is positioned. In
a multi-step protocol it is likely the step previous to a shake/soak will leave
the plate carrier in its home position. In this case and when it is the first step
in a protocol, the step will be performed at home.

l Shake settings:

l Duration: enter numeric values to shake the plate for up to 1 hour.

l Intensity: use the drop-down list to select a shake intensity. "Variable" cycles
through the other levels of intensity.

Intensity Hertz
Slow 7
Medium 13
Fast 19
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Choose the intensity that most closely matches your assay kit instructions.

l Soak: allows buffer/dispense fluid to remain in wells for the specified duration, i.e.
processing is delayed:

l Duration: enter values to stop processing the plate for up to 1 hour (59
minutes, 59 seconds).

nSoak is not the same as "submerge" the tips. You must define a prime step or
use the AutoPrime feature to soak the tips in the priming trough.

nSoak is equivalent to incubating the plate at room temperature or delaying the
protocol.

nShaking and soaking the plate is also an option when defining a Wash step.

Pre-Dispense

Wash and Dispense Step option

Also called Tip Priming.

Valid volume ranges:

Manifold µL/tube Default value

96-tube 50-3000 50

192-tube 25-3000 25

About the Pre-Dispense Options

Enable the Pre-dispense options to condition or normalize the dispense tubes
before dispensing fluid. This is recommended for precise dispensing to mitigate
evaporation or any potential fluid imbalance at the ends of the tubes.

The pre-dispense options are not intended to fully prime the tubing, for example,
when changing fluids. Be sure to fully Prime the device to remove all air from the
tubing before commencing a dispense step. Use the Pre-dispense feature to quickly
prime the tubes or tips between runs.

When a Pre-dispense is enabled, the 405 LS moves the plate to the home position
to allow the manifold to dispense into the priming trough.

How to condition the tips before dispensing

l In a stand-alone Dispense step: select the Advanced Options link and fill
the Pre-dispense checkbox;
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l In a Wash step, select the Show Wash Options link and fill the Pre-
dispense checkbox.

Washer Flow Rates

The default setting for flow rates is 7, in the middle of the range for standard
tubing rates 3-11, 3 is the slowest, 11 is the fastest. Slower rates are recommended
for viscous fluids.

Dual 96-Tube Manifold: When this manifold is installed, you can select rate 1 or 2
to use the low-flow tubing to dispense fluid slowly and gently to avoid damaging
well contents.

Rate µL/tube/second
96 tube 192 tube

Cell Wash 1 116* NA*
Cell Wash 2 134* NA*

3 204 102
4 244 122
5 273 136.5
6 306 153

Default 7 325 162.5
8 352 176
9 375 187.5
10 391 195.5
11 418 209

*Cell Wash flow rates direct fluid through special low-flow tubing, which is not
compatible with the single 96-tube and 192-tube wash manifolds. 

Aspirate Travel Rates

Rate mm/sec

1 4.1 +1 Slowest

1 CW 4.1

2 5.0 +1

2 CW 5.0

3 7.3 +1 Default rate

3 CW 7.3
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Rate mm/sec

4 9.4 +1

4 CW 9.4

5 9.4 +2 Fastest

6 CW 14.7 Recommended rate
for Cell Wash
protocols

CW rates are specially designed travel rates that minimize turbulence in the wells
for Cell Wash protocols.

Standard rates (1-5) show two speeds as they approach the well because they slow
down to 1 or 2 mm/sec before reaching the aspirate height to provide more time to
aspirate the fluid, improving evacuation. Conversely, the CW rates do not change
speeds, they move into and out of the well as quickly as possible to limit
turbulence.

How to define a Final Aspiration step

By default, wash steps include a final aspiration step because a common objective
is minimizing the residual left in the wells during a wash cycle. You can enable,
disable, or modify the parameters of the final aspiration step.

n Important info for Vacuum Filtration Assays: Be sure to reset or disable the
Final Aspiration step to match your assay requirements.

Edit the Wash step to modify the Final Aspiration:

LHC Users: Keypad Users:

1. Double click the step in the
protocol to open it for editing.

2. Fill the checkbox to enable Final
Aspirate and click the Definition
link to define the parameters to suit
your assay.

1. Edit the Wash step or stand-alone
Aspirate step: Define>Edit>select
protocol, and if necessary press
Options to scroll to the desired
step.

2. Select OPTS>POST and select Yes,
or modify the Final Aspirate step
by pressing Enter.

3. Define or modify the parameters
to suit your assay.
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Add a secondary aspiration to a wash cycle

When too much residual is left in the wells during a wash cycle, you can add a
secondary aspiration to reduce it. Secondary aspiration can be performed
immediately after each aspiration in a wash cycle and/or after the final aspiration
step.

nSecondary aspiration is also called Crosswise aspiration because it is typically
performed in a different location within the well. Reposition the tubes by
defining different X-, Y-, and/or Z-axis positions when enabling the secondary
aspiration for the most effective evacuation of the wells.

Edit the Wash step or stand-alone Aspirate step to add a secondary aspiration:

LHC Keypad

1. Double click the step in the
protocol to open it for editing.

2. Click Advanced Options (for
Aspirate) and enable Perform
Secondary Aspirate.

3. Apply a second aspiration to the
Final Aspirate, also, for best
evacuation results.

4. Optionally, adjust the position of
the manifold as it addresses the
wells.

1. Edit the Wash step or stand-alone
Aspirate step: Define>Edit>select
protocol, and if necessary press
Options to scroll to the desired
step.

2. Select ASPIR and press Enter until
Secondary Aspirate is offered.
And/or select OPTS>POST to add a
second aspiration to the Final
Aspirate.

3. Select YES to perform a second or
crosswise aspiration.

4. Specify a crosswise position for the
manifold as it addresses the wells.

For example, you may want to adjust the X- or Y- axes to get to hard-to-reach areas
of certain types of wells. Or, you may want to lower the height (reduce the Z-axis),
to better evacuate fluid.

Run the Adjust Utility: To determine the precise positioning of the dispense and
aspirate tubes.

Bottom Wash

Bottom washing adds an initial dispense/aspirate sequence, another wash cycle, to
the specified number of cycles. Fluid is simultaneously dispensed and aspirated to
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create cleaning turbulence (at the specified height). The manifold descends to
aspirate again and ends with a final dispense to fill the wells.

Buffer: Select the buffer to use, if applicable.

Bottom Wash Volume: Enter the volume of wash solution to dispense per well
during the bottom wash.

Flow Rate: Set the rate. Valid range is 3-11. The cell wash rates, 1 CW and 2 CW,
which use low-flow tubing, when available, are not recommended. Cell wash
options are designed for gentle washing, while bottom wash is designed for
vigorous washing.

Advanced Options

Parameters Description

Bottom Wash
Height:
Z-axis Position

The distance between the bottom of the aspirate
tubes and the carrier surface. The valid range is 12
to 175. The value in mm is displayed on screen.

Horizontal X-axis
Position

The left and right position of the dispense tubes
when the carrier is beneath the manifold.

Horizontal Y-axis
Position

The front-to-back carrier position (or Y axis) to align
the microplate with the manifold tubes during a
dispense. The range depends on the model.

Delay start of
Vacuum

until dispensing this volume. 3000 µL max
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Verify Performance

nLHC Required for "Q" models: you must use BioTek's Liquid Handling
Control (LHC) software to run the Verify™ Technology clog detection feature.

Tools>Instrument Utilities>Verify Manifold>Run a New Test

BioTek's Verify™ Technology quickly detects clogged aspirate or dispense tubes.

Important! Before running the test:

Make sure the 405 LS is primed and ready to run:
l Fully prime the tubing/system, e.g. run Day Rinse.

l If necessary, empty waste vessel and tighten waste bottle cap.

Prepare to run the Verify test:
l Fill the supply vessel with at least 100 mL dH2O or DI water or buffer solution1.

l Put the Verify Test Plate on the standard-mag bead plate carrier (without a magnet)2 in
the proper orientation: "Front" label is readable (well A1 in the back, left of the carrier).
See also: Handling the Verify Test Plate on the facing page.

Run the Verify test:

LHC

1. Select Tools>Instrument Utilities>Verify Manifold and click Run a new Test.

l Buffer: Select the bottle to use, if applicable.

l Prime: optionally, prime the manifold tubes to correct for evaporation loss.
40 mL of fluid is dispensed.

l %CV Threshold: optionally, change the %CV to match your lab's standard for
QC tests: 5-15%. The default value of 5% is recommended.

2. Press Start to run the test.

3. Assess the results: Verify Results.

Do not discard the Verify Test Plate. Reuse it for as long as possible. See
Replacement Procedure for Verify Test Plate on page 134 if it is damaged.

1Do not use highly viscous fluids or wash buffers that are prone to leave significant residue on the plate.
2Vacuum filtration assays: You must uninstall the vacuum filtration plate carrier and install the standard-
mag bead plate carrier to run the test. For this temporary purpose, you do not need to change the
instrument's plate carrier setting to run the Verify test.
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Frequency:

5 Minutes: Gain complete confidence that your plates will be processed correctly by
spending five minutes to run the Verify test before running your assay!

Develop a schedule for running the Verify routine based on the type of wash buffer
you are using, how frequently you use the washer, and your maintenance habits:
l Daily: When using PBS, protein, and other fluids that easily crystallize and harden,
potentially clogging the tubes, run the Verify routine every day and/or after prolonged
downtimes to ensure the tubes are not clogged.

l Weekly: When using TRIS and other low-salt buffers and when adhering to the
recommended maintenance schedule, you can confidently run the Verify routine less
frequently, e.g. before new assay runs.

Replace the Verify Test Plate (according to the prescribed procedure) if it is
damaged, scratched, warped, etc.

For more details: See About Verify™ Technology on page 76.

Manage Test Results

Immediately after a test is run, its results are displayed. The test data file is named
with the date and time. You can view previous results using the drop-down list of
tests. The most recent test results are at the top of the list.

View Report file: to open a text file of the current test results. Report file names are
appended with Passed/Failed results.

Configure settings: to specify a text file folder. See Configure Verify™ Technology
Utilities on page 79 for other useful info.

Handling the Verify Test Plate

The Verify Test Plate ships in its own special box. The plate is labeled with the
serial number of the 405 LS that has been calibrated for its use.
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l Well A1 is opposite the
chamfered or beveled
edges.

l The plate is labeled with the
washer's serial number.

l When the plate is on the
carrier in the proper
orientation, the "Front"
label is visible.

Verify Test Plate

Important guidelines:

l Always put the plate on the carrier with well A1 in the
back, left corner of the carrier.

l Clean the plate after each use if you are using wash
buffer to run the test.

l Fully dry the plate after each use and before putting it
back in its foam-lined box.

l Inspect the plate regularly for damage, e.g.
scratches, chips, warping.

l Replace the plate when it is damaged. See
Replacement Procedure for Verify Test Plate
on page 134 in the operator's manual.
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Verify™ Technology Flowchart Diagram

Note: When the manifold tubes are clog-free, it is expected that all five tests pass and
normal operation can be resumed.

Verify Test Corrective Action

Corrective Action

1 Clean the Manifold: begin with AutoClean/Quick
Clean and rerun. If test fails again, remove the
manifold to clean it more thoroughly.

See AutoClean the
Washer on page 125

2 If the test fails after the manifold has been cleaned,
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Corrective Action

recheck the instrument setup:

l System fully primed;

l Sufficient/correct fluid supply;

l Vacuum pump working;

l Washer on a level surface;

l Supply vessels on same or higher elevation than
washer;

l Supply vessel filter (in bottle) unclogged;

l Waste bottle cap tightened;

l Inline vacuum filter unclogged.

See Remove and clean
the washer manifold
on page 131

Note All or many tubes: if the plate map shows:

l all the aspirate tubes as clogged: check for a
vacuum leak

l clusters of dispense tubes as clogged: check fluid
supply/fully primed system

About Verify™ Technology

BioTek's Verify™ Technology uses an ultrasonic liquid-level sensor to quickly test
aspirate and dispense performance. In less than 5 minutes, the Verify routine will
give you supreme confidence that assay plates will be washed according to your
specifications or it will identify any clogged manifold tubes that need cleaning.

Our Verify Technology can significantly decrease the need for routine instrument
quality control using fluorescence- or absorbance-based dyes and a microplate
reader, as the test can be performed with dH2O/DI water and most wash buffers
by the washer itself. You can run the Verify test prior to each assay, at the
beginning or end of every day, or at the frequency that best fits your lab's current
practices. However, use of the Verify Technology does not alter the recommended
instrument qualification schedule, i.e. dispense precision and evacuation efficiency
testing should be performed monthly to confirm the washer is performing to
specifications. See Sensitivity: Verify Sensor vs. Absorbance Reader on page 78.

See Verify™ Technology Flowchart Diagram on previous page for a graphical depiction
of the process.

The Verify routine runs a pre-check and five tests:
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l Pre-check: the sensor verifies the standard plate carrier is present and level, and the
Verify Test Plate is on the carrier. All wells are aspirated to make sure they are dry.

Tests conducted by the Verify level sensor:

1. Aspirate Minimum Capability: Post-aspirate, this test verifies the residual
volume is less than 250 µL/well.

2. Dispense Minimum Volume: Post-dispense, this test verifies that every well has
at least 125 µL/well.

3. Dispense Mean Volume: Calculates the mean dispense volume: dispense
accuracy of ±20% is expected.

4. Dispense Volume %CV: Calculates the dispense %CV and per-well deviation
from mean.

5. Aspirate Rate: Calculates the aspirate rate per well in mL/seconds.

When the manifold tubes are clog-free, it is expected that all five tests pass and
normal operation can be resumed. If any of the tests fail, the procedure stops and
displays the results in a plate map format to instantly identify the clogged
manifold tubes.

The Verify Process Flow

The Verify Test proceeds this way when not interrupted by a failed test:

1. Pre-check: The process begins with the pre-check described above.

2. Dispense: 300 µL/well dispensed to each well in the test plate.

3. Aspirate: All wells are evacuated.

4. Shake plate to better distribute remaining fluid in the plate and improve the
meniscus.

5. Scan: Level sensor scans plate to measure fluid: <250 µL/well is expected.
Generate Test 1 results.

6. Dispense: 250 µL/well dispensed to each well in the test plate.

7. Shake plate to distribute fluid in the plate and improve the meniscus.

8. Scan: Level sensor scans plate to measure fluid: ≥125 µL/well plus residual
from aspirate step is expected. Generate Test 2 results.

9. Evaluate data and generate Test 3 and Test 4 results.

10. Aspirate: All wells are evacuated at the fastest travel rate (6CW).

11. Shake plate to distribute fluid in the plate and improve the meniscus.

12. Scan: Level sensor scans plate to measure aspirate rate: ≥0.4 mL/sec is
expected. Generate Test 5 results.
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Sensitivity: Verify Sensor vs. Absorbance Reader

While the 405 LS's Verify™ ultrasonic level sensor is a reliable tool for quickly
determining the current state of the wash manifold, it has greater measurement
variability than a typical absorbance reader.

The Verify sensor is an excellent maintenance tool, but BioTek recommends using
the more precise measurements obtained with a microplate reader for qualifying
the 405 LS's performance on a monthly basis. Additionally, BioTek recommends
performing an annual qualification of the Verify sensor itself, to ensure it is
meeting its performance specifications. Qualify the Verify™ Technology Sensor on page
167.

The Verify measurement variability is determined this way:

CV% =Verify
σ

V

Verify %CV accuracy is determined from the sigma measurement error and mean
volume measurement error. The sensor’s performance specification is σmeasurement<
9 μL, (also typically σmeasurement> 3 μL). Typical volume error is +/- 14 μL.

%CV reported by the level sensor is highest when σmeasurement is high and mean
volume measurement error is low, and vice versa.1

1The error contribution of sigmameasurement is found by summing the actual well volume variance and

the measurement variance: σ σ actual σ mea urement error= +
2 2

.
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For example, if the actual sigma is 7.5, and mean volume is 250, then actual CV =
7.5/250 = 3%.

And: CV to to% = = 3% 5%Verify
7.5 +3

250+14

7.5 +9

250−14

2 2 2 2

Configure Verify™ Technology Utilities

Tools>Instrument Utilities> Verify Manifold>Configure Utilities link

l Raw Data folder: This field shows the path and folder that LHC creates on your PC and
uses to store the test data. Every test creates an .xml data file that displays the test
results in the LHC. Regularly archiving these "Raw Data" files will ensure optimal viewing
performance.

l Reports folder: This customizable field shows where the text (.txt) files of the test
results are stored. To change the folder, click the link to browse to a desired location or
edit the path shown in the field.

Managing Test Results

l Improve online viewing of test results: If test results do not appear instantly after
a test, there may be too many raw data files in the Raw Data folder. Archive the data
files, i.e. save the files in a different folder to restore normal performance.

l Archive files: Develop a schedule that compliments your current QC/QA practices to
regularly archive Verify test raw data files. Use Windows Explorer to move data files
(.xml) and report files (.txt) to archive folders.

Test Plate Alignment

Procedure for calibrating the level sensor to work with a replacement test plate.
Depending on frequency of use, the Verify Test Plate will occasionally need to be
replaced due to wear or damage. When you receive a replacement plate from
BioTek, perform this procedure to update the washer's calibration data to match the
new plate. See Replacement Procedure for Verify Test Plate on page 134.

Sensor Calibration

This procedure serves two purposes:
l Testing/determining the Slope and Offset volume coefficients for a specific Verify Test
Plate, i.e. a step in the procedure to replace a test plate.

l Qualify the Verify™ Technology Sensor on page 167 to ensure it is performing to
specification.
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Advanced Settings

Do not change the slope or offset values unless specifically instructed to do so by
BioTek.

Note: Instructions in the Replacement Procedure for the Verify Test Plate may
recommend changing these values.

405™ Microplate Washer LS



Operating with the BioStack | 81

Operating with the BioStack

If you purchased BioTek’s BioStack Microplate Stacker to operate with the 405
LS, here is some important information about running it:

LHC Control:

l LHC users: connect both the BioStack and the 405 LS to the computer and control them
with the LHC.

l Design protocols that integrate BioStack controls with 405 LS steps. LHC protocols must
contain a BioStack loop.

l In the LHC, select Help>Tutorials, click Sections in the toolbar for a drop-down menu,
select Controlling the Bio-Stack with LHC. It only takes a couple minutes to
complete this interactive demo. It is a great way to learn about the special BioStack
features offered with the LHC.

Keypad Control:

l The Quick Wash option does not function with the BioStack, i.e. the BioStack will not
deliver a plate. You must create a protocol to process plates using the BioStack.

l You can use the Quick Prime option. This is recommended especially prior to processing
plates, to remove air from the tubing.

nOnly one of the 405 LS's communication ports can be used at a time: you can
plug in either the USB cable to connect it to the PC or the serial cable to
connect it to the BioStack (but not to both at the same time).

Install and Align the BioStack:

1. Set up the BioStack according to instructions in your BioStack Operator’s
Manual to interact with the 405 LS. Connect it to the:

o Host computer (PC) when using the LHC to control the 405 LS.

o 405 LS when using the keypad to control the instrument.

2. Align the BioStack’s gripper with the 405 LS’s plate carrier:

LHC: Keypad:

1. Select Tools> BioStack
Utilities.

2. Use the Alignment Utility.

Click the Help button for
detailed instructions.

1. Press Setup Menu.

2. Select BIOSTK.

3. Select ALIGN.

3. Set the BioStack operating mode:
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LHC: Keypad:

1. Press Setup Menu.

2. Select BIOSTK.

3. Select CONF.

4. Select BIOSTACK.

Fill the BioStack checkbox in the main view
to enable the BioStack action buttons and
use them to design a protocol that delivers
and retrieves plates.

Important: When using LHC to control the 405
LS and the BioStack, the instrument's BioStack
configuration setting must be set to MANUAL,
not "BIOSTACK."

nTo Restack or not? Yes: to keep plates in the same order. No: to save time
when the plate sequence is unimportant.

5. Verify the setup: perform a protocol with 1 or 2 plates.

At the start of the day, power up the BioStack first, and then the 405 LS. BIOSTACK2WR:
Lift the BioStack’s gripper before turning it on.

Robotics integrators: CAD drawings of the physical dimensions of the 405 LS are
available upon request. Contact BioTek customer service.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You

can use USB to connect the 405 LS to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Keypad Control: When the BioStack is connected to your 405 LS, you are
controlling both instruments using the keypad. Before connecting the 405 LS to
your computer to download basecode or for other reasons, you must first
disconnect the BioStack from the 405 LS and change the Instrument Setting for the
BioStack: Press Setup Menu> BIOSTK> CONF>MANUAL.

BioStack Alignment Utility

Follow the detailed procedure in the BioStack Operator's Manual to use this
alignment utility to precisely align the BioStack's gripper with the microplate
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carrier: First install the alignment hardware, correctly position the instruments in
their respective aligning plates, and connect the instruments with the dedicated
serial cable before attempting to align the gripper with the washer.

Begin by pressing Home to enable the alignment and step up and down buttons.
When the gripper appears to be correctly positioned, Save (the) Position and
proceed with the Verify procedure.

Press the previous button to exit the screen.
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Cell Wash

nNot all 405 LS models support cell wash assays. The dual 96-tube wash
manifold must be installed.

See how to Define a Cell Wash Protocol on page 1. 

Low-flow Fluid Path

The 405 LS supports cell-based assays that require the addition and removal of
buffer solution without disrupting the cells in the wells of the microplate. Cells are
often dislodged when fluid is dispensed at too high a pressure and lost during
subsequent aspiration of the fluid from the well unless counter measures are taken.
The 405 LS is equipped with a low-flow fluid path that provides a "cell wash"
alternative for cell-based assays.
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The low-flow tubing is used during a wash step when the Flow Rate is set to 1 or
2. It dispenses fluid to the wells slowly enough to avoid damaging the cells. Note
that the low flow line is always open, i.e. some fluid flows through the tubing
during normal dispenses. For this reason, priming the low flow tubing is
recommended for all Prime steps.

Additional Techniques

Delay Aspiration: Also critical to cell-based assays is delaying aspiration to allow
the slower dispense process to finish before beginning fluid removal from the well.
This option, offered as part of the dispense step, is called Delay Start of Vacuum.

Adjust the Aspirate Travel Rate and Aspirate Height: when defining the aspirate
step select one of the specially designed travel rates that minimize turbulence in
the wells. Increase the aspirate height to leave more residual fluid in the wells to
protect the cell layer. Also, consider using a secondary aspiration as described in
the Cell Wash Strategies described below.

Adjust the Dispense Flow Rate, Height and Position: when defining the dispense
step be sure to select one of the special Flow Rates that trigger use of the low-flow
tubing, 1 or 2 CW. Also reposition the dispense tubes to aim the fluid at the side of
the wells to further minimize turbulence. See Cell Wash Strategies below.

CW+ Dispense Manifold

As a result of BioTek's continuous improvement effort for liquid handlers, the
washer dispense manifold has evolved. The dispense tubes of the improved
manifold ensure fluid hits higher on the walls of the well, minimizing damage to
the cells. "CW+ Dispense Manifold" is engraved on the top of these newer
manifolds to make them easy to recognize. If you do not have one of these
manifolds you may need to experiment with the Washer Settings on page 105 (the
CW+ Control) to improve the performance of your cellular assays. Contact BioTek to
obtain this special cell wash manifold.

Next: Define a Cell Wash Protocol on page 1.

Cell Wash Strategies

To give you a starting point for optimizing your own assays, here are some
recommendations for improving your cell wash assays:
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Repositioning the dispense and aspirate tubes helps minimize turbulence in the
wells, preserving more cells. Using a standard 96-well Corning Costar plate, best
results were achieved with these values:

Dispense Step Settings:
Z - height = 120 steps
X - horizontal position = -45
Y - horizontal position = 0

Aspirate Step Settings:
Z = 46 steps
X = 35
Y = 0
Secondary Aspirate:
Z = 80 steps
X = -45
Y = 0
About 40 µL/well residual fluid is
retained using these values.
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For loosely adherent cells, the best performance was seen by increasing the aspirate
height and using both a standard and secondary (or crosswise) aspiration. Moving the
aspirate tubes from one side of the well to the other prevents a fluid stream from forming
and dislodging the cells. Increased residual in the well means increased cell retention.

Best practice:

l Use the Align tool to determine the optimal X, Y, and Z axis adjustments needed to best
position the manifold above the wells during the wash routine.

l Test the protocol settings by running the protocol using only water and an empty plate
before actually running your assay to make sure the fluid stream hits the wells as
desired.

l Optimal cell wash performance is achieved with BioTek's special CW+ Dispense
Manifold. "CW+ Dispense Manifold" is engraved on the top of these newer manifolds to
make them easy to recognize. If you do not have one of these manifolds you may need
to experiment with the Washer Settings on page 105 (the CW+ Control) to improve the
performance of your cellular assays. Contact BioTek to obtain this special cell wash
manifold.

Delay Aspiration or Vacuum On Volume Control

LHC Users: Open the Wash or Dispense Step>Advanced Options

During regular plate washing, aspiration and dispensing occurs simultaneously.
This allows "overflow" dispensing, because the fluid is aspirated before
overflowing the plate. But, the low-flow tubing used in cell wash protocols
dispenses fluid so slowly that aspiration must be delayed to allow the fluid to
reach the well.
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Use this control to turn on the vacuum pump and begin aspiration only after the
specified volume is dispensed. For cell wash assays, specify at least 10 µL/well.

For small dispense volumes, BioTek recommends setting the vacuum-on volume to
equal your dispense volume. Refer also to application notes on the BioTek web site
for more information (www.biotek.com).
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Biomagnetic Separation - Magnetic Bead Assays

The microplate carrier supports placement of a magnet under the microplate. The
magnet induces magnetic beads to settle at the bottom of the wells to help retain
them during a wash protocol’s aspirate cycle.

The 405 LS supports standard microplates and these magnets available for
purchase from BioTek:

Plate Type Magnet PN

96-well 96 Flat Magnet 7103016

96 Ring Magnet 7102216

384-well 384 Flat Magnet 7103017

384 Ring Magnet 7102215

You can use a different magnet if it fits in the carrier and accommodates your
plates. Contact BioTek TAC or visit the Customer Resource Center at
www.biotek.com to obtain a drawing of the carrier with its dimensions.

Persons with pacemakers/implants should avoid direct contact. Keep all
magnetic media, watches, and sensitive electronic devices away from the magnets.
Credit cards, tapes, and disks can be erased in the presence of a magnetic field. Bodily
harm [pinching of hands and skin] can result if magnets are not handled correctly.
Maintain distance between two or more magnets.

Take advantage of the sample magnetic-bead protocols shipped onboard the 405 LS.
Copy W-Luminex_Mag_Flat_96, for example, and modify the parameters to suit your assay
requirements.

Handling and Cleaning the Magnets

For best magnet strength and bead retention, the bottom of the microplate must be
as close to the magnet as possible. We recommend using flat-bottom plates with
minimal support “webbing” between the sides of the outer wells and the plate
skirts.

Handle the magnets with care. Avoid direct contact with the magnet material. Keep
loose ferrous material away and do not attempt to disassemble.

The magnet should be stored in a cool, dry environment and should be cleaned
with a damp cloth and mild detergent when exposed to harsh solvents. Do not
autoclave.

To install the magnet in the proper orientation:
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l Flat magnet: place in the plate carrier so the text on the side of the magnet is readable;

l Ring magnet: place in the plate carrier with the small round magnets visible, facing
upwards.

Realign the BioStack with the Magnet Installed

Using the magnet increases the effective height of the carrier surface (generally by
at least 1 mm). This shift in the plate position requires a comparable adjustment to
the BioStack’s gripper movement. Realign the BioStack before using it with the
magnetic bead assays.

Refer to the BioStack Operator’s Manual for detailed instructions of the alignment
procedure. To help get you started:

1. Place the magnet in the carrier and a microplate on top of it.

2. Launch the BioStack Alignment Utility:

LHC Keypad

Tools> BioStack Utilities> Alignment Utility SETUP >BIOSTK > ALIGN

3. HOME the BioStack and Begin Realignment.

4. Lower the claw until a 0.050” (1.3 mm) gap between the bottom of the plate and
the top of the gripper fingers is achieved and save the gripper position.

5. Put the microplate in the input stack and Verify the alignment.

Remember to realign the BioStack for non-bead assays, when applicable.

Perform Magnetic Bead Assays

For the best results when performing biomagnetic separation assays:
l Use the Manifold Stop Screw Adjustment Kit on page 94, if necessary.

l Realign the BioStack with the Magnet Installed

l Change the Magnet Height Offset on page 93

l Optimize Magnetic Bead Protocols below

Optimize Magnetic Bead Protocols

Here are some suggestions to consider for optimizing your magnetic bead assays:
l Plate Type: Flat-bottom plates are recommended for magnetic bead assays because
more of their well surface sits closer to the magnet, resulting in increased magnet
strength, than with other plate formats. If you must use round-bottom plates, increase
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the between-cycle soak time to improve bead separation during processing.

l Shake/Soak Step: Begin the protocol with a delay to let the magnetic beads settle.
Also, specify a mid-cycle soak to let the beads settle after fluid is dispensed to the plate,
e.g. include a 60 second soak before and between cycles.

Include a 1 second Shake in the first step to best position the plate.

l 6CW Aspirate Travel Rate: select 6CW for the aspirate travel rate. The CW travel
rates are designed to minimize disruption to cell layers on the bottom of the well. The
same principle applies to magnetic bead assays.

l Adjust the Aspirate height: increase the aspirate height setting (Z-axis) which will
increase the residual fluid in the wells but also preserve the beads. Good results were
obtained when keeping the aspirate height around 1.0 mm above the plate carrier for all
but a last Final Aspirate (disabled between cycles).

l Adjust the Aspirate position: When using Flat Magnets below, position the aspirate
tubes near the sides of the wells (X-axis), if possible, to improve bead retention.

l As always, before running assays, we recommend testing new protocols using deionized
or distilled water and a little Tween® 20 with the desired microplate and a magnet
installed.

Flat Magnets

Use this information about the flat magnets to fine-tune wash protocol settings:

96F Magnet 7103016

384F Magnet 7103017

The 96- and 384-well magnets are structured differently. Their force fields traverse
the magnet in opposite directions. Magnetic beads in the wells will be drawn to the
center. For the best bead retention, reposition the aspirate tubes in the proper axis:

96-well Flat Magnet PN 7103016

The magnetic force (approx. 6800 Gauss)
is distributed in a horizontal pattern,
row-wise, across the plate. Magnetic
beads are pulled to the center, across the
well in flat-bottom plates and to the
button in round-bottom plates. Increasing
the aspirate height to increase the
amount of residual in the well may
improve performance.
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Aspirate Settings:

Adjust the Y Position to align the
aspirate tubes near the well walls, if
available. Increase the Aspirate Height (Z
axis), leaving more residual volume in
the wells.

384-well Flat Magnet PN 7103017

The magnetic force (approx. 4300 Gauss)
is distributed in a vertical pattern,
column-wise, across the plate.

Adjust the X Position to align the
aspirate tubes away from the center of
the well, near the well walls.

Ring Magnets

Use this information about the VP magnets to fine-tune wash protocol settings:

96 Ring Magnet 7102216

384 Ring Magnet 7102215

96 Ring Magnet
PN: 7102216

This magnetic bead separator uses
329 of VP’s 52 MGO magnets (7094
Gauss). The magnets are arranged
around each well, pulling the
magnetic beads to the bottoms and
edges of the wells. Aspirate from
the center of the well (the default
position), when using this magnet.

384 Ring Magnet
PN: 7102215

This magnetic bead separator uses
425 of VP’s 52 MGO magnets (6994
Gauss). The magnets are aligned
with the intersections of the wells,
pulling the magnetic beads to the

Aspirate from the center of the well
(the default position), when using this
magnet.
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bottoms and edges of the wells.
Every well is circled by 4 magnets.

Magnet Height Offset

When performing magnetic bead assays/biomagnetic separation, this offset setting
is a real time saver. It increases the height or Z-axis for all processing options to
accommodate the increased height of the plate when the magnet is installed.

This setting eliminates the need to modify individual protocol parameters to adjust
the dispense and aspirate heights and enables Quick Wash (without adjustments)
when the magnet is used. It applies the specified height value as an offset to all
relevant steps.

Custom or non-standard microplates and special adapters for labware may benefit from
this setting, too. If a vessel's height has been its only limitation to processing with the 405
LS, i.e. the vessel's geometry permits the manifold tips to successfully address its wells,
this setting can be used to simplify protocol development.

See Determine Magnet Height Offset below.

For the best results, measure the height of the plate you are using with the magnet.
BioTek has determined that Nunc flat bottom plates are about 3 mm taller than a similar
Corning plate, for example.

The "In use" checkbox/option lets you specify and retain a height setting. Set the
value once and then use the control to switch it on and off: fill the checkbox
(keypad users: say Yes) when using a magnet, empty the checkbox (keypad: No) to
disable the offset.

LHC Keypad

1. Tools> Instrument Utilities> General

2. Fill the In use checkbox and set the Magnet
Adapter height to the correct offset.

3. Click the Send link.

1. SETUP > MAGNET

2. Select YES.

3. Enter the desired offset
value and press Enter.

Determine Magnet Height Offset

Use a caliper for the best results or another measuring device.
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1. Measure the combined height of the
plate, magnet, and carrier in
millimeters.

2. Measure the plate and the carrier.

3. Calculate the offset: (plate + magnet +
carrier) - (plate + carrier) = Magnet
Height Offset

1. Remove the carrier from the washer.

2. Put a magnet in the carrier and the type of plate you will be using on top of it.

3. Measure the distance from the bottom of the carrier to the top of the plate in
millimeters (mm).

4. Remove the magnet, and measure the plate and carrier combined.

5. Subtract the plate and carrier measurement from the measurement value of the
total combined elements. This is the offset value to use.

Example:

24.6 mm = 96-well Corning microplate + 96-well flat magnet + plate carrier

- 22.7 mm = 96-well Corning microplate and plate carrier

1.9 mm = Magnet Height Offset

Manifold Stop Screw Adjustment Kit

For Magnetic Bead Assays and 384-Well PCR Plate Processing

To successfully perform these assays, 405 LS Select and HT models may need to
adjust the height of the manifold stop screw. The adjustment kit, PN 1170011, is
shipped with instruments with a dual manifold.
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The manifold stop screw prevents the
bottom manifold from touching the
microplate during operation. Sometimes
the screw installed at the factory is too tall
or too short to permit desired processing:
l a taller screw is needed to support a magnet
under the plate for magnetic bead assays

l a shorter screw is needed to support
processing of 384-well PCR plates that have
a very low profile

Two stop screws can reside in the plate
carrier, making it easier to swap between
them.

Microplate Carrier
Kit Contents:

l Screw height measurement tool (jig)

l Two stop screws with adjustable nuts and
lock washer

l 5/32" Allen (hex) wrench

l Two wrenches - 5/16" and 3/8"

Remove the carrier to perform most of these steps but always perform the
measurement steps with the plate carrier installed correctly on the 405 LS.

1. In the carrier's empty hole,
insert the taller stop screw
when using a magnet or the
shorter screw when using
PCR plates.

2. Put the magnet and
microplate or the 384-
PCR plate in the carrier on
the instrument. Place the
height-measurement tool (or
jig) on top of the
microplate, with the
notched end above the
screw.
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3. Hold the jig level on top of
the microplate and raise or
lower the stop screw so its
head touches the bottom of
the notch.

4. Set the jig aside. Using your
fingers, hold the stop screw
in place and screw the
bottom nut down until it
touches the microplate
carrier.

5. Using the two supplied
wrenches, tighten the
bottom nut to secure the
screw, then tighten the top
nut to fully compress the
washer between them. This
will lock the nuts in place
and allow you to easily
remove/replace the screw
without affecting its height
setting.

6. Verify the height with the jig and repeat steps 3-6 if necessary.

Instrument Settings: Try applying different Plate Clearance and Magnet Height Offset
settings to optimize performance with special plates, like 384-PCR.
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Vacuum Filtration for Filter Plate Assays

With the optional vacuum filtration accessory kit, you can process most standard-
size filter-bottom microplates.

To perform filter plate assays:
l Install the side bracket on next page

nFollow instructions provided with the accessory kit.

l Set up the Vacuum Filtration module

l Install Vacuum Filtration Plate Carrier on page 103

l Create a Vacuum Filtration Protocol on page 101

Maintenance guidelines: Maintaining the Vacuum Filtration System on page 133

nFor the best results, take a few moments to learn how to Control the Vacuum
Level on page 104.

Take advantage of the sample vacuum filtration protocols shipped onboard the 405 LS.
Copy W-Luminex_Vac_96, for example, and modify the parameters to suit your assay
requirements.

Recommendations for best performance:

Here are some guidelines to achieve the best performance of your filter plate
assays:

l Do not use dry filter plates. If dry plates are required by the assay kit
instructions, turn off the Vacuum Filtration sensor to avoid process
interruptions.

l Shake the plate to suspend the beads before aspiration. Enable the wash
cycle option to shake the plate after the dispense and before aspiration. Also
consider creating a multi-step protocol that begins by shaking the plate.

l Experiment with the two parameters, aspiration time and vacuum level, to
determine the best combination of settings for your assay. Start with a brief
time period and low vacuum to avoid lodging the beads in the filter
material.

l Maintain consistent vacuum during the process with a tight seal:
o Use new or defect-free filter plates and make sure they are seated perfectly in the
carrier;

o Make sure all tubing is connected correctly, and leak-free.
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Expect to spend some time experimenting with different pressure settings. Follow
the filter plate manufacturer's recommendations, if available. Generally, bead
assays prefer low pressure and DNA separation assays prefer higher pressure. The
best performance in tests at BioTek were seen when the pressure was set to 2.5
inHg.

Install the side bracket

Install the bracket on
the right side of the
washer to hold the
vacuum filtration
tubing used to

evacuate the filter
plate.

Locate the screws shippedwith the bracket

Required: Philips screwdriver

1. Locate the two empty holes on the right side of the washer and line up the
bracket over the holes.

2. Insert the screws using the Philips head screwdriver.
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Set up the Vacuum Filtration module

Connect the Intermediate Waste System

Intermediate Waste System Setup

For this step you will need the Vacuum Filtration tubing, intermediate waste
bottle, and the control module. Review the tubing map on the front of the
control module. It is a good guide for this step.

Three lengths of tubing are supplied to set up the control module. Connect the
tubing to the control module and to the intermediate waste bottle cap:

Tubing Control
Module Waste Bottle Cap

1 Dual tubing connected by Luer
fitting, approx. 15”/38.1 cm

Intermediate
Waste Out

Smallest nipple with long
interior tube

2 Long single tube, approx. 15”/
38.1 cm

Intermediate
Vacuum Supply

Nipple without a tube inside
the bottle
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Tubing Control
Module Waste Bottle Cap

3 Short single tube, approx.
12”/30.48 cm

Intermediate
Waste In

Nipple with the wide, split-
tube extension in the bottle

nTwo other quite distinct tubing sets are used in subsequent steps.

1. Put the intermediate waste bottle into the bracket on the side of the control
module.

2. Connect the tubing with the Luer fitting to the port labeled Intermediate Waste
Out and to the smallest nipple on the waste bottle cap.

3. Connect the longest single tube to the port labeled Intermediate Vacuum
Supply and to the nipple without a tube inside the bottle.

4. Connect the shortest tube to the port labeled Intermediate Waste In and to the
waste bottle cap nipple with the wide, split-tube extension inside the bottle.

Connect to Waste System

Connecting the Vacuum Filtration module to the washer
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This step requires the Y-connector waste tubing which is provided to connect the
control module to the washer’s main waste system.

1. Remove the main waste system tubing from the Vacuum port on the back of the
washer (waste tube with green bands on both ends), if it is installed. Plug it into
the barbed fitting of the Y-connector waste tubing.

2. Connect the branch of the Y-connector that does not have a green band (tube
with no tape) to the control module port labeled To Waste Line.

3. Connect the other end of the Y-connector (with green band), to the Vacuum port
on the back of the washer.

Connect the Vacuum Filtration Control Module to the Washer

Connect the supplied cable from the round port labeled To Filtration Valve
Control on the control module to the corresponding Vacuum Filtration Control port on
the back of the instrument.

Enable Vacuum Filtration

LHC 405 LS Keypad

1. Select Tools>Instrument
Utilities>Washer

2. Select installed for the Vacuum
Filtration Module.

1. Press Setup Menu.

2. Selectg>ADVANC>VACFIL.

3. Select Yes for Vacuum Filtration
Module.

Create a Vacuum Filtration Protocol

You may want to begin the protocol with a Shake step to suspend the beads.

LHC: Keypad:

1. Click (or select File>New).

2. Select the plate type.

3. Specify a Protocol Name.

4. Click

5. Click Show Wash Options

6. Fill the checkbox for Vacuum Filtration

1. At the main menu, select
DEFINE>CREATE and assign a
unique name to the protocol.

2. Select the plate type.

3. Select ADD>WASH

4. Select ASPIR>VAC

5. Specify the duration to apply
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LHC: Keypad:

and specify the vacuum duration, Time.
Optionally, do the same for the Final
Aspirate.

vacuum.

6. Select OPTS>MIDCYC and add
a Shake duration to follow each
dispense to suspend the beads
before applying the vacuum.

7. Select OPTS>POST to either
disable the Final Aspirate or
make sure it is defined for
vacuum filtration.

8. Experiment with other
parameters, like number of
cycles, to optimize the protocol
for your assay.

7. Fill the checkbox for Shake/Soak and
specify the shake duration.

Experiment with different settings to determine the optimal parameters to meet
your goals.

n Important: Be sure to change the Plate Carrier setting to match the installed
carrier.

Remember to specify the type of aspiration to perform in a Final Aspirate. Keypad
users: select OPTS>POST at the Wash Step Parameters menu.
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Install Vacuum Filtration Plate Carrier

Vacuum Filtration Plate Carrier (and bracket for holding tubing)

1. Locate the longest length of tubing shipped with the module. It is made from
two tubes joined by a rigid connector.

2. Connect the shorter end to the special plate carrier for vacuum filtration.

3. Connect the longer end to the control module port labeled To Vacuum
Filtration Carrier.

4. Tuck the rigid connector into the bracket you installed on the side of the
instrument.

5. Change the instrument setting:

LHC Keypad

1. Select Tools> Instrument
Utilities.

2. For Plate Carrier
Selection, select Vacuum
Filtration.

1. Press Setup Menu >
MORE > CARR

2. Select VAC.

Note: Make sure Vacuum Filtration is "enabled" to select the special plate carrier: Setup

Menu>g>ADVANC>VACFIL

Important: Always set the carrier selection to match the installed hardware, regardless
of the type of plate processing you are doing. You can perform a regular wash (non-filter
plates) using the vacuum filtration carrier.
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Control the Vacuum Level

Vent plugs stored on side of carrier

Change the vent plug to control the vacuum level

The vacuum filtration plate carrier has a vent and ships with four vent plugs to
vary the vacuum levels:

Plug Vent Diameter Vacuum Level mmHg kPa

No plug 0.067” (1.70 mm) Lowest -32 -4.3

Beige with hole 0.047” (1.19 mm) Low -118 -15.7

Gray 0.032” (0.81 mm) Medium -187 -24.9

Black 0.020 (0.51 mm) High -382 -50.9

Beige (solid) 0.00 Highest -567 -75.5

Leave the vent open for the least amount of vacuum. Insert one of the plugs to
increase vacuum.

nVacuum pressure is affected by several factors like relative humidity,
barometric pressure, and mechanical tolerances, as well as, filter plate pore
size
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Testing at BioTek confirmed expectations: small pore filter plates and highly
viscous fluids require increased vacuum and/or longer aspiration durations to
evacuate the wells.

Here are the results of our tests using 25% horse serum to give you a starting point
for your experimentation.

Plate and Dispense Volume Vent Plug Aspiration
Time

Millipore 96-well 0.45µM filter plate; 200 µL/well sample
volume

Beige
w/hole  

12.9 sec

Gray 8.8 sec

Black  7.1 sec

Beige 6.4 sec

Millipore 96-well 1.2 µM filter plate; 200 µL/well sample
volume

Beige
w/hole

6.2 sec

Gray 4.7 sec

Black 4.6 sec

Beige  3.9 sec

Millipore 384-well 1.2 µM filter plate; 100 µL/well sample
volume

Beige
w/hole  

8.9 sec

Gray  6.5 sec

Black 6.0 sec

Beige 4.7 sec

Washer Settings

Touch screen: Instrument>Options

LHC users: Tools>Instrument Utilities>Washer

Manifold Selection

After physically changing the manifold, tell the 405 LS which manifold is installed:
l 96-tube: single manifold for 96-well plates only or dual manifolds to process 96- and
384-well plates.

l 192-tube: only 384-well plates.

Magnet Height Offset
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When performing magnetic bead assays/biomagnetic separation, this offset setting
is a real time saver. It increases the height or Z-axis for all processing options to
accommodate the increased height of the plate when the magnet is installed.

This setting eliminates the need to modify individual protocol parameters to adjust
the dispense and aspirate heights and enables Quick Wash (without adjustments)
when the magnet is used. It applies the specified height value as an offset to all
relevant steps.

Custom or non-standard microplates and special adapters for labware may benefit from
this setting, too. If a vessel's height has been its only limitation to processing with the 405
LS, i.e. the vessel's geometry permits the manifold tips to successfully address its wells,
this setting can be used to simplify protocol development.

See Determine Magnet Height Offset on page 93.

In use - this checkbox lets you retain the height offset value while turning off its
application. After determining the offset, enter the Height value, fill the checkbox to
apply the Magnet Height Offset. Conversely, empty the checkbox to disable the
offset. LHC users: don't forget to click Send to apply the change.

Sensors Enabled
l Important: The washer must be primed, tubes filled, prior to a run.

l These sensors cannot detect the depletion of fluid in the supply vessel during a protocol
step. Fill the supply bottle(s) with sufficient fluid to fully prime the system and complete
the protocol.

Fluid Detection: measures the fluid level at the beginning and completion of a
wash cycle, dispense and AutoClean step. An error before the run suggests
insufficient fluid to begin. An error at the end of the run may indicate that less
volume than specified was dispensed.

Flow Detection: monitors fluid flow during the run and issues a warning if the
pump is interrupted. An error indicates a problem with the pump.

Filter Vacuum Detection: built into the vacuum filtration module, this sensor
detects errors in the setup of the vacuum filtration system, including disconnected
tubing, loose bottle cap, missing filter plate, non-functioning internal vacuum
pump and extremely low vacuum. This sensor is disabled by default.

Plate Detection: washers with Verify™ Technology offer this sensor to detect the
presence of a microplate on the plate carrier before every protocol run. BioStack
users: the sensor checks for the first plate in the stack only.
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BioTek recommends keeping the detection systems activated. Exceptions:

l Deactivate the Waste sensor when using BioTek's Direct Drain Waste System.

l When vacuum filtration assays need to be performed at very low vacuum levels, e.g. no
plug, but the washer displays an error, deactivate the sensor: LHC - "Filter Vacuum" or
Keypad - "Vac Fil".

l When running the system using air instead of fluid to dry out the components before
shipping or long-term storage, if error messages interrupt the procedure, deactivate the
fluid and flow sensors.

CW+ Control

This setting is applicable only to cell wash assays that use dispense flow rates 1
CW and 2 CW. Generally, the optimal instrument configuration for cell wash assays
includes installation of the CW+ Dispense Manifold and enabling this control with the
default 100 msec setting. If the CW+ Dispense manifold is not installed, better
performance may be achieved by disabling this setting. Additionally, a minor
adjustment to the duration setting may improve the performance of certain
instruments.

Service Functions  

Position the wash manifold to install the shipping bracket: prior to packing up the
instrument, click the link and install the manifold shipping bracket.

Change the Washer Manifold Setting (Keypad)

The instrument's onboard settings must match the installed hardware.

If you have multiple wash manifolds, in addition to physically changing the
manifold (Remove/Change Wash Manifold on page 145), you must also change the
instrument manifold setting:

1. Press Setup Menu (button in center of keypad).

2. Selectg and then MANIF.

3. Select the currently installed wash manifold by pressing its Soft-key: Single or
Dual 96-tubeor 192-tube manifold.

Change the Plate Carrier Setting (Keypad)

The instrument's onboard settings must match the installed hardware.

When you physically change the plate carrier to perform special assays, you must
also change the instrument carrier setting to direct the devices to higher or lower
positions to accurately address the wells:
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1. Press Setup Menu (button in center of keypad).

2. Selectg and then CARR.

3. Select the currently installed carrier by pressing its Soft-key:
o STD - Standard (Magnet Ready) carrier

o VAC - Vacuum filtration carrier.

Change the Plate Clearance Setting (Keypad)

The Plate Clearance setting adds the specified (input) value to the travel height for
the selected plate type, i.e. it adds this number to the "Plate Height" value cited in
the Plate Types Table. The manifold rises to this height to move from one column
to the next and whenever repositioning is needed. This setting does not affect
dispense and aspirate heights.

Use this setting to accommodate plates that are slightly taller than standard plates
to make sure the manifold rises high enough above the plate to prevent crashes
when the plate carrier moves.

Note: Enabling the Magnet Height Offset affects the travel height, as well as dispense
and aspirate heights. The Magnet Height Offset increases the respective values of all
height parameters. Generally, it is best to keep the default setting for Plate
Clearance when using the Magnet Height Offset setting.

To change the setting using the keypad:

1. Press Setup Menu (button in center of keypad).
2. Selectg and ADVANC then PLTCLR.

3. Enter an offset value in millimeters (mm).

Adjust Utility

LHC: Tools>Instrument Utilities>General Information

Keypad: Select UTILS>ADJST from the main menu

The Adjust Utility is a tool for determining the precise positioning of the dispense
and aspirate tubes when addressing the plate. Generally, the components' default
positions function perfectly, but certain assays may be improved by repositioning
the dispense or aspirate tubes. For example, to minimize cell damage, tubes can be
positioned at the sides of the wells, rather than the center. Use the utility to identify
the offsets required, then, enter these offsets when defining the protocol step.
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The Adjust Utility puts the plate in its run position and lets you position the plate
in relation to the manifold. You can:
l Raise or lower the manifold in the Z-axis, to determine the optimal dispense or aspirate
height, for example. The default positions are based on the plate type.

l Position the tubes in the X and Y axes by moving the plate carrier. The default position is
the center of the well, 0 steps:

o Move the carrier left or right in the X-axis. Negative offsets move left of center;
positive offsets are right of center.

o Move the carrier forward and back in the Y-axis. Negative offsets move the plate
backward from center; positive offsets place the plate forward of center.

Warning: The Adjust Utility does not have limits to protect you from making bad
choices. It is possible to identify dispense positions that miss the wells, for example. If
incorrect values are defined in the protocol, you'll have a big mess on your hands.

Positional Limits:

The allowable ranges for positioning the devices for operation:

X Y Z
Washer -60 to 60 steps

2.74 mm offset
-40 to 40

2.96 mm offset
1 to 210 steps
26.68 mm max

Run the Adjust Utility (Using the Keypad)

This page describes how to run the Adjust Utility using the keypad rather than the
LHC. Find LHC instructions in the Help system.

l Learn about the Adjust Utility on previous page.
l Keep in mind the positional limits of the devices during operation.

1. Place a microplate on the carrier.

2. Select UTILS at the main menu and then select ADJST.

3. Select the PLATE TYPE. Only valid options for the installed hardware are
presented for selection.

5. Select a run position. Only one position may be viewed at a time.
o for the Washer choose ASPIR (aspiration) or DISP (dispense) depending on which
tubes you are measuring offsets for;

6. At the AXIS screen, choose an axis, Z, X or Y. The top line of the display
indicates which axis is active, and the offset position of that axis:
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Axis Washer

Z-axis (up/down) MAN Positions the manifold or dispense arm.

X-axis (left/right) CARX Positions the plate carrier.

Y-axis (front/back) CARY Positions thee plate carrier.

7. Closely observe the position of the hardware. Use arrow keys: t (reverse) and
u (forward) to single-step the offset in either direction.

8. When the desired offset position is found, record the position number to enter
later when defining a wash, dispense, or aspirate step.

9. To quit the Adjust Utility, press Main Menu. The carrier and manifolds return
to their default positions.

Plate Types and Processing Patterns

Depending on the type of hardware installed on the instrument, e.g. manifold type,
the 405 LS can process several plate types. The default parameters for wash and
dispense steps represent the optimal positioning of the hardware for the plate type.
And, the aspirate and dispense heights and horizontal positions can be adjusted
when necessary for special situations and to optimize assay performance.
l Review the Plate Types Table on the facing page for a listing of supported plates and
their geometries;

l See About Wash Processing Patterns on the facing page in the Help system or
operator's manual.

l See Dispense Processing Patterns in the Help system or operator's manual.

l Review these instrument settings that may improve your work flow:
o Plate Carrier Setting

o Plate Clearance Setting

o Peri-pump Dispense Pattern
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Plate Types Table

Plate Type
Columns x
Rows

Plate
Height

Default
Aspirate/
Dispense
Heights

mm Washer

96 Well 12x8 14.35 29/121

384 Well 24x16 14.22 22/120

384 PCR² 24x16 9.50 2/83

² Low profile 384 PCR plates require manually adjusting the height of the manifold stop screw.

Plate Geometry Diagram

Plate height = physical measurement

Default Dispense Height = (plate height - flange height + 1.0 mm)

Travel Height = (plate height - flange height + Plate Clearance)

n If Dispense Height > Travel Height (greater than), the travel height is changed
to match the dispense height.

About Wash Processing Patterns

When using a 96-tube manifold to process a 96-well plate, all wells are processed
simultaneously. To process 384-well plates, a processing pattern is needed, which
also provides the ability to process the plate partially. Some portions of the plate
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can be left untouched or panels can be defined, i.e. multiple assays can be run on
the same plate.

The processing pattern is determined by the hardware's footprint.

96-tube wash pattern for 384-well plate

To process a partial plate, you must select the sector or sectors you want to process:

nKeypad users see: Define the Plate Type and Plate Map or Partial Plate on page
50 for instructions.

Checkmarks show the sectors to be processed. Numbers show
potential sectors that are currently unselected and will not be washed. The 96-tube
manifold processes the plate in four sectors.

A B
C D

192-tube wash pattern for 384-well plate

To process a partial plate, you must select the sector you want to process:
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nKeypad users see: Define the Plate Type and Plate Map or Partial Plate on page
50 for instructions.

Checkmarks show the sectors to be processed. Numbers show
potential sectors that are currently unselected and will not be washed. The 192-tube
manifold processes the plate in two sectors.

A B
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Maintenance

Properly maintaining the 405 LS is the key to reliable
performance.
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Storing the Instrument 144
Replace Components 144
Remove/Change Wash Manifold 145
Replace the Vacuum Pump Fuse 145
Vacuum Filtration Carrier: Replace the Gasket 146
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Overview

A Preventive Maintenance (PM) regimen for the 405 LS includes rinsing and
soaking the fluid path and cleaning and/or autoclaving the various components.
The level of maintenance required to keep the instrument performing as expected
is dependent on several factors, including the type of fluid dispensed, the
frequency of use, and the work habits employed.

The Recommended Maintenance Schedule on page 119 summarizes BioTek’s
recommended maintenance tasks, and indicates approximately how often each task
should be performed. Daily and periodic routines and minimal guidelines for
frequency are listed. Beyond that, it is difficult for BioTek to recommend a fixed
frequency for each task to be performed. The frequency of conducting these tasks
must be based on the risk and performance factors of your assays.

Develop a maintenance schedule for your 405 LS based on the characteristics of the
fluids used and the activity level. Here are some guidelines for each component:

Washer
o When using fluids prone to dry and harden quickly, the washer’s dispense and
aspirate tubes can clog quickly, and must be rinsed frequently and cleaned
regularly. Run AutoClean ultrasonic cleaning regularly, when available.
Otherwise, Remove and clean the washer manifold on page 131.

o If the washer will be idle for several hours or days at a time, soak the tubes to
keep them in a ”wetted” state. Enable AutoPrime if the washer is idle for more
than 3 hours.

o Wash solutions affect the rinse frequency. If the solution does not contain
surfactant, consider rinsing (or running AutoPrime) at least once an hour.

Recommended Maintenance Schedule

The schedule recommends preventive maintenance tasks, the frequency with which
each task should be performed, and the predefined onboard Maintenance program
that should be run (if applicable). See Recommended Maintenance Schedule on
page 119.

n It is important to note that the risk and performance factors associated with
your assays may require that some or all of the procedures be performed
more frequently than suggested in this schedule.

nWater: Daily maintenance is the key to keeping the liquid handler performing
to specifications. In the maintenance procedures provided in this manual, the
requirement to use distilled (dH2O) or deionized (DI) water can be met by
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numerous water purification methods, including MilliQ™. A minimum water
purity of 2mOhm is expected.
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Recommended Maintenance Schedule

Keypad Users: The protocol names onboard the washer do not include the W- prefix and
some protocols include the model name, e.g. 405HT or 405Select, when appropriate.

Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before
storage/
shipment

Run W-DAY_RINSE ü ü

Run AutoPrime ü

Run W-OVERNIGHT_LOOP ü

Run W-RINSE_AND_SOAK ü

Run Verify™ clog detection test ü

Run AutoClean ü ü

Components

Remove protein residuals and
fungi growth, (if necessary)

ü ü ü

Check/empty waste bottles ü ü

Clean bottles ü ü

Clean plate carrier system ü ü

Clean washer manifold ü ü

Clean aspirate and dispense tubes ü ü

Clean exterior surfaces and mist
shield

ü

Clean fluid inlet filter ü ü

Clean vacuum filtration system ü ü

Clean the Verify™ level sensor ü ü

Decontaminate

Decontaminate external surfaces ü ü

Run W-DECONTAMINATE ü ü

Decontaminate vacuum filtration
system

ü
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Tasks

Frequency

Daily Overnight/
Multi-Day

Weekly Periodic/
Monthly

Before
storage/
shipment

Prepare for Storage or Shipment

Run W-LONG_SHUTDOWN ü

Replace/Repair Components

Replace the Verify Test Plate As Needed
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Daily Maintenance

Daily maintenance involves flushing the washer with an appropriate reagent or
deionized water throughout the day.  Routine rinsing helps to prevent the aspirate
and dispense tubes from clogging between runs. Flushing the devices with
deionized water is recommended at the end of the day for most applications.

The recommended rinsing frequency depends on the solutions currently in use: 

l When a solution containing surfactant is used throughout the day, perform
the rinsing procedure when the device is idle for more than 3 hours.

l When the solution does not contain surfactant, consider rinsing at least once
an hour.

Run this protocol and enable AutoPrime to satisfy the daily maintenance
requirements:

l DAY_RINSE

Make sure the supply bottles contain sufficient rinse solution and that the waste
bottles are empty before running the protocols.  

Also see the additional maintenance procedures required when dispensing protein
solutions: Removing Protein Residuals and Fungi Growth on page 124.

AutoPrime

AutoPrime automatically conditions the dispense tubes, priming them with the
specified volume, after a user-specified amount of idle time. See AutoPrime on
next page.

l Press the STOP button to interrupt the AutoPrime routine when it is
underway.

l Any interaction with the instrument via the keypad or the LHC resets the
interval clock.

l AutoPrime only runs when the main menu, quick menu, or run completion
message is displayed on the keypad.

Overnight/Multi-Day Maintenance

Overnight/multi-day maintenance involves flushing all solutions out of the
instrument, and then periodically rinsing and soaking the tubes to keep them
moist. Here are three recommendations for accomplishing the task. Employ the
method that best suits your work flow:
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Overnight Loop

To keep the wash manifolds in a wetted condition, you can run these predefined
protocols to soak the tubes for several hours at a time:

l OVERNIGHT_LOOP: requires the washer to remain turned on.

l RINSE_AND_SOAK: alternatively, run this protocol and turn off the
instrument after the soak begins. The tubes will soak in the priming trough
until the instrument is turned on again.

AutoPrime

LHC: Tools>Instrument Utilities> AutoPrime

Keypad: Select UTIL at the main menu, then AUTPRM

Recommended for optimum performance, AutoPrime keeps the tubing wet in
between runs and can be an essential part of your daily maintenance routine.

About AutoPrime

AutoPrime automatically primes the tubing whenever the instrument is idle for a
specified time. Keeping the tubes wet prevents clogging and mitigates fluid
evaporation at the tips. AutoPrime's submerge feature lets you soak the tubes for
extended periods, which is an effective maintenance option.

Specify the Interval and AutoPrime Parameters

AutoPrime runs when the instrument has been idle for a specified interval.

To set the AutoPrime Interval:

LHC: Keypad:

1. Select Tools>Instrument
Utilities> AutoPrime tab.

2. Specify the idle-time
interval that will trigger
an AutoPrime; up to 24
hours.

3. Enable and define the
parameters. Remember to
set a Submerge Duration to
employ this option.

1. Select UTILS at the main menu
and select AUTPRM.

2. Specify the idle-time interval
that will trigger an AutoPrime;
up to 24 hours in minutes and
press Enter.

3. Set the Submerge Duration, if
desired.

4. "Enable AutoPrime."
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LHC: Keypad:

4. Click Send to transfer the
settings to the instrument.

5. Define the AutoPrime
parameters: rate, volume, and
buffer valve, if applicable. Press
Enter at each screen to advance
to the next.

AutoPrime for Overnight-Weekend Maintenance

AutoPrime can be used to keep the manifold tubes wetted during idle periods
throughout the day and then modified to soak the tubing for longer periods
overnight and on the weekends. See AutoPrime on previous page for setup
instructions.

AutoPrime Parameters Washer

AutoPrime Interval 15 minutes

Device Washer

AutoPrime Yes/Enabled

Volume 90 mL

Rate 09

Buffer Any

Submerge Duration 120 minutes/2 hours

Turn on AutoPrime for the Washer

l Learn about AutoPrime, if you haven't already done so.

nKeypad users: Select UTIL at the main menu, then AUTPRM and specify
parameters.

1. Select Tools>Instrument Utilities>AutoPrime.

2. Fill the Enabled checkbox.

3. Set the AutoPrime Interval: enter the downtime interval that will trigger an
AutoPrime.

4. Select the Buffer to use if you have Buffer Switching installed.

5. Set the Volume and Rate. The default values are 40 mL at flow rate 9.
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6. You can Submerge the manifold tubes in the fluid after the prime, if desired.
Set Duration in Hours and Minutes.

After the dispense tubes have been primed, the manifold moves down into the
priming trough that is filled with the dispensed solution. The vacuum pump is
turned off and the tubes are allowed to soak. After the specified duration, the
vacuum pump is turned on and the trough is aspirated.

It takes approximately 93 mL of fluid to fill the priming trough. Be sure to
specify a volume of fluid that will cover the tubes.

7. Click Send to transfer the settings to the instrument.

Keep in mind:

l AutoPrime can be stopped when it is underway: press STOP on the keypad.

l Any interaction with the instrument via the keypad or the LHC resets the
interval clock.

l AutoPrime only runs when the main menu, quick menu, or run completion
message is displayed.

Removing Protein Residuals and Fungi Growth

Important! Solutions containing proteins, such as bovine serum albumin (BSA), will
compromise the 405 LS’s performance over time unless a strict maintenance regime is
adhered to. Do not use isopropyl alcohol to flush out BSA.

When using protein solutions or similar fluids, BioTek recommends performing the
following additional Maintenance procedures to thoroughly flush out protein
particles and other contaminants from the fluid path.

Daily Practice with buffer or deionized water:

If the 405 LS will be idle between plates for longer than 45 minutes, flush the
proteins:

1. Fill a supply bottle with deionized water. Connect the bottle to the washer.
(Buffer valve “A” for Buffer Switching models)

2. Run the DAY_RINSE protocol.

3. Enable AutoPrime for 60-minute intervals.

At the end of the day:

1. Fill a supply bottle with deionized water. Connect the bottle to the washer
(Buffer valve “A” for Buffer Switching models).
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2. Run the DAY_RINSE protocol three times.

3. Perform your regular Overnight/Multi-Day Maintenance routine.

Weekly or As Needed use NaOH and HCl to remove proteins:

1. Flush the system with 0.1-0.5 N* NaOH (sodium hydroxide), followed by
neutralization with an equivalent normality (0.1-0.5 N) of HCl (hydrochloride).

2. Rinse well with deionized water to remove the HCl.

3. Run the applicable DAY_RINSE protocol three times with deionized water if
you plan to use the device immediately.

n* N = Normal solution, which contains 1 ‘gram equivalent weight’ (gEW) of
solute per liter of solution. The gram equivalent weight is equal to the
molecular weight expressed as grams divided by the ‘valency’ of the solute.

Alternatively use an Enzyme-Active Detergent:

1. Mix an enzyme-active detergent according to the manufacturer’s directions to
fill a four-liter supply bottle. Connect the bottle to the washer’s Buffer valve A.
Connect a bottle of deionized or distilled water to Buffer valve B to rinse the
tubing.

2. Run the DECONTAMINATE protocol, as appropriate.

3. LHC users: Respond to the Delay message, “Connect a bottle of water…”, leave
the detergent bottle connected and when ready, press Continue.

4. When the protocol is completed, connect a bottle containing four liters of
deionized water and run DAY_RINSE three times to flush the system.

AutoClean the Washer

Learn About AutoClean on next page

Some models of the 405 LS feature BioTek's Ultrasonic Advantage™ for easy and
thorough cleaning of the wash manifold. Instruments with AutoClean capability are
easily identified by the stainless steel priming reservoir built into the instrument's
base, under the wash manifold.

Warning!   Ultrasonic energy is present in the cleaning reservoir when the AutoClean
program is running. Do not put your fingers in the bath! Ultrasonic energy can harm
human tissue.

BioTek Instruments, Inc.



126 | Chapter 4: Maintenance

nImportant! Ensure there is adequate room in the waste bottle and sufficient
volume in the supply bottle before running AutoClean!

Tip: Detergent such as Terg-A-Zyme® added to deionized water in the supply bottle
helps to break down the water’s surface tension and enhances the cleaning process. Terg-
A-Zyme also contains protease enzyme for assimilating protinaceous residue such as
bovine serum albumin (BSA).

About AutoClean

BioTek's Ultrasonic Advantage™ is a built-in ultrasonic cleaner that provides
enhanced maintenance capabilities by using ultrasonic pulses in a water bath to
clean the manifold tubes. Ultrasonic energy causes cavitation forces within the
water bath, which in turn cause tiny vapor bubbles to be created. The formation
and subsequent collapse of these bubbles is the mechanism that cleans the
manifold tubes submerged in the bath.

The cleaner consists of a stainless steel reservoir with an ultrasonic transducer
bonded to the bottom of the reservoir. The reservoir is mounted under the washer
manifold and also functions as the priming trough.

nDo not try to remove the ultrasonic cleaner! Only BioTek authorized service
personnel should remove the ultrasonic cleaner for maintenance or repair.

While the program is running, the ultrasonic cleaner will pulse on and off
approximately every ten seconds, and you will hear a periodic hissing sound that
indicates the ultrasonic energy is present. 

nNot all 405 LS models are equipped with this feature.

Quick Clean (Keypad Only)

Select Quick>Sonic

Take advantage of the 405 LS's "Ultrasonic Advantage" to make sure the manifold
tubes are clean and clog-free.

1. Connect a bottle with detergent or an appropriate solution for your assay. The
405 LS primes the system with 300 mL/305 mL for CW models and fills the
trough with 93 mL for the sonicator. Buffer Switching models: specify the
CLNBUF (Clean Buffer) valve it is connected to; non-Buffer Switching models will
be prompted to change buffer bottles.
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2. Fill the "Rinse Buffer" bottle with at least 305 mL of deionized or distilled water
or with a wash buffer to leave the instrument primed and ready for use. Buffer
Switching models: specify the RINBUF (Rinse Buffer) valve.

3. Set the desired duration in minutes, up to 4 hours, to soak the tubes and run the
sonicator: use the arrow or Options key.

4. When you're ready, press Start.

Warning!   Ultrasonic energy is present in the cleaning reservoir when the AutoClean
program is running. Do not put your fingers in the bath! Ultrasonic energy can harm
human tissue.

nImportant! Ensure there is adequate room in the waste bottle and sufficient
volume in the supply bottle before running AutoClean!

Create an AutoClean protocol

Create an AutoClean protocol for regular use. Make sure it begins by priming the
tubing with the cleaning fluid. Approximately 93 mL of fluid fills the reservoir
during each run.

General Recommendation: Run AutoClean for 1 hour. Follow with a full prime using
deionized water to remove the detergent from the system and/or with a wash
buffer to leave the instrument primed and ready for use.

LHC Keypad

DEFINE>CREATE>NAME>PLATE>ADD>g>ACLEAN

Define the cleaning protocol:

1. First, add a Prime step to fully prime the
tubing with the cleaning fluid (or water).

2. Add an AutoClean step to the protocol.

3. Buffer Valve: select the supply bottle containing the desired cleaning
fluid if Buffer Switching is installed.

4. Duration: enter the duration, up to 4 hours. Input the time in minutes
when using the keypad; hours and minutes when using LHC.

5. Click OK to add a cleaning step to the protocol.
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Periodic Maintenance

Periodic maintenance involves cleaning the components on a regular basis to keep
the instrument running efficiently and in compliance with performance
specifications.  The recommended frequency for cleaning components is at least
monthly. The risk and performance factors associated with your assays may require
that some or all of the procedures be performed more frequently.

Warning! Internal Voltage. Turn off and unplug the instrument for all cleaning
operations.

nImportant: Do not apply lubricants to channel-end seals, bottle cover seals,
any tubing connection, or any surface that is a part of the fluid path. The use of
any lubricant on the fluid handling components will interfere with aspirate and
dispense performance, and may cause irreparable damage to these
components.

nWater: Daily maintenance is the key to keeping the liquid handler performing
to specifications. In the maintenance procedures provided in this manual, the
requirement to use distilled (dH2O) or deionized (DI) water can be met by
numerous water purification methods, including MilliQ™. A minimum water
purity of 2mOhm is expected.

Important!

l Do not immerse the instrument, spray it with liquid, or use a ”wet” cloth on it.

l Do not allow the cleaning solution to run into the interior of the instrument. (If this
happens, contact the BioTek TAC.)

l Do not expose any part of the instrument to the recommended diluted sodium
hypochlorite solution (bleach) for more than 20 minutes. Prolonged contact may damage
the instrument surfaces.

l Be certain to rinse and thoroughly wipe all surfaces.

l Do not soak the keypad. Instead, moisten a clean cloth with deionized or distilled water
and wipe the keypad. Dry it immediately with a clean, dry cloth.

Perform these preventive maintenance tasks regularly:

l Clean the Bottles below

l Clean the Plate Carrier on the facing page

Clean the Bottles

l Clean and rinse the supply bottles with deionized water before the first use, before each
refill, and, periodically, as necessary, to prevent bacteria growth.
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l Empty the waste bottle often (at least daily), and firmly seat the waste bottle stopper.

l Rinse the covers every time the wash or rinse bottles are filled.

l Accumulated algae, fungi, or mold may require decontamination.

nTo ensure that fluid does not back up into the vacuum pump during operation,
always operate the instrument with the waste sensor cable installed and the
waste detection sensor enabled (the sensor is enabled by default).

If fluid collects in the overflow bottle, thoroughly rinse the level-switch assembly and
bottle.

l Check the hex nuts securing the quick-disconnects to the bottle cap to ensure they are
not loose or corroded.

Clean the Plate Carrier

If liquid has overflowed onto the plate carrier, transport rail, or glide strips, some
buildup may occur and prevent the microplate from seating correctly on the carrier.
This can interfere with plate transport. Weekly cleaning is recommended.

1. Turn the instrument off.

2. Lift the carrier up and off the transport rail.

3. Clean the carrier, rails, and glide strips, using mild detergent and hot water,
70% isopropyl alcohol, or ethanol. Clean the priming trough, too.

4. If detergent was used, wipe the components with a cloth moistened with water.
Use a clean, dry cloth to dry the components.

5. Reinstall the carrier:
l If necessary, release the spring-loaded microplate clamp in the back left corner of the
carrier to level the carrier on the base.

Clean the Vacuum Filtration Carrier

Use a damp cloth to wipe up any spills, especially if the fluid is prone to dry and
harden quickly. If necessary, flush it out with warm water by holding it under a
running faucet for a few seconds.
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Clean the exterior surfaces and mist shield

1. Turn off the instrument and disconnect the power cable.

2. Moisten a lint-free disposable towel with water, or with water and mild
detergent. Do not soak the cloth.

3. Remove the mist shield if it is attached. Wipe the inside and outside surfaces of
the mist shield with the towel. Wipe the top surface of the instrument base and
all exposed surfaces of the instrument.

4. Verify™ Technology ("Q" models): Release the catch (on left side) and lift the
level-sense unit (above the wash manifold) to gain access to all sides of the
wand. Gently wipe off the wand.

5. If detergent was used, wipe all surfaces with a cloth moistened with water.

6. Use a clean, dry cloth to dry all wet surfaces.

Clean the Buffer Bottle Filter

Periodically clean the buffer bottle filter (PN 01310):

nPerform this task when the buffer bottle is empty or over a sink to catch
spillage.

1. Open the buffer bottle
and lift the cap and
its tubing up and out
of the bottle.

2. Remove the fluid
filter at the bottom of
the tubing.

3. Wash the filter with
hot water and a soft-
bristled brush, if
necessary.

4. Rinse the filter and
reinstall it.
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Remove and clean the washer manifold

nDO NOT AUTOCLAVE the manifold!

1. Run the system "dry” to remove any fluid: remove the supply tubing from the
fluid or connect an empty supply bottle to the 405 LS and run a prime protocol,
e.g. RINSE_&_SOAK, until the tubing is empty.

2. Turn off the instrument, disconnect the power cable and remove the mist shield.

nDual manifolds: Hold the two manifolds together as a single unit when
removing and reinstalling.

Have a towel handy to mop up drips from the manifold.
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3. Carefully remove the manifold(s)
and end plates.

4. Using a soft-bristled brush,
thoroughly clean the outside
surfaces.

5. Clean inside each tube with the
appropriate stylus
(aspirate/dispense). Flush hot
water through the cross channels to
wash away debris.

Soak the manifold in hot soapy water
before using the stylus if the manifold is
encrusted with residue.

Avoid pressing the stylus against the
sides of the tubes during cleaning. This
can cause the tubes to bend,
adversely affecting dispense precision.

6. Rinse the manifold with deionized or distilled water. Check to see if water
comes out of all dispense and aspirate tubes. If not, soak the manifold in hot,
soapy water and repeat.

7. When satisfied, reassemble the manifold and end plates.

8. Install the mist shield.

9. Reconnect the power cable and turn on the instrument.

10. Prime the system with deionized water by running DAY_RINSE or a similar
Maintenance or Prime protocol. Watch for leaks. If fluid leaks out of the back of
the instrument, firmly seat the tubing. If fluid leaks from the manifold, try
disassembling and carefully reassembling.

11. Verify aspirate/dispense performance visually or by performing the
qualification tests.

Ultrasonic Advantage™: For optimal results after using the stylus, fully prime the
system and run AutoClean for 30 minutes.
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Maintaining the Vacuum Filtration System

Perform the following tasks as part of your regular maintenance when you are
using the vacuum filtration system:

Clean the Vacuum Filtration Carrier

Use a damp cloth to wipe up any spills, especially if the fluid is prone to dry and
harden quickly. If necessary, flush it out with warm water by holding it under a
running faucet for a few seconds.

l Decontaminate the Vacuum Filtration System on page 142
l Vacuum Filtration Carrier: Replace the Gasket on page 146 (as needed)

Maintain the Verify™ Technology Components

To keep 405 LS's with Verify™ Technology, "Q" models, performing as expected:
l Keep the Verify Test Plate clean. Remove any salt deposits or other contaminants.

l Regularly inspect the plate for damage.

l Inspect the plate at least annually and replace it when necessary: Replacement
Procedure for Verify Test Plate on next page.

l Clean the level sensor at least annually or as needed: Clean the Verify™ Level Sensor
below.

Clean the Verify™ Level Sensor

Annually or as needed, give the level sensor a deep cleaning.

Clean the Collimator:

The collimator is the narrow plastic sleeve or arm
of the level sensor that focuses detection at the
wells.
1. Make sure the wash manifold is in its home

position. (Run Self-check, if needed.)

2. Turn off and unplug the washer.

3. Release the latch that holds the Verify unit in
place above the wash manifold.
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3. Gently pull the collimator off the level sensor.

4. Wipe off the collimator to remove any
contaminants. If necessary, soak the collimator
in hot, soapy water to remove material that
has hardened or resists cleaning.

5. Dry the collimator with a soft, lint-free towel
or allow to air dry.

6. When the collimator is completely dry,
reinstall it. Snap the collimator back in place
on the level sensor.

Replacement Procedure for Verify Test Plate

Before it leaves the factory, BioTek calibrates the 405 LS to use a specific Verify
Test Plate. That test plate is labeled with 405 LS's serial number. When a
replacement plate is needed, follow these instructions to recalibrate the 405 LS for
the new plate.
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Required Materials:

l Precision digital balance with a capacity of 400 g and readability of 0.01 g resolution

l 200 mL Solution #3: Dispense Precision solution. This volume is sufficient for two test
runs. See Washer Qualification Test Materials on page 155.

l The Excel spreadsheet provided on the operator's manual CD to perform the required
calculations: in the Verify Technology Spreadsheets folder, open
VerifyPlateReplacement.xls.

Prerequisites:

l Make sure the replacement Verify Test Plate is clean and dry to begin this procedure.

l Mix the dye solution, fill a buffer bottle attached to the washer, and fully prime the
system.

1. Perform Test Plate Alignment

LHC

1. Select Tools>Instrument Utilities>Verify Manifold>Configure Utilities.

2. Put the test plate on the carrier and click Test Plate Alignment.

This process updates configuration data needed to successfully run the Verify
routine.

2. Determine the Slope and Offset Volume Coefficients

nThis step is not mandatory but strongly recommended to ensure the most
reliable performance.

1. Put the Verify Test Plate on the balance and tare the balance.

2. Run the special procedure:

Touch screen LHC

1. Select Instrument>Other>Verify
Technology.

2. Select Plate Replacement (select this
button in the Sensor Calibration box)
and press Start.

1. Select Tools>Instrument
Utilities>Verify
Manifold>Configure Utilities.

2. Click the Sensor Calibration
link.

The 405 LS will perform the first part of the Verify process.

3. At the first pausing message, weigh the plate and record the Aspirate Weight
(WA) value.
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4. Put the Verify Test Plate back on the carrier and click OK to continue.

5. At the second pause, weigh the plate again and record the Dispense Weight
(WD) value.

6. Put the test plate back on the carrier and click OK to continue.

LHC users: A time and date stamped .txt file is created when the process is
completed.

Important: Touch screen users: Enter the weights onboard the washer when
prompted. The washer will perform the calculation described below and automatically
update the Slope and Offset. Skip the next two steps, but run the Verify routine as
advised in Step 9.

Format and evaluate test results:

7. LHC users only: In the Calibration Data folder, open the report. Copy and paste
all the data from the .txt file into the spreadsheet provided:

o Select Ctrl+A and Ctrl+C

o Select the From405 tab and paste (Ctrl+V) all the data into the worksheet
beginning at cell A1.

The slope and offset are calculated using these formulas:

Slope calculation: Slope =
W W

D D

( − )

9600× ( − )

D A

D A

Offset calculation: Offset Slope D= − ( × )
W

D0.096

D

o DD is the Dispense Scan Mean value

o DA is the Aspirate Scan Mean value reported in the date and time stamped .txt
file.

8. LHC users only: Review the current Slope and Offset values and change them to
match your calculated results, if they differ.

Touch screen LHC

To review the values that were updated by
this procedure:

1. Select Instrument>Other>Verify
Technology and select Advanced.

2. See the Volume Coefficients.

1. Select Tools>Instrument
Utilities>Verify
Manifold>Configure Utilities.

2. Click the Advanced settings link.

9. Run the Verify Manifold routine and confirm passing results.

Important: Write the 405 LS's serial number on the Verify Test Plate label.
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Volume coefficients - Slope and Offset

BioTek's Verify™ Technology level sensor has been calibrated at the factory to
work with a specific Verify Test Plate. These volume coefficients have been
gravimetrically determined and set for your washer-test plate combination.

Important: Do not change these values unless specifically instructed to do so by BioTek,
as when replacing the test plate, for example.

Note: default values are Slope = 0.6 and Offset = -200.0.
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Decontamination

Any laboratory instrument that has been used for research or clinical analysis is
considered a biohazard and requires decontamination prior to handling.

Decontamination minimizes the risk to all who come into contact with the
instrument during shipping, handling, and servicing. Decontamination is required
by the U.S. Department of Transportation regulations. Persons performing the
decontamination process must be familiar with the basic setup and operation of the
instrument.

The recommended frequency for decontamination is at least monthly, and before
shipment of the instrument to BioTek for calibration or repair.

nImportant! BioTek Instruments, Inc. recommends the use of the following
decontamination solutions and methods based on our knowledge of the
instrument and recommendations of the Centers for Disease Control and
Prevention (CDC). Neither BioTek nor the CDC assumes any liability for the
adequacy of these solutions and methods.  Each laboratory must ensure that
decontamination procedures are adequate for the biohazards they handle.

Warning! Internal Voltage. Turn off and unplug the instrument for all
decontamination operations.

nDo not immerse the instrument, spray it with liquid, or use a ”wet” cloth. Do
not allow the cleaning solution to run into the interior of the instrument. If this
happens, contact the BioTek TAC. Do not soak the keypad.

nWear prophylactic gloves when handling contaminated instruments.
Gloved hands should be considered contaminated at all times; keep gloved
hands away from eyes, mouth, nose, and ears.  Eating and drinking while
decontaminating instruments is not advised.

nMucous membranes are considered prime entry routes for infectious agents.
Wear eye protection and a surgical mask when there is a possibility of aerosol
contamination. Intact skin is generally considered an effective barrier against
infectious organisms; however, small abrasions and cuts may not always be
visible. Wear protective gloves when performing the decontamination
procedure.

Tools and Supplies

0.5% sodium hypochlorite (NaClO, or bleach)
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70% isopropyl alcohol (as a bleach alternative)

Deionized or distilled water

Priming plate

Safety glasses

Surgical mask

Protective gloves

Lab coat

Biohazard trash bags

Clean cotton cloths

Step-by-Step Decontamination Instructions:

l Decontaminate Exterior Surfaces below

l Decontaminate Tubing and Manifold on next page

l Alternate Decontamination Procedure for Tubing and Manifold on page 141

Decontaminate Exterior Surfaces

Caution! Be sure to check the percentage NaClO of the bleach you are using; this
information is printed on the side of the bottle. Commercial bleach is typically 10%
NaClO; in this case, prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in
this case, prepare a 1:10 dilution.

The bleach solution is caustic; wear gloves and eye protection when handling. 

1. Turn off the instrument and disconnect the power cord. Empty the waste bottle.

2. Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach).
As an alternative, 70% isopropyl alcohol (or 70% ethanol) may be used if the
effects of bleach are a concern.

nIsopropyl alcohol is not recommended for removing proteins (such
as bovine serum albumin).

3. Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth.
l Wipe the keypad (do not soak). Wipe again with a clean cloth moistened with
deionized or distilled water. Dry immediately with a clean, dry cloth.

l Remove the mist shield if it is attached. Wipe the inside and outside surfaces of the
mist shield.
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l Wipe the plate carrier, top surface of the instrument’s base, supply bottles and
tubing, and all exposed surfaces of the instrument.

4. Wait 20 minutes. Moisten a cloth with DI or distilled water.
l Wipe the inside and outside surfaces of the mist shield.

l Wipe the plate carrier, top surface of the instrument’s base, supply bottles, tubing,
bottle covers and all exposed surfaces of the instrument that have been cleaned
with the bleach solution or alcohol.

5. Use a clean, dry cloth to dry all wet surfaces.

6. Reassemble the instrument as necessary.

7. Discard the used gloves and cloths using a biohazard trash bag and an
approved biohazard container.

Decontaminate Tubing and Manifold

Predefined protocols to flush and soak the supply tubing and manifolds with
disinfectant, then flush the system with rinse fluid are installed onboard the
instrument and on the host computer during installation of the LHC:

o DECONTAMINATE for the washer

When storing or shipping the instrument, the LONG_SHUTDOWN procedure (on
page 143) primes and soaks the instrument, and ends by pushing air through the
system. The parameters can be edited for optimum cleaning. For example, consider
using ethanol instead of air to complete the decontamination process.

nTwo supply bottles are required for this procedure: one for disinfectant, and
one for rinse. Except Buffer Switching models require four bottles altogether,
two of each solution.

1. Empty the waste bottle.

2. Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach).

3. Fill one or two supply bottles with at least 300 mL of bleach solution
(disinfectant).

4. Fill another supply bottle or two with at least 500 mL of deionized water (rinse).

When using Buffer Switching:

l Buffer valve C & D: Disinfectant

l Buffer valve A & B: Rinse solution (they will be reversed in the next
round)
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Without Buffer Switching, connect the bottle containing disinfectant to the
Fluid In port.

5. Reconnect the power cord and turn on the instrument.

6. Run the decontamination protocols.

Preparing to run DECON or W-DECONTAMINATE:

With Buffer
Switching

Connect the supply bottles this way:
• Buffer bottles C and D: Disinfectant
• Buffer bottles A and B: Rinse solution
After disinfecting channels C and D, you will reverse this assignment
to disinfect channels A and B.
Keypad: Run DECON_STEP1, DECON_STEP2, and DECON_
STEP3.
LHC: At the prompt/delay, change bottles.

Without Buffer
Switching

Connect the disinfectant bottle to the Fluid In port.
Keypad: Run DECON_STEP1 followed by DECON_STEP2.
LHC: At the prompt/delay, change bottles.

Alternate Decontamination Procedure for Tubing and Manifold

If you are unable to run the decontamination protocols due to a system failure,
perform the following alternate decontamination procedure to disinfect the internal
tubing and manifolds.

Caution! Be sure to check the percentage NaClO of the bleach you are using; this
information is printed on the side of the bottle. Commercial bleach is typically 10%
NaClO; in this case, prepare a 1:20 dilution. Household bleach is typically 5% NaClO; in
this case, prepare a 1:10 dilution.

1. Turn off the instrument and disconnect the power cord.

2. Remove the mist shield.

3. Remove the wash manifold(s) and end plate(s).

nFor dual manifold models, hold the two manifolds (and end plates) together as
a single unit when removing and replacing them.

4. Prepare an aqueous solution of 0.5% sodium hypochlorite (bleach). As an
alternative, 70% isopropyl alcohol (or ethanol) may be used if the effects of
bleach are a concern.

nIsopropyl alcohol is not recommended for removing proteins (such as
bovine serum albumin).
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5. Soak the tubing and manifold in the bleach or alcohol solution. 

6. Wait 20 minutes. Rinse the tubing and manifold with DI or distilled water.

7. Use a clean, dry cloth to dry all wet surfaces of the tubes and manifold.

8. Reassemble the washer manifold, making sure that the o-rings/gaskets are in
place prior to reassembly.

9. Re-attach the mist shield.

10. Prime the system by running W-DAY_RINSE or a similar Maintenance or Prime
protocol. Watch for leaks. If fluid leaks out of the back of the instrument,
firmly seat the tubing. If fluid leaks from the manifold, try disassembling and
carefully reassembling.

11. Discard the used gloves and cloths using a biohazard trash bag and an
approved biohazard container.

12. Verify performance visually or by performing qualification tests.

Decontaminate the Vacuum Filtration System

First, disinfect the tubing, then, remove and soak the carrier:

Decontaminate the tubing:

Run the predefined protocol QC_96/384_VAC30/10_TEST (depending on your
instrument model) with disinfectant as the fluid supply to clean the tubing and
hardware used to perform filter plate assays.

1. Connect a supply bottle filled with 200 mL of bleach solution/disinfectant.

2. Insert the black vent plug into the vent port on the front of the carrier.

3. First prime the tubing.

4. Run QC_96/384_VAC30/10_TEST.

5. When the run is completed, replace the decontamination fluid supply with
deionized or distilled water and rerun it once or twice.

Decontaminate the vacuum filtration carrier:

1. Turn off and unplug the instrument.

2. Disconnect the tubing from the vacuum carrier.

3. Remove the carrier and soak it in the Decontamination (bleach) solution for 20
minutes.
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4. Rinse the carrier thoroughly to remove all bleach.

5. Use a clean, dry cloth to dry all wet surfaces.

Inspect the plate seal gasket and replace it if defects are observed replace the
gasket: Vacuum Filtration Carrier: Replace the Gasket on page 146.

Long Shutdown Procedure (Prepare for Storage or Shipment)

Before the 405 LS is shipped or stored, the entire system should be rinsed and
soaked with disinfectant and then purged of all fluid. Perform these steps when
leaving the instrument unused for a long period of time.

Predefined protocols are installed onboard the instrument and on the host
computer during installation of the LHC:

LHC Keypad

W-DECONTAMINATE DECON_STEP1, STEP2, STEP3

W-LONG_SHUTDOWN PURGE_SYSTEM_WITH_AIR

nTwo supply bottles are required for this procedure: one for disinfectant, and
one for rinse. Except Buffer Switching models require four bottles altogether,
two of each solution.

1. Empty the waste bottle.

2. Prepare an aqueous solution of 0.5% sodium hypochlorite (NaClO, or bleach).

3. Fill one or two supply bottles with at least 300 mL of bleach solution
(disinfectant).

4. Fill another supply bottle or two with at least 500 mL of deionized water (rinse).

When using Buffer Switching:

l Buffer valve C & D: Disinfectant

l Buffer valve A & B: Rinse solution (they will be reversed in the next
round)

Without Buffer Switching, connect the bottle containing disinfectant to the
Fluid In port.

5. Reconnect the power cord and turn on the instrument.

6. Run the decontamination protocols.

Preparing to run DECON or W-DECONTAMINATE:
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With Buffer
Switching

Connect the supply bottles this way:
• Buffer bottles C and D: Disinfectant
• Buffer bottles A and B: Rinse solution
After disinfecting channels C and D, you will reverse this assignment
to disinfect channels A and B.
Keypad: Run DECON_STEP1, DECON_STEP2, and DECON_
STEP3.
LHC: At the prompt/delay, change bottles.

Without Buffer
Switching

Connect the disinfectant bottle to the Fluid In port.
Keypad: Run DECON_STEP1 followed by DECON_STEP2.
LHC: At the prompt/delay, change bottles.

7. Finally, disconnect the supply tubing from the washer to completely purge the
system of all fluid by priming the tubing with air. Keypad: Run PURGE_
SYSTEM_WITH_AIR. LHC: Follow the prompts.

Storing the Instrument

After performing the Long Shutdown (Prepare for Storage or Shipment) protocols:
l Turn off the instrument and disconnect the power cord.

l Store it on a flat surface that is relatively free of vibration, in a dust-free and particle-
free environment.

l Protect the instrument from temperature extremes that can cause condensation within
the unit and from corrosive fumes and vapors.

l Store the instrument under the following environmental conditions:

Temperature: 20° to 50°C (-4° to 122°F)

Relative humidity: 10% to 85% (non-condensing)

n Important: Allow the instrument to reach room temperature before use after
storage.

Replace Components

Some components of the 405 LS must be replaced periodically to maintain specified
performance levels.
l Replace the Vacuum Pump Fuse on the facing page

l Clean the Fluid Inlet Filter on page 130

l Vacuum Filtration Carrier: Replace the Gasket on page 146
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Remove/Change Wash Manifold

To clean or replace the wash manifold:

1. Run the system "dry” to remove any fluid: connect an empty supply bottle and
run a prime protocol until the tubing is empty.

2. Turn off the instrument, disconnect the power cable, and remove the mist
shield.

3. Release the thumbscrews that secure the manifold(s) in place.

nDual manifolds: Hold the two manifolds together as a single unit when
removing and reinstalling.

4. Carefully slide the manifold(s) and end plates off their rails.

nDO NOT AUTOCLAVE the manifold!

Reverse these steps to reinstall the manifold. Be sure to correctly position the
manifold(s) on the rails; they only fit one way: the side with the recessed channel
openings faces the washer. Make sure there are no gaps between the manifold and
the washer.

Change the Instrument Settings

When you change the type of manifold, e.g. from a 96-tube to a 192-tube manifold,
you must tell the instrument which manifold is installed:

LHC Keypad

1. Select
Tools>Instrument
Utilities>Washer

2. Update the
Manifold Selection.

3. Click Send.

1. Press Setup Menu (button in center of keypad).

2. Selectg and then MANIF.

3. Select the currently installed wash manifold by
pressing its Soft-key: Single or Dual 96-tubeor 192-tube
manifold.

Replace the Vacuum Pump Fuse

Spare fuses (PN 46055) are shipped with the instrument in case the pump blows a
fuse.

Tools: Screwdriver

To change the fuse:
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1. Locate the Accessory Fuse port on the rear panel below
the Accessory Outlet for the vacuum pump.

2. Use a screwdriver to open the port and release the fuse.
It has a spring action.

3. Replace the fuse and reinstall.

Vacuum Filtration Carrier: Replace the Gasket

If you observe damage to the vacuum filtration carrier’s gasket, you must order a
replacement part from BioTek, and follow these instructions to replace it.

Tools: Philips head screwdriver

1. Remove the carrier from the instrument and put on a level work surface.

2. With a Philips screwdriver, remove the six screws around the perimeter of the
top of the carrier.

3. Lift off and set aside the top plate, and remove the gasket.
o If the grate (located under the gasket) needs to be cleaned, rinse it under tap
water. Allow the grate to dry before placing it and the gasket in the carrier.

4. Place the new gasket in the carrier, correctly positioning the notch with the
corresponding indentation on the carrier’s right side.

nNote: The gasket fits only one way on the carrier. When replacing it, align the
notch in the gasket with the small “bump” on the carrier.

5. Restore the top plate and its six screws. Do not overtighten.

6. Verify vacuum filtration performance by performing the Qualification
procedure: Vacuum Filtration Evacuation Efficiency Test on page 165.
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Qualification

This chapter provides instructions for periodically testing the
instrument to verify that it meets performance specifications.

Qualification Overview 148
Qualification Schedule 149
System Self-Test, Verify Information 149
Sensor Test: Fluid, Waste, Plate Detection 150
Ultrasonic Cleaner Test 151
Liquid Testing the 405™ Microplate Washer LS 152
Washer Liquid Tests 154
Vacuum Filtration Evacuation Efficiency Test 165
Qualify the Verify™ Technology Sensor 167
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Qualification Overview

Instrument verification for the 405 LS involves three activities:  qualification of
installation and setup, qualification of routine capability, and qualification of long-
term stability.  These activities are called Installation Qualification (IQ),
Operational Qualification (OQ), and Performance Qualification (PQ), respectively.

Review the Qualification Schedule on the facing page.

Verification testing includes:
l The System Self Test verifies system components, such as the vacuum, manifold, and
carrier positioning.

Washer
l Evacuation Efficiency: This test measures the residual volume per well after
aspiration. The lower the residuals per well, the better the evacuation efficiency of the
washer. 

l Dispense Precision: This test measures the variability of volumes dispensed from tube
to tube across the manifold. 

l Buffer Switching: This test measures the variability of volumes dispensed from tube to
tube across the manifold when using buffer switching.

l Vacuum Filtration Evacuation Efficiency:When applicable, this test measures the
total residual volume of the plate after evacuation to verify it is performing to
specifications.

ll Verify Sensor Test. Compares the ultrasonic level sensor's measurement precision
against a microplate absorbance reader's determination to ensure accurate, repeatable
volume-level detection.

Washer Qualification Tests:
l Dispense Precision (96) on page 157

l Dispense Precision Test (192) on page 161

l Evacuation Efficiency Test (96) on page 158

l Evacuation Efficiency Test (192) on page 162

l Buffer Switching Dispense Test on page 160

l Vacuum Filtration Evacuation Efficiency Test on page 165
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Qualification Schedule

The following schedule defines the factory-recommended intervals for verification
tests for an instrument used two to five days a week. The schedule assumes that
the 405 LS is properly maintained as outlined in the Recommended Maintenance
Schedule on page 119.

nNote: An instrument qualification package (PN 1170543) is available for
purchase. The package contains thorough procedures for performing
Installation Qualification, Operational Qualification and Performance
Qualification (IQ-OQ-PQ) and preventative maintenance (PM). Extensive
Checklists and Logbooks are included for recording results. Contact your local
dealer for more information.

Tests
IQ OQ PQ

Initially Annually Monthly

Unpacking, Installation, and Setup ü

Enable/Test System Sensors ü ü

System Self Test and Checksum
Test

ü ü ü

Shake Test ü

Ultrasonic Cleaner Test ü

Washer Evacuation Efficiency Test ü ü

Washer Dispense Precision Test ü ü

Vacuum Filtration Evacuation Test ü ü

Buffer Switching Dispense Test ü

Verify™ Sensor Test ü

Run Assay ü

nImportant! The risk factors associated with your assays may require that the
Operational and Performance Qualification procedures be performed more or
less frequently than shown above.

System Self-Test, Verify Information

Perform these steps to verify software information and run a system self-check:
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Prerequisite: When controlling the instrument with the LHC, ensure that it is
attached to the host computer and turned on, and then launch the LHC software.

To run the System Self-Test:

LHC Keypad

Select Tools>Instrument
Utilities>General Settings.
Under Instrument Functions, click
Perform Self-check.

1. Select UTILS at the main menu.

2. Select TESTS.

3. Select SLFCHK.

Test Results:

l If the test passes, a “passing” message appears.

l If the test fails, an error code displays. If this happens, find the error code in
the 405 LS Operator’s Manual to determine its cause. If the problem is
something you can fix, turn off the instrument, fix the problem, and then turn
the instrument back on and re-run the test. If the problem is not something
you can fix, contact BioTek’s Technical Assistance Center.

Record Basecode

Record the software part number and version installed on the 405 LS.

LHC Keypad

1. Select Tools>Instrument
Utilities

2. Select the Software tab and from
the Instrument Software
Information section record the

l Software Version and part
number

1. Select UTILS

2. Select TESTS

3. Select SFTWR

4. Select WASHER and record the
Software part number and version.

ü Use the OQ Checklist to confirm that the software information is correct and the
system self-test passed.

Sensor Test: Fluid, Waste, Plate Detection

These tests simulate an error condition for the fluid and waste alert sensors and
plate detection, when applicable.
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1. Test the Fluid Supply Sensor

1. Remove the lid on the fluid supply bottle (Buffer valve A, when applicable)
and lift the internal tube up and out of the fluid.

2. Run W-DAY_RINSE (DAY_RINSE onboard) to bleed the fluid lines.

3. Put a plate on the carrier and run a dispense protocol, e.g. QC_96_DISP_
TEST.

4. Look for air moving through the tubing to the washer and wait for the alarm.

The instrument should display a fluid error, like 1500 or 1501.

2. Test the Waste Level Sensor

1. Turn the waste bottle upside down.

2. Run an aspirate protocol, e.g. QC_96_EVAC_TEST.

The instrument should beep and display the expected error code, 1401.

3. Test the Plate Detection Sensor (Verify™ Technology ("Q") models only)

1. With plate carrier empty, Run any predefined wash protocol.

The instrument should beep and display the expected error code, 1737: no plate
detected.

Ultrasonic Cleaner Test

Perform this test to verify that the cleaner is operating properly.

1. Fill a supply bottle with one liter of deionized water. Buffer Switching
models need two bottles connected to valves A and B.

2. Select Quick>Sonic from the main menu. Set the Duration to 002 (2 minutes).

3. Run the program.

4. While the AutoClean program is running, the ultrasonic cleaner should
pulse on and off approximately every ten seconds (a 50% duty cycle). While
the program is running, listen for the periodic “hissing” sound that indicates
the ultrasonic energy is present. Detecting the sound is all that is required to
verify that the ultrasonic cleaner is operating properly. After two minutes,
the washer will aspirate the fluid and the program will be complete. (Non-
Buffer Switching models can press STOP when prompted for a rinse bottle
and quit the program.)

If the ultrasonic cleaner does not operate as described above, contact BioTek for
assistance.
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Liquid Testing the 405™ Microplate Washer LS

Which Tests to Perform?

We recommend that you perform these routine tests before first use (after the
IQ) and then monthly:

Washer
l Dispense Precision Test. Precision tests measure the variability of volumes dispensed
from tube to tube across the manifold.

l Evacuation Efficiency Test. Measures the residual volume per well after the
aspiration aspect of plate washing. The lower the residuals per well, the better the
evacuation efficiency of the washer.

Specially equipped washers: with Buffer Switching and/or Verify™ Technology,
perform test annually (starting one year after installation):
l Annual Buffer Switching Test. Measures the variability of volumes dispensed from
tube to tube across the manifold, for each valve, when the washer is equipped with
buffer switching.

l Verify Sensor Test. Compares the ultrasonic level sensor's measurement precision
against a microplate absorbance reader's determination to ensure accurate, repeatable
volume-level detection.

Perform the tests applicable to the installed manifold type and feature set:

If you have: Run Liquid Test(s):

96-Tube Manifold Dispense Precision Test (96)

Evacuation Efficiency Test (96)

192-Tube Manifold Dispense Precision Test (192)

Evacuation Efficiency Test (192)

Buffer Switching Buffer Switching Dispense Test

Vacuum Filtration Module Vacuum Filtration Evacuation Efficiency (for either
96- or 384-well plates)

Verify™ Technology Verify Sensor Test
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Important Recommendations for All Liquid Tests

Test Solutions

l Using pure deionized water in place of the test solutions is not
recommended and will likely result in the failure to meet specifications.

l Prepare the solutions the day before you plan to run the tests. This will
allow any foam caused by the agitation of solutions containing Tween® 20 to
settle.

l BioTek determined the pass/fail specifications for the instrument tests using
the recommended test solutions. You may use your own buffer solution
instead, but if any tests fail using your own buffer, retry the tests using the
recommended solutions.

Plate Reading

l If you are using one of BioTek’s keypad-based readers, such as the ELx800 or
ELx808, ensure that the reader is not running in Rapid mode. To check the
setting, select UTIL à READ and cycle through the options until READ IN

RAPID MODE? appears. Set it to NO.

l The absorbance of blue dye solutions should be measured at 630/450 (or
405) nm. The BioTek blue dye solution part number is 7773001.

l The final absorbance for all dye solution concentrations should be in a range
between 0.700 and 1.600 OD.

Recording Test Results

l Use the Liquid Test Worksheets at the end of this section for recording data
reduction results. If your tests are failing, this information will be useful for
BioTek TAC to help diagnose any problems.
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Washer Liquid Tests

Dispense Precision Test

Dispense precision is a measure of the variability of volumes dispensed from tube
to tube across the manifold. The optical density of the solution in a well is
proportional to the total volume of the solution in the well. If the % Coefficient of
Variation (%CV) is calculated, the result is a measure of the uniformity of the
distribution of dispensed volumes across the manifold. It is the ratio, expressed in
percent, of the standard deviation of the distribution of fluid volumes in the wells
to the mean value of volume per well. The uniformity of distribution across the
manifold improves as the %CV is lowered.

Annual Buffer Switching Test: The dispense test is also conducted for the buffer
switching module to ensure that each valve (A, B, C, D) is calibrated to deliver the
same volume of fluid.

Evacuation Efficiency Test

The Evacuation Efficiency test measures the residual volume (mean residual
weight) per well after aspiration is performed. The lower the residual per well, the
better the evacuation efficiency of the washer. A known solution is dispensed into
all wells of a previously weighed microplate. Aspiration is performed and the plate
is re-weighed. The total residual fluid is calculated based on the weight difference,
and this value is divided by 96or 384 as appropriate, to obtain the mean residual
weight.

In addition, a diagnostic tool is provided for use, if necessary, to identify problem
wells: a known dye concentration is dispensed to and evacuated from the wells,
and the plate is weighed. Buffer is then dispensed to all wells to bring the volume
of fluid to a more optically measurable volume. The optical density (OD) of each
well is measured and the background is subtracted to account for scratches on the
plate or particulates in a well. Each well’s residual volume is calculated using its
OD and a calibration factor derived from the mean residual weight and the mean
OD of all wells on the plate. It is assumed that 1 mg = 1 µL of fluid for this
calculation.

Predefined Test Protocols

Several 405 LS protocols are shipped onboard the instrument and with the LHC
and installed on your computer during LHC installation.
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Keypad Users: The protocol names onboard the washer do not include the W- prefix
and some protocols include the model name, e.g. 405HT or 405Select, when appropriate.

They include the protocols required to perform the Liquid Tests:

Predefined Protocols

W-DAY_RINSE

QC_ 96_EVAC_TEST

QC_ 192_EVAC_TEST

QC_ 96_DISP_TEST

QC_192_DISP_TEST

QC_96_VAC30_TEST

QC_384_VAC10_TEST

Prime_All_Buffers

The files are stored in the LHC's default file location. Unless you have changed the
file location:

1.  Click the Open button and locate the 405 LS folder. Choose the 1Buffer or
4Buffer folder to match your instrument's Buffer Switching capability.

2. Open the Prime and Maintenance or QC Protocols folder.

3. Select the required protocol.

BioTek recommends customizing these predefined protocols, as described in the topic,
Customize the Predefined Protocols on page 41.

Washer Qualification Test Materials

l One new microplate per test to be performed:

Microplate Type Liquid Tests

Flat-bottom 96-well plates, Corning®

Costar #3590 or equivalent
Evacuation Efficiency Test (96)

Dispense Precision Test (96)

Annual Buffer Switching Test
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Microplate Type Liquid Tests

Flat-bottom 384-well plates, Corning
Costar or equivalent

Evacuation Efficiency Test (192)

Dispense Precision Test (192)

Annual Buffer Switching Test

l 96-well 0.45 µm filter plate,
Millipore MSHVN4550 96 or
equivalent

l 384-well 1.2µm filter plate,
Millipore MZFCN0W10 or
equivalent

Vacuum Filtration Evacuation Efficiency
Test (Use the plate size most
commonly used in your lab)

l Precision balance with minimum capacity of 100 g and readability of 0.001 g
resolution

l Pipettes and graduated beakers

l Microplate absorbance reader capable of dual wavelength reading at 630/450
nm

l Liquid Test Worksheets at the end of this chapter for recordingdata and
results

l Deionized water
l Test solutions:

For this manifold: Sol. 1 Sol. 2 Sol. 3 Sol. 4

96-Tube 1000 mL 100 mL 1200 mL n/a

192-Tube 2000 mL 100 mL n/a 1440 mL

nThese volumes are sufficient for performing the dispense tests and standard
and diagnostic Evacuation Efficiency tests. In most cases, enough fluid will be
left over to re-run a test, if necessary.

n If you will be performing the annual OQ for the external Buffer Switching
module, you will need several additional liters of deionized or distilled water.

nVerify™ Technology ("Q" models): if you will be qualifying level sensor
performance as part of the annual OQ, mix up another 200 mL of Solution #3
to run that test: Qualify the Verify™ Technology Sensor on page 167.
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Test Solutions

Solution #1:  Buffer Solution

Pipette 1 mL Tween 20 into 1 liter (1000
mL) of deionized or distilled water and
mix well.

or Pipette 10 mL of BioTek Wetting Agent* into
1 liter of deionized or distilled water and
mix well.

* BioTek Solution #1 100X Concentrate Wetting Agent 125 mL (PN 7773002)
contains 10% Tween 20 in deionized water and 0.01% Sodium Azide as a
preservative.

SOLUTION #2:  Residual Test Solution

Mix 100 mL of Solution #1 with 0.050
grams of FD&C #1 blue dye.

or Mix 90 mL ofSolution #1with 10 mL
of BioTek Blue Test Dye*.

* BioTek Solution #2 10X Concentrate Blue Test Dye 125 mL (PN 7773001)
contains 5 grams per liter FD&C Blue #1, 0.1% Tween 20 in deionized water and
0.01% Sodium Azide as a preservative.

SOLUTION #3:  Dispense Precision Solution for 96-Tube manifolds

Mix 1180 mL of deionized or distilled water with 20 mL of Solution #2.

SOLUTION #4:  Dispense Precision Solution for 192-Tube manifolds

Mix 1420 mL of Solution #1 with 20 mL of Solution #2.

Dispense Precision Test (96)

nThis test is designed for 96-Tube manifolds. Find the Dispense Precision Test
(192) on page 161.

nFind a list of the supplies you will need at Materials on page 155.

nSave the plate!When this test is complete, use the filled plate to perform the
Evacuation Efficiency Test.

n Keypad Users: The protocol names onboard the washer do not include the
W- prefix and some protocols include the model name, e.g. 405HT or
405Select, when appropriate.

1. Fill a supply bottle with 2 liters of deionized or distilled water; Buffer Switching
units use buffer valve A. Run the W-DAY_RINSE protocol two or three times to
prime the fluid lines and manifold.
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2. Fill a supply bottle with 1200 mL of Solution #3; Buffer Switching units use
buffer valve A.

3. Run W-DAY_RINSE again to prime the washer with the solution.

4. Place a new 96-well microplate on the balance and zero the balance.

5. Place the plate on the carrier and run the QC-96_DISP_TEST.  This protocol
dispenses 300 µL of solution to each well of the plate.  It does not evacuate the
solution.

6. When the protocol is completed, carefully remove the plate. Place the plate on
the balance and record the Total Dispense Weight.

7. Read the plate in an optical reader (blank on air), using the dual-wavelength
method (630 nm - 450 nm), then print or export the results.

8. Use the Dispense Precision Test Worksheet to perform data reduction:

Tip: If you have a spreadsheet software program, enter/export all 96 values into a
spreadsheet and apply your program’s Standard Deviation function (e.g., Microsoft®
Excel’s STDEV).

a. Calculate the Standard Deviation.

b. Calculate the sum of the OD values for all 96 wells, then divide by 96 to
determine the Mean OD for the plate.

c. Calculate the %CV: (Standard Deviation / Mean OD) * 100.

The %CV should be <= 3.0.

If the %CV is greater than 3.0, one or more dispense tubes may need to be cleaned.
Run AutoClean, if available, and/or remove the manifold and use the stylus to
clean the dispense tube(s) giving lower-than-average absorbance readings. When
finished, re-prime the washer and retry the test.

9. When finished, prime with deionized water to flush out the dye solution.

Evacuation Efficiency Test (96)

nThis test is designed for 96-Tube manifolds. Find the Evacuation Efficiency
Test (192) on page 162

n If you tared the balance at the start of the Dispense Precision Test, use the
plate from that test here; skip steps 1-3.

Keypad Users: The protocol names onboard the washer do not include the W- prefix and
some protocols include the model name, e.g. 405HT or 405Select, when appropriate.
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1. Fill a supply bottle with 2 liters of deionized or distilled water. Run the
Maintenance program W-DAY_RINSE two or three times to prime the tubing
and manifold.

2. Place a new 96-well microplate on the balance and zero the balance.

3. Pipette or dispense 150 µL of Solution #1 into each well of the microplate.

4. Place the plate on the carrier and run the QC-96_EVAC_TEST protocol.  This
protocol evacuates the wells, leaving a small amount of residual fluid.

5. When the program is completed, remove the plate and weigh it immediately
because evaporation will affect the results. This is the Total Residual Weight in
grams.

6. Visually inspect the plate and note if any wells appear to have considerably
more liquid than others.

7. Use the Evacuation Efficiency Test Worksheet to perform data reduction:
l Divide the Total Residual Weight by 96 to find the Mean Residual Weight.

l The Mean Residual Weight should be <= 0.002 g.

If the Mean Residual Weight is greater than 0.002 g, or if one or more wells
appear to have much more liquid than the others, the washer failed the test.

Troubleshoot as follows:

If the test fails once: 
o If the problem appears to be related to particular wells, clean those aspiration
tubes: run AutoClean and/or remove the manifold and thoroughly clean the tubes
with the stylus (See Remove and clean the washer manifold on page 131).
When finished, retry the test.

o Failure of this test is commonly caused by improper aspiration tube placement
within the wells, usually because a microplate other than the recommended
Corning Costar® 96 was used. If you must use a plate other than the Corning
Costar 96, modify the Aspirate Height, i.e., Z position, or horizontal X or Y position
parameters in a copy of the QC-96_EVAC_TEST protocol to correct this error. 
After making this change, retry the test using a new microplate.

If the test fails a second time: Perform the Evacuation Diagnostic Test.

Evacuation Diagnostic Test

nConduct this test if the standard Evacuation Efficiency Test fails twice. This
test will confirm which aspirate tube(s) may be clogged, or if the plate’s
alignment or position is the problem.
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1. If you have not already done so, repeat steps 2 through 7 of the standard
Evacuation Efficiency test, using Solution #2 for the dispense fluid. Be sure to
recalculate the Mean Residual Weight.

2. Pipette up to 300 µL of Solution #1 into each well, on top of the residual
solution.

3. Shake the plate to achieve uniform distribution of the remaining dye in each
well.

4. Read the plate in an optical reader (blank on air), using the dual-wavelength
method (630 nm - 450 nm), then print or export the results.

5. Use the Evacuation Efficiency Test Worksheet to perform data reduction:

l Calculate the sum of the OD values for all wells, then divide by 96 to
determine the Mean OD for the plate.

l Divide the Mean OD by the Mean Residual Weight (from step 1), to find the
Residual Factor.

l For each well, divide its OD value by the Residual Factor to find its Residual
Weight.

Each well’s Residual Weight should be <= 0.002 g.

If one or more wells have a Residual Weight greater than 0.002 g, review the data to
determine which well, or wells, is causing the problem.

o If the problem appears to be related to particular wells, clean the associated
aspiration tubes: run AutoClean and/or remove the manifold and thoroughly
clean the tubes with the stylus. (See Remove and clean the washer manifold
on page 131.) When finished, retry the test.

o If the problem appears to be related to a particular region, edge, or corner of the
plate, review the alignment and flatness of the plate on the carrier. 

Please do not adjust the carrier adjustment screws! Contact BioTek if you suspect an
alignment problem, contact BioTek TAC.  

o For additional suggestions, See Troubleshooting on page 180 .
o If the test continues to fail, contact BioTek Instruments.

Buffer Switching Dispense Test

This procedure tests all the buffer valves.

nThe Dispense Precision test must pass before the test for Valves A-D can be
performed.
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1. Empty the waste bottle now, and then as needed throughout this procedure.

2. Fill each of the supply bottles connected to Buffer valves A, B, C, and D with
three liters (3000 mL) of deionized water. Place the bottles on a surface level
with the 405 LS, i.e., the adjacent (lab bench) area.

3. Run the Maintenance protocol PRIME_ALL_BFRS two or three times to prime
the fluid lines, manifold, and the valves.

Repeat the following steps for each valve:

1. Edit the applicable dispense protocol, for example, QC_96_DISP_TEST, to use
the buffer valve currently being tested.

2. Place a new 96- or 384-well microplate on the balance and zero the balance.

3. Place the microplate on the carrier and run the dispense protocol.

4. When the program is finished, carefully remove the plate and weigh it. This is
the Total Dispense Weight in grams.

The Total Dispense Weight should be:
l 28.8 grams ± 10% (between 25.92 g and 31.68 g) for the 96-Tube test.
l 30.72 grams ± 10% (between 27.65 g and 33.79 g) for 192-Tube test.
l If the weight falls above this range, the valve may be defective. Contact BioTek.
l If the weight falls below this range, the valve may be contaminated with fungi or
proteins and must be cleaned using an appropriate enzyme, alcohol, or a diluted
bleach solution, depending on the contaminant. See Removing Protein Residuals
and Fungi Growth on page 124 in the Maintenance section for suggestions. After
cleaning the valve and tubing, retry the test. If the test continues to fail, contact
BioTek.

5. Record the results in the applicable worksheet.

Dispense Precision Test (192)

nThis test is designed for the 192-Tube manifold. Find the Dispense Precision
(96) on page 157.

nFind a list of the supplies you will need at Materials on page 155.

nSave the plate!When this test is complete, use the filled plate to perform the
Evacuation Efficiency Test.

1. Fill a supply bottle with 2 liters of deionized or distilled water; Buffer Switching
units use buffer valve A. Run W-DAY_RINSE two or three times to flush the
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fluid lines and manifold.

2. Fill a supply bottle with 1440 mL of Solution #4; Buffer Switching units use
buffer valve A.

3. Run W-DAY_RINSE again to prime the washer with the solution.

4. Place a new 384-well microplate on the balance and zero the balance.

5. Place the plate on the carrier and run the QC-192_DISP_TEST protocol. This
protocol dispenses 80 µL of solution to each well of the plate. It does not
evacuate the solution.

6. When the program is finished, carefully remove the plate. Place the place on the
balance and record the Total Dispense Weight.

7. Read the plate in an optical reader (blank on air), using the dual-wavelength
method (630 nm - 450 nm), then print or export the results.

8. Use the Dispense Precision Test Worksheet, perform data reduction:

Tip: If you have a spreadsheet software program, enter/export all 384 values into a
spreadsheet and apply your program’s Standard Deviation function (e.g., Microsoft
Excel’s STDEV).

a. Calculate the Standard Deviation.

b. Calculate the sum of the OD values for all 384 wells, then divide by
384 to determine the Mean OD for the plate.

c. Calculate the %CV: (Standard Deviation / Mean OD) * 100.

The %CV should be <= 4.0.

If the %CV is greater than 4.0, one or more dispense tubes may need to be
cleaned. Run AutoClean and/or remove the manifold and use the stylus to
clean the dispense tube(s) giving lower-than-average absorbance readings.
When finished, re-prime and retry the test.

9. When finished, prime with deionized water to flush out the dye solution.

Evacuation Efficiency Test (192)

nThis test is designed for the 192-Tube manifold. Find the Evacuation
Efficiency Test (96) on page 158.

n If you tared the balance at the start of the Dispense Precision Test, use the
plate from that test here; skip steps 1-3.
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1. Fill a supply bottle with 2 liters of deionized or distilled water. Run the W-
DAY_RINSE protocol two or three times to prime the fluid lines and manifold.

2. Place a new 384-well microplate on the balance and zero the balance.

3. Pipette or dispense 80 μL of Solution #1 into each well of the microplate.

4. Place the plate on the carrier and run the QC-192_EVAC_TEST.  This protocol
evacuates all of the wells, leaving a small amount of residual fluid.

5. When the program is completed, remove the plate and weigh it immediately
because evaporation will affect the results.  This is the Total Residual Weight in
grams.

6. Visually inspect the plate and note if any wells appear to have considerably
more liquid in them than others.

7. Use the Evacuation Efficiency Test Worksheet to perform initial data
reduction:

1. Divide the Total Residual Weight by 384 to find the Mean Residual
Weight.

2. The Mean Residual Weight should be <= 0.002 g.

If the Mean Residual Weight is greater than 0.002 g, or if one or more wells
appear to have much more liquid than the others, the washer failed the test.

Troubleshoot as follows:

If the test fails once: 
o If the problem appears to be related to particular wells, clean those aspiration
tubes: run AutoClean and/or remove the manifold and thoroughly clean the tubes
with the stylus (See Remove and clean the washer manifold on page 131).
When finished, retry the test.

o Failure of this test is commonly caused by improper aspiration tube placement
within the wells, usually because a microplate other than the recommended
Corning Costar® 384 was used. If you must use a plate other than the Corning
Costar 384, modify the Aspirate Height, i.e., Z position, or horizontal X or Y
position parameters in a copy of the QC-192_EVAC_TEST protocol to correct this
error.  After making this change, retry the test using a new microplate.

If the test fails a second time: Perform the Evacuation Diagnostic Test (192).

Evacuation Diagnostic Test (192)

nConduct this test if the standard Evacuation Efficiency Test fails twice. This
test will confirm which aspirate tube(s) may be clogged, or if the plate’s
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alignment or position is the problem.

1. If you have not already done so, repeat steps 2 through 7 of the standard
Evacuation Efficiency test, using Solution #2 for the dispense fluid. Be sure to
recalculate the Mean Residual Weight.

2. Pipette up to 80 µL of Solution #1 into each well, on top of the residual
solution.

3. Shake the plate to achieve uniform distribution of the remaining dye in each
well.

4. Read the plate in an optical reader (blank on air), using the dual-wavelength
method (630 nm - 450 nm), then print or export the results.

5. Using the Evacuation Efficiency Test Worksheet, perform data reduction:

l Calculate the sum of the OD values for all wells, then divide by 384 to
determine the Mean OD for the plate.

l Divide the Mean OD by the Mean Residual Weight (from step 1), to find the
Residual Factor.

l For each well, divide its OD value by the Residual Factor to find its Residual
Weight.

Each well’s Residual Weight should be <= 0.002 g.

If one or more wells have a Residual Weight greater than 0.002 g, review the data to
determine which well, or wells, is causing the problem.

o If the problem appears to be related to particular wells, clean the associated
aspiration tubes: run AutoClean and/or remove the manifold and thoroughly
clean the tubes with the stylus. (See Remove and clean the washer manifold
on page 131.) When finished, retry the test.

o If the problem appears to be related to a particular region, edge, or corner of the
plate, review the alignment and flatness of the plate on the carrier. 

Please do not adjust the carrier adjustment screws! Contact BioTek if you suspect an
alignment problem, contact BioTek TAC.  

o For additional suggestions, See Troubleshooting on page 180 .
o If the test continues to fail, contact BioTek Instruments.
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Vacuum Filtration Evacuation Efficiency Test

This test is designed for the 405 LS with the Vacuum Filtration accessory. Install the vacuum
filtration plate carrier to perform the test. Make sure the instrument setting for Plate Carrier is
set correctly. Use the plate size most commonly used in your lab.

nPerform this test during the initial and annual OQ and themonthly PQ.

1. Fill a supply bottle with 2 L (two liters) of deionized water. Run W-DAY_
RINSE to prime the fluid lines and manifold.

2. Place a new microplate on the balance and zero the balance:
o 96-well 0.45 µm filter plate: Millipore MSHVN4550 96 is recommended.

o 384-well 1.2µm filter plate: Millipore MZFCN0W10 is recommended.

3. Run the predefined protocol to first dispense deionized or distilled water into
each well of the microplate and then evacuates the wells:

Plate Predefined Protocol Volume Vacuum Time

96-well QC-96_VAC30_TEST 300 µL/well 30 seconds

384-well QC-384_VAC10_TEST 80 μL/well 10 seconds

4. When the protocol is finished, remove the plate, and blot the bottom of the
plate on a paper towel to remove any droplets.

5. Weigh the plate immediately. This is the Total Residual Weight, in grams.

6. Visually inspect the plate and note if any wells appear to have considerably
more liquid in them than others.

7. Use the “Vacuum Filtration Evacuation Efficiency Test” worksheet at the end
of this chapter to record the results:

Residual Weight should be:
o <= 1.2 grams for a 96-well plate;
o <= 4.0 grams for a 384-well plate.

nWhile BioTek recommends using the Millipore filter-bottom plate listed above
in this test, you may substitute other manufacturers’ filter-bottom plates that
you are familiar with. However, using a substitute platemay vary your test
results.

If the Residual Weight is greater than specified, the washer failed the test. Make
sure a tight seal was maintained between the filter plate and plate carrier:
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l A new, defect-free filter plate was used.

l The vacuum filtration plate carrier’s gasket is clean and has not been
damaged by previous use or mishandling.

Correct these conditions and rerun the test or contact BioTek TAC for assistance.
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Qualify the Verify™ Technology Sensor

If applicable to your 405 LS ("Q" models), BioTek recommends performing this
procedure annually to ensure the Verify Technology level sensor is meeting
performance specifications.

Required Materials:

l Precision digital balance with a capacity of 400 g and readability of 0.01 g resolution

l Absorbance microplate reader

l 200 mL Solution #3: Dispense Precision solution. This volume is sufficient for two test
runs. See Washer Qualification Test Materials on page 155.

l BioTek's 405 LS IQ-OQ-PQ procedure or operator's manual CD and a spreadsheet
program compatible with Microsoft® Excel®.

Prerequisites:

Important: Mix the dye solution, fill a buffer bottle attached to the washer and fully
prime the system.

If you purchased the 405 LS IQ-OQ-PQ procedure:
l If you have Gen5™, create a new experiment with the Gen5 Verify Technology protocol
(VerifyCal.prt) shipped with the IQOQPQ procedure.

Otherwise, open the Excel spreadsheet provided on the 405 LS Operator's Manual
CD in preparation for recording and calculating test results.

Run Verify Test Plate Alignment:

To make sure the 405 LS is correctly calibrated for the Verify Test Plate:

LHC

1. Select Tools>Instrument Utilities>Verify Manifold>Configure Utilities.

2. Put the test plate on the carrier and click Test Plate Alignment.

This process updates configuration data needed to successfully run the Verify
routine.

Perform qualification procedure:

1. Put the Verify Test Plate on the balance and tare the balance.

2. Put the test plate on the carrier, begin the test:

LHC

1. Select Tools>Instrument Utilities>Verify Manifold>Configure Utilities.
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LHC

2. Click the link to Perform the Sensor Calibration.

3. At the first pausing message, weigh the plate and record the Aspirate Weight
(WA) value.

nWhen using Gen5, the spreadsheet does not open until the second read is
done. Jot down the weight for later entry in the spreadsheet.

4. Use the absorbance reader to read the plate at 630 nm and 450 nm.

l If you do not have Gen5, copy and paste the Delta transformation reading
results (630 nm - 450 nm) into the spreadsheet provided: in the Supporting
Data section of the worksheet, paste data into the Da (aspirate distance)
grid.

l If you have Gen5, the reading results will be reported later in the Power
Export.

5. Put the Verify Test Plate back on the 405 LS's carrier and select OK in the
pausing message to continue.

6. At the second pause, weigh the plate again and record the Dispense Weight
(WD) value.

7. Use the absorbance reader to read the plate at 630 nm and 450 nm. Gen5 users:
select OK.

l If you do not have Gen5, copy and paste the Delta transformation reading
results (630 nm - 450 nm) into the spreadsheet provided: in the Supporting
Data section, paste data into the Dd (dispense distance) grid.

l If you have Gen5, the Power Export containing the reading results opens. Fill
in the other data fields for weight and calibration data (as described below).

8. Put the test plate back on the 405 LS's carrier and select OK in the second
pausing message.

Format and evaluate test results:

9. Open the Calibration Data .txt file named in the final message (with the date and
time of execution) in the Calibration Data folder in the LHC folder structure.1

10. Copy and paste all the data from the .txt file into the spreadsheet provided:

1LHC users: The default location for this report is the Windows Common AppData folder (e.g.
C:\ProgramData) \BioTek\Liquid Handling Control version#\ManifoldTests\SN_##\Calibration Data. Touch
screen: transfer the memory stick to your PC.
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o Select Ctrl+A and Ctrl+C

o Select the From405 tab and paste (Ctrl+V) all the data into the grid beginning at
worksheet cell A1.

If the Sigma Error is greater than 9 µL, the sensor failed the test.

Troubleshoot as follows:

l Review the test procedure: Was the Verify Test Plate seated correctly during testing on
the washer and the reader, with well A1 in the correct orientation? Was there a long
delay between steps, allowing fluid to evaporate?

l Inspect the plate for damage. Replace the plate (according to the prescribed procedure)
if the plate is cracked, warped, scratched, or otherwise damaged.

l Inspect the washer components:
o Is the Verify sensor's collimator clean and properly installed? (Clean the Verify™
Level Sensor on page 133).

o Have the plate carrier feet been adjusted? Contact BioTek TAC for recalibration
service.

Take corrective action if possible and rerun the test. If it fails again, contact BioTek
TAC for guidance.
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405™ Microplate Washer LS



Dispense Precision Test Worksheet

96-Tube Manifold

Serial Number:

Calculations

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ number of wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 3.0? q Pass    q Fail

Date:

Test Performed By:

405 LS Qualification Procedures
© 2012, BioTek® Instruments, Inc.



Evacuation Efficiency Test Worksheet

96-Tube Manifold

Serial Number:

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass    q Fail

Mean Residual Weight (Total Residual Weight ÷ 96): g

Mean Residual Weight <= 0.002 g? q Pass    q Fail

Evacuation Diagnostics Test (check here q if not performed)

Mean OD for the plate (Sum of all wells ÷ 96):

Residual Factor (Mean OD ÷ Mean Residual Weight):

Calculate the Residual Weight for each well: well OD ÷ Residual Factor

Every Residual Weight per well <= 0.002 g? q Yes  q No

Date:

Test Performed By:

405 LS Qualification Procedures
© 2012, BioTek® Instruments, Inc.



Dispense Precision Test Worksheet

96-Tube Manifold

Annual Buffer Switching Test

Serial Number:

Calculations for Valve A

Standard Deviation:

Mean OD (Sum of all wells ÷ Number of wells):

% CV (Standard Deviation ÷ Mean OD x 100):

% CV <= 3.0? q Pass    q Fail

Calculations for Valves A-D 
(Annual OQ only, check here q if not performed)

Total Dispense Weight 28.8 g ±10%?
(25.92 g - 31.68 g)

Valve A grams q Pass    q Fail

Valve B grams q Pass    q Fail

Valve C grams q Pass    q Fail

Valve D grams q Pass    q Fail

Date:

Test Performed By:

405 LS Qualification Procedures
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Dispense Precision Test Worksheet

192-Tube Manifold

Serial Number:

Calculations

Standard Deviation:
(calculate using spreadsheet program)

Mean OD:
(sum of all wells ÷ number of wells)

% Coefficient of Variation:
((Standard Deviation ÷ Mean OD) x 100)

% CV <= 4.0? q Pass    q Fail

Date:

Test Performed By:

405 LS Qualification Procedures
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Evacuation Efficiency Test Worksheet

192-Tube Manifold

Serial Number:

Standard Test

Total Residual Weight: g

Verification that wells are consistent in appearance: q Pass    q Fail

Mean Residual Weight (Total Residual Weight ÷ 384): g

Mean Residual Weight <= 0.002 g? q Pass    q Fail

Evacuation Diagnostics Test (check here q if not performed)

Mean OD for the plate (sum of all wells ÷ 384):

Residual Factor (Mean OD ÷ Mean Residual Weight):

Calculate the Residual Weight for each well: well OD ÷ Residual Factor

Every Residual Weight per well <= 0.002 g? q Yes    q No

Date:

Test Performed By:

405 LS Qualification Procedures
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Dispense Precision Test Worksheet

192-Tube Manifold

Annual Buffer Switching Test

Serial Number:

Calculations for Valve A

Standard Deviation:

Mean OD (Sum of all wells ÷ Number of wells):

% CV (Standard Deviation ÷ Mean OD x 100):

% CV <= 4.0? q Pass    q Fail

Calculations for Valves A-D 
(Annual OQ only, check here q if not performed)

Total Dispense Weight 30.72 g ± 10%?
(27.65 g – 33.79 g)

Valve A grams q Pass    q Fail

Valve B grams q Pass    q Fail

Valve C grams q Pass    q Fail

Valve D grams q Pass    q Fail

Date:

Test Performed By:

405 LS Qualification Procedures
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Vacuum Filtration Evacuation Efficiency Test

96-Well Filter Plates

Serial Number:

Test Results

Verification that wells are consistent in appearance: c Pass
c Fail

Residual Weight: g

Residual Weight: <= 1.2 g c Pass
c Fail

Date:

Performed By:

If required,
Reviewed/Approved By:

405 LS Qualification Procedures
© 2012, BioTek® Instruments, Inc.



Vacuum Filtration Evacuation Efficiency Test

384-Well Filter Plates

Serial Number:

Test Results

Verification that wells are consistent in appearance: c Pass
c Fail

Residual Weight: grams

Residual Weight: <= 4.0 g c Pass
c Fail

Date:

Performed By:

If required,
Reviewed/Approved By:

405 LS Qualification Procedures
© 2012, BioTek® Instruments, Inc.



Chapter 7

Troubleshooting

This chapter provides guidelines for error recovery and
troubleshooting performance problems.

Troubleshooting 180
General Operation Troubleshooting 182
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Troubleshooting

Error recovery:

First Response: Run a System Test (restart the instrument) to give the instrument
an opportunity to restore its initial settings and communication capability.

LHC Users: Reboot your Computer and Instrument: When you cannot run a
system test, e.g. LHC is not responding, or when running a system test doesn't
resolve the issue, turn off your computer and 405 LS, check all the cabling, i.e.
make sure your USB cable is in good condition and is properly connected to the PC
and instrument, and then, power them on. This should refresh the devices and reset
communication parameters.

Error Codes

To find a specific error code:
l Software Error Codes on page 200 (6000-6100) - protocol errors

l System Error Codes on page 192 (0000-A500) - hardware errors

Most error conditions generate an error message that is displayed on the computer
screen or keypad.

6045 Serial write error

LHC Users: A potentially common error, especially when using the Predefined
Protocols, a "serial write" error, is easily fixed by correcting the COM port setting
defined in the protocol.

810D To communicate, instrument must be at main menu/Home screen.

LHC Users: Similarly, the 810D message appears when the instrument is busy, for
example when AutoPrime is running. The LHC can only talk to the instrument
when its main menu is displayed. Press the Stop button, if desired, to end the
current process and reestablish communication with the LHC.

Technical Note: Only one of the two communication ports (COM port) on the
instrument can be used at a time. They cannot be used simultaneously. You

can use USB to connect the 405 LS to the computer or the RS232 serial port to
connect to a BioStack or similar robotic device. But you cannot use both ports
simultaneously, i.e. make sure only one cable is plugged in at a time.

Keypad Control: When the BioStack is connected to your 405 LS, you are
controlling both instruments using the keypad. Before connecting the 405 LS to
your computer to download basecode or for other reasons, you must first
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disconnect the BioStack from the 405 LS and change the Instrument Setting for the
BioStack: Press Setup Menu> BIOSTK> CONF>MANUAL.
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General Operation Troubleshooting

This is a list of potential performance problems and their solutions.

Startup

Problem Possible Cause What To Do

Display (Touch
screen) not on.

Power cord not
plugged in.

Check power connection.

Carrier/manifold
position error.

Manifold or
carrier is being
obstructed.

Remove obstruction.

Motor, sensor, or
electrical
problem.

Turn instrument off, wait at least 15 seconds, and
turn it back on. If the self-test does not pass, contact
BioTek TAC.

Misaligned
carrier or
manifold.

Contact BioTek TAC.

Incorrect
manifold setting.

Make sure the manifold setting matches the installed
manifold.
LHC: Tools>Instrument Utilities>Washer
Touch screen: Instrument>Options

Microplate Scratches

Problem Possible Cause What To Do

Scratches
on
microplate
bottom.

Microplate dispense or
aspiration height
adjustment too low.

Change the Dispense or Aspirate height, the Z-axis
position.

Microplate not properly
seated or strips not
level.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder. If the
problem is unresolved, the carrier may have to be
realigned. Contact BioTek TAC.
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Washer Problems

Vacuum Pump

Problem Possible Cause What To Do

Vacuum pump
does not start,
or shakes when
turned on.

Vacuum pump is not
turned on.

Flip the switch on the side of the vacuum pump to
turn it on.

Vacuum pump
accessory cable not
installed correctly.

Plug the vacuum pump accessory cable into the
back of the instrument, Accessory Outlet.

Too much residual
vacuum force for
pump.

Release the vacuum by loosening the waste bottle
stopper. Reconnect and start again.

Blown fuse in
accessory outlet.

Plug the vacuum pump accessory cable into the
back of the instrument, Accessory Outlet, not into a
wall outlet.

Increase vacuum dissipation delay.
LHC: Tools>Instrument Utilities>Vacuum
Dissipation Delay.
Keypad: Setup Menu>àADVANCàVACDIS

Replace fuse (PN 46055), Replace the Vacuum
Pump Fuse on page 145

Repeated
blown fuses.

Vacuum Dissipate
Delay is set too low
for the volume of
the waste bottle.

See above. If not enough time is allowed for the
vacuum to dissipate, the pump will try to start
while it is under a vacuum. The pump draws
excessive current and blows the fuse.

Pump has been
flooded.

Remove the head from the pump and inspect it for
corrosion, crystalline buildup or liquid. Contact
BioTek TAC for information on pump rebuilding kits.

Fluid Aspiration

Problem Possible Cause What To Do

Poor or
uneven
aspiration.

Insufficient or no
vacuum.

Firmly seat the waste bottle covers.  Ensure tubing is
connected properly. Check all external tubing and in-
line filter for kinks or clogs. If you are using an in-line
vacuum filter, it may need to be replaced.

With the vacuum pump on, remove the vacuum pump
tubing from the back of the instrument. Put your finger
over the port; if there is no vacuum, contact BioTek
TAC.
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Problem Possible Cause What To Do

Clogged aspiration
tubes on the
washer manifold.

Remove and clean the washer manifold on page 131

Make sure the microplate carrier is level and the waste
valve is not touching the bench.

Aspirate height
adjustment too
high or too low.

Change the aspiration height (Z-axis position) in the
protocol.

Vacuum pump
failure.

Contact BioTek TAC.

Uneven
aspiration of
water buffer.
Some wells
left full.

No surfactant in
the buffer, such as
Tween® 20.

Add surfactant to the buffer. If this is not possible,
continue below.

Insufficient
vacuum.

BioTek offers a high-flow pump for assays using only
water for the wash fluid. Contact BioTek for more
information.

Protocol settings
not optimized.

Optimize protocols to improve evacuation on page 40

Aspiration tubes
not properly
positioned
horizontally in
wells.

If none of the tubes are bent, try adjusting the
horizontal aspirate position (X-/Y-axis) in the protocol.

Microplate not
level in carrier, or
strips not level in
holder.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder.
If the problem is unresolved, the carrier may have to
be realigned. Contact BioTek TAC.

Too much
residual left
in wells after
aspiration.

Clogged vacuum
filter.

If you are using an in-line vacuum filter (PN 49943),
the filter may need to be cleaned or replaced.

Waste bottle cover
not properly
sealed or fittings
not properly
connected.

Firmly seat the waste bottle stopper.  Make sure tubing
is connected properly.

Manifold out of
alignment or not
moving freely.

Check for obstructions. If none are found, contact
BioTek TAC.
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Problem Possible Cause What To Do

Protocol requires
optimization.

Optimize protocols to improve evacuation on page 40.

Aspirate tubes are
bent.

Contact BioTek TAC.

Fluid Delivery

Problem Possible Cause What To Do

Unable to
dispense
fluid.

Clogged fluid filter. Clean the fluid filter inside the supply bottle.

Inlet tube not connected. Make sure all tubing is connected properly.
Check all external tubing for kinks or clogs.

Clogged valve Create a protocol with several small primes, e.g.
10 mL, to try to unclog valve.

Clogged dispense tubes on
the washer manifold.

Remove and clean the washer manifold on page
131

No wash or rinse fluid. Fill bottles with appropriate fluid. Ensure bottles
are clean and do not contain particles or organic
material.

Unable to
dispense
fluid.

System not primed. Large
air pockets in tubing.

Run W-DAY_RINSE.

Insufficient suction,
clogged tubing, or faulty
valve.

Perform Washer Maintenance; If the problem
persists, contact BioTek TAC.

Plate
overfills
(floods).

Dispense height too high.
The aspirate tubes are too
far above the wells to
prevent overflow.

Lower the dispense height (Z-axis position) in the
protocol.

Dispense flow rate too
low.

Define a higher dispense Flow Rate in the
protocol.

Cell wash flow rate 1 or 2
is used with 384-well
plates.

Specify a non-CW dispense Flow Rate when using
384-well plates.

Aspiration tubes hit
bottom of trough during
Prime or Maintenance.

Manifold may not be properly seated or mounted.
Contact BioTek TAC.

BioTek Instruments, Inc.



186 | Chapter 7: Troubleshooting

Problem Possible Cause What To Do

In-line vacuum filter
plugged.

Replace or remove the in-line vacuum filter.

Loose covers on waste
bottles.

Firmly tighten waste bottle covers.

Dispense rate too fast for
volume selected.

Specify slower dispense Flow Rate or lower
volume.

Faulty vacuum pump. Contact BioTek TAC.

Insufficient or no vacuum. Firmly seat the waste bottle covers.
Check all external tubing for kinks or clogs.
When the program begins, you should be able to
hear the vacuum pump turn on. If it is not turning
on, contact BioTek TAC.
If the vacuum pump turns on, remove the
vacuum tubing from the back of the instrument
and put your finger over the port. If there is no
vacuum, contact BioTek TAC.

Uneven
dispensing
of fluid;
wells not
filled.

Clogged dispense tubes on
the washer manifold.

Remove and clean the washer manifold on page
131

Manifold or tubing not
adequately primed.

Run W-DAY_RINSE once or twice.

Dispense flow rate too
low. Flow rate 1 or 2 CW is
used with 384-well plates.

Define a higher dispense Flow Rate.

Microplate aspiration
height adjustment too high
or too low.

Change the aspirate height (Z-axis position) in
the protocol.

Fluid Leakage

Problem Possible Cause What To Do

Fluid leaking from
manifold.

Defective seals. Contact BioTek TAC

Aspiration tubes
only: vacuum too
low.

Check waste connector tubes; make sure they
are properly connected.
If you are using an in-line vacuum filter,
check the filter for clogging, and replace if
necessary.
Check seal of waste bottle covers.
Check for air leaks in the waste tubing and
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Problem Possible Cause What To Do

bottles.
Use a slower Aspiration Travel Rate.

Uneven (not level)
surface.

Make sure the surface the washer sits on is
perfectly level.

Fluid leaking from
underneath the
instrument.

Defective tubing
connector or inlet
tubing.

Contact BioTek TAC.

Leaking valve. Contact BioTek TAC.

Fluid leaking from
external tubing
connector.

Defective
connector.

Replace connector.

Worn tubing. Replace tubing or cut back tubing one inch (to
remove worn section).

Worn seal (inlet or
vacuum fitting).

Replace filter or seal.

Microplate Carrier Movement

Problem Possible
Cause What To Do

Aspiration
tubes not
entering
wells
correctly.

Microplate not
properly seated
or strips not
level.

Reseat microplate in carrier or strips in holder.
Make sure the carrier is clean.
Try a different microplate or strip holder. If the problem
is unresolved, the carrier may have to be realigned.
Contact BioTek TAC.

Aspirate tubes
position is too
wide for a
movement.

Change the horizontal, X- or Y-axis aspirate position in
the protocol.

Aspirate tubes
bent.

Contact BioTek TAC.

Loud,
annoying
noise during
operation.

Plate carrier is
rubbing against
glide strip.

Thoroughly clean the microplate carrier and exterior
surface as recommended in the maintenance procedure.

384-well
plates not
properly
washed.

Microplate
carrier not
moving
correctly in the

Clean the plate carrier system. If problems persist,
contact TAC for assistance cleaning the carrier transport
arm.
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Problem Possible
Cause What To Do

Y-axis.

Uneven
performance.

Plate carrier
leveling feet
damaged.

Replace plate carrier: contact BioTek TAC for assistance.
Note: "Q" model washers with Verify™ Technology must
recalibrate the Verify test plate after installing the new
carrier.

Washer Manifold Movement

Problem Possible
Cause What To Do

Manifold
position
error.

Manifold
movement is
blocked.

Check orientation of microplate; A1 should be in the left rear
corner of the plate carrier as you face the instrument.
Check for and remove any obstructions.
Ensure the manifold is installed properly.

Incorrect
manifold
selected.

Make sure the washer manifold setting matches the installed
manifold (96-, 192--tube).
LHC: Tools>Instrument Utilities>Washer>Manifold
Selection.

Keypad: Setup Menu>g>MANIF

Communication Errors

Here are some guidelines for troubleshooting communication errors between the
405 LS and the computer.

6045: A potentially common error,
especially when using the Predefined
Protocols, a "serial write" error, is easily
fixed by correcting the COM port setting.

BioStack communication error: when controlling the BioStack with the LHC, make
sure the onboard configuration setting is Manual.

810D: Similarly, the 810D message appears when the instrument is busy, for
example when AutoPrime is running. The LHC can only talk to the instrument
when its main menu is displayed. Press the Stop button on the keypad, if desired,
to end the current process and return to the main menu.
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Safety first

nTo prevent damage to the instrument, always turn OFF the 405 LS or the
computer before removing or inserting a communications (serial or USB)
cable.

When the computer (PC) won't communicate with the instrument:

1. Run the system self-test. All BioTek instruments perform a self-test when
turned on. The 405 LS will not communicate if it fails an internal system test. An
error message will be displayed when a test fails.

2. Make sure the USB cable is in perfect condition and properly attached to the
port defined in the Instrument Settings dialog (e.g. COM 1). Review the LHC
Help Topic Select Help&gt;Help Topics and search for "About COM Ports."
"About COM Ports" to learn about virtual COM ports when using a USB cable.
Correct and reboot both PC and instrument. Test communication.

3. Confirm that the USB cable was obtained from BioTek. USB cables are not
universal. Contact BioTek customer service to purchase a factory tested cable.
After installing a known, good cable, reboot both PC and instrument.
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Appendix A

Error Codes

A listing of potential error codes and possible solutions for
resolving them.

System Error Codes 192
405 LS-LHC Software Error Codes 200
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System Error Codes

Most of these error conditions require technical expertise to correct. Error code 306
and few other exceptions to this rule are listed with remedies in the
Troubleshooting section. A few other errors may be caused by an obvious
obstruction to a device's movement or insufficient fluid in a supply vessel. Fix
these kinds of errors and restart your instrument to give it an opportunity to clear
the error code.

Contact BioTek Technical Assistance Center (TAC) for assistance.

Code Message What to do

100 Task was aborted Restart instrument if this message is
unexpected.

210, 220 Carrier X motor didn’t find
home opto sensor transition
Carrier X motor didn’t find
autocal jig opto sensor
transition

Clean the plate carrier, rails, and glide
strips, using mild detergent and hot water,
70% isopropyl alcohol or ethanol. Restart
the instrument. If the error occurs again,
contact BioTek TAC.

211, 221 Carrier Y motor didn’t find home
opto sensor transition
Carrier Y motor didn’t find
autocal jig opto sensor
transition

Run self test. If error reoccurs, contact
BioTek TAC.

212, 222 Dispense head motor didn’t find
home opto sensor transition,
Dispense head motor didn’t find
autocal jig opto sensor
transition

Run self test. If error reoccurs, contact
BioTek TAC.

213, 223 Wash head motor didn’t find
home opto sensor transition,
Wash head motor didn’t find
autocal jig opto sensor
transition

Run self test. If error reoccurs, contact
BioTek TAC.

220 Carrier X motor didn’t find
autocal jig optical sensor
transition.

Service Only.
Contact BioTek TAC.

221 Carrier Y motor didn’t find
autocal jig optical sensor
transition.

Service Only.
Contact BioTek TAC.
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Code Message What to do

223 Wash head motor didn’t find
autocal jig optical sensor
transition.

Service Only.
Contact BioTek TAC.

300 Carrier X motor interlock safety
switch open

Service Only.
Contact BioTek TAC.

301 Carrier Y motor interlock safety
switch open

Service Only.
Contact BioTek TAC.

302 Dispense head motor interlock
safety switch open

Service Only.
Contact BioTek TAC.

303 Wash head motor interlock
safety switch open

Service Only.
Contact BioTek TAC.

400 Carrier X motor failed positional
verify

Run self test. If error reoccurs, contact
BioTek TAC.

401 Carrier Y motor failed positional
verify

Run self test. If error reoccurs, contact
BioTek TAC.

402 Dispense head motor failed
positional verify

Run self test. If error reoccurs, contact
BioTek TAC.

403 Wash head motor failed
positional verify

Service Only.
Contact BioTek TAC.

600-606 Specified motor currently in use Service Only.
Contact BioTek TAC.

700 -
70F

Invalid motor number specified Service Only.
Contact BioTek TAC.

900 Calibrationon failed. The
measured or calculated autocal
value is out of tolerance

Service Only.
Contact BioTek TAC.

A00 Invalid plate type selected The currently selected plate type is not
supported with the currently installed or
requested hardware. If this is not the case,
contact BioTek TAC.

C01 Configuration or autocal data
missing

Service Only.
Contact BioTek TAC.

C02 Checksum mismatch -calculated
checksum didn’t match saved
checksum

Service Only.
Contact BioTek TAC.
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Code Message What to do

C03 Configuration parameter out of
range

Service Only.
Contact BioTek TAC.

1001 Bootcode powerup checksum
test failed

Contact BioTek TAC.

1002 Unknown error in bootcode Contact BioTek TAC.

1003 Bootcode page program error Contact BioTek TAC.

1004 Bootcode block size error (not
256)

Contact BioTek TAC.

1005 Invalid processor signature (not
1280,1281,2560,2561)

Contact BioTek TAC.

1006 Bootcode memory exceeded Contact BioTek TAC.

1007 Invalid slave port Contact BioTek TAC.

1008 Invalid response from slave Contact BioTek TAC.

1009 Invalid processor detected Contact BioTek TAC.

1010 Checksum error downloading
basecode

Contact BioTek TAC.

1250 Internal RAM test error on the
UI processor

Contact BioTek TAC.

1251 Internal RAM test error on the
MC processor

Contact BioTek TAC.

1260 Stack test error on the UI Contact BioTek TAC.

1261 Stack test error on the MC Contact BioTek TAC.

1400 No vacuum pressure detected
after turning on the vacuum
pump

Make sure the vacuum pump is turned on,
and not leaking; the waste bottle has not
overflowed and its caps are seated
correctly.  If the pump is not running, the
fuse may be blown. But, before replacing the
fuse, first try to determine and remedy the
cause of the failure. If the pump sounds
strained or runs slowly, it may be damaged.
Review other related Troubleshooting
suggestions.
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Code Message What to do

1401 The waste bottles should be
emptied before continuing

Empty the waste bottles and rerun the
protocol.

1402 The requested valve is invalid Contact BioTek TAC.

1403 Invalid Z-axis offset value The Magnet Adapter offset (MAGHT) is too
high, the "in use" value is missing, or a more
serious software problem exists. Make sure
the setting is valid, and if so, contact BioTek
TAC.

1404 Plate type restricted This instrument model or the requested
device does not support the selected plate
type. Edit the protocol to change the plate
type.

1405 Z-axis out of range The requested travel/dispense height cannot
be reached. The conflict may be caused by a
combination of variables, plate type, Plate
Clear or other height settings. Review the
protocol parameters and instrument settings
to identify a correction.

1407 Invalid step type The protocol may have been created for a
different instrument, it is not compatible
with this instrument.

1408 Invalid plate geometry Contact BioTek TAC.

1409 Invalid plate carrier type Contact BioTek TAC.

1410 Incompatible hardware Vacuum filtration requested but either the
instrument is in BioStack mode, or this
instrument is not configured to support it.
Change the BioStack configuration, it is not
compatible with the vacuum carrier, or
contact BioTek TAC.

1411 Invalid plate carrier The vacuum filtration carrier must be
installed to run this kind of protocol, and the
plate carrier setting must represent the
currently installed carrier.

1412 Tip clearance error Contact BioTek TAC.

1413 AutoPrime in progress Contact BioTek TAC.

1414 AutoPrime aborted Contact BioTek TAC.
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Code Message What to do

1415 AutoPrime value out of range Contact BioTek TAC.

1500 No buffer fluid detected at the
start of a wash protocol

Fluid detection errors. Make sure the supply
bottle is full and properly connected, the
tubing is not kinked, blocked, etc., and the
correct port/valve is selected. 1501 No buffer fluid detected before

the washer dispense step

Note: Running very low density fluids, like alcohol, may generate some of these fluid
detection errors because the fluid prohibits the float detector from operating
properly. Disable the Fluid sensor (Washer Settings) while using such low
density fluids, but be vigilant about monitoring fluid levels.

1502 The buffer valve selection is
invalid

Contact BioTek TAC.

1503 Dispense volume error Contact BioTek TAC.

1504 No buffer detected flowing
through the manifold during an
operation

Flow detection errors. Make sure the supply
bottle is full and properly connected, the
tubing is not kinked, blocked, etc., and the
correct port/valve is selected.

1505 No buffer detected at the end of
a wash protocol

1506 The requested carrier Y-axis
position is out of range

Contact BioTek TAC.

1507 Internal valve transition error Contact BioTek TAC.

1508 Pre-dispense volume error The specified Pre-dispense volume is invalid
for this plate type. Edit the protocol.

1509 Low flow 192-tube manifold
error

The 192-tube manifold does not support cell
wash or low-flow protocols. A wash step
mismatch has occurred. Edit the protocol.

1510 Low flow 96-tube manifold error Contact BioTek TAC.

1511 External Buffer Switching valve
module is required

The current protocol is defined to use
different valves of the Buffer Switching
module, which is not installed. Edit the
protocol.

1512 Invalid plate type The specified plate type is not supported
with the current hardware.
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Code Message What to do

1513 Plate type - manifold conflict Change the Plate Type to one supported by
the manifold. Or, click the Instrument
Settings link and make sure they match the
physical hardware: Get settings from
instrument.

1514 Ultrasound module not
connected

The protocol may have been created for a
different instrument, according to the
instrument's basecode it is not compatible
with this instrument. Contact BioTek TAC.1515 Cell Wash hardware not

installed

1516 Vacuum filtration start or end
error

Vacuum pressure is detected in the
intermediate waste bottle before or after the
run. Conatct BioTek TAC.

1517 Vacuum filtration sensor error Unable to read vac. filtration sensor. This is
expected if you are running with very low
pressure, in this case disable the sensor.
Otherwise, check for leaks, e.g. bottle cap.

1600-
160C

The onboard storage space
allocated for this function has
been used up.

Use the LHC ”Manage Memory” control to
reallocate space.

160D Not a valid step Contact BioTek TAC.

1700-
1709

"Q" model level sensor errors Contact BioTek TAC.

170A-
170F

"Q" model level sensor RX
errors

Contact BioTek TAC.

1710-
1716

"Q" model level sensor RX
errors

Contact BioTek TAC.

1717-18 Level sensor X-axis parameter
out-of-range

Contact BioTek TAC.

171A-
171F

Level sensor initiation errors Contact BioTek TAC.

1720-
1736

Level sensor functional errors Take action to correct the error, if possible.
Otherwise, contact BioTek TAC for
assistance.

1737 Plate test did not find plate. Put a plate on the plate carrier.
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Code Message What to do

1738-
173A

Level sensor functional errors Take action to correct the error, if possible.
Otherwise, contact BioTek TAC for
assistance.

2400 Parameter limit exceeded Contact BioTek TAC.

4000 Program locked so operation
denied

Contact BioTek TAC.

4010 Program cannot be erased so
delete denied

Contact BioTek TAC.

4020 Bad checksum when reading
program from EEPROM

Contact BioTek TAC.

4030 Program not found Contact BioTek TAC.

4040 Can’t save program because no
space available

Contact BioTek TAC.

4050 Program run canceled by user Restart instrument if this message is
unexpected.

8100 Communications NAK Contact BioTek TAC.

8101 Timeout while waiting for serial
message data

Contact BioTek TAC.

8102 Instrument busy and unable to
process message

Contact BioTek TAC.

8103 Receive buffer overflow error Contact BioTek TAC.

8104 Checksum error Contact BioTek TAC.

8105 Invalid structure type in
byMsgStructure header field

Contact BioTek TAC.

8106 Invalid destination in
byMsgDestination header field

Contact BioTek TAC.

8107 Request object received not
supported by instrument

Contact BioTek TAC.

8108 Message Body size exceeds
max limit

Contact BioTek TAC.

8109 Max number of requests
currently running and cannot
run the latest request

Contact BioTek TAC.
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Code Message What to do

810A No request running when
response request issued

Contact BioTek TAC.

810C Response for outstanding
request not ready yet

Contact BioTek TAC.

810D To communicate with the LHC,
the instrument must be at its
Home screen

The LHC can only talk to the instrument
when its main menu is displayed. When the
instrument is busy, for example when
AutoPrime is running, press the Stop button
on the keypad, if desired, to end the current
process and return to the main menu.

810E One or more request
parameters are not valid

Contact BioTek TAC.

810F The command was received
while the software was not
ready to accept that command

Contact BioTek TAC.

A00 Invalid plate type requested Service Only.
Contact BioTek TAC.

A100 -
A10F

Software device not available Service Only.
Contact BioTek TAC.

A200 Version strings for multiple
microprocessors do not match

Service Only.
Contact BioTek TAC.

A301 +5v logic power supply level
error

Service Only.
Contact BioTek TAC.

A302 +24v system/motor power
supply level error

Service Only.
Contact BioTek TAC.

A400 Malloc failed Service Only.
Contact BioTek TAC.

A500 Multiple tasks attempted to use
display simultaneously

Service Only.
Contact BioTek TAC.

A600 Serial EEPROM access error Service Only.
Contact BioTek TAC.

A700 Motor truncation error Service Only.
Contact BioTek TAC.
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405 LS-LHC Software Error Codes

Generally, these errors are caused by protocol parameters that conflict with the
instrument's onboard settings. The protocol may have been originally created for a
different hardware configuration, the 192-tube wash manifold instead of the 96-
tube, for example.

Quick Fix: Make sure your Instrument Settings accurately reflect your
instrument’s hardware configuration and then, modify the protocol to fix any
invalid parameters. With the 405 LS connected to and communicating with your
computer and its main menu displayed on the keypad:

1. Click the Settings link in the main view.

2. In the Instrument Settings dialog, click the instrument link to get the settings
from the instrument.

3. Modify the protocol step that generated the error message.

Error
Code Description Help

6000 General communication error during
download.

See Communication Errors on page 188

6001 COM port created by USB converter
no longer active

See Communication Port

6002 Invalid basecode part number;
instrument is not an 405 LS

Service Only.
Contact BioTek TAC.

6003 Invalid Basecode Data Version;
basecode needs to be updated

Contact BioTek to obtain latest basecode.

6004 No rows are selected for the specified
plate type

Modify the protocol to select a row.

6005 Invalid row selection value (must be
0 or 1)

Contact BioTek TAC.

6006 This instrument can only process 96-
well plates

The protocol may have been created for
another instrument, change the plate type
or select another protocol.

6007 This instrument can only process
1536-well plates

6008 The 8-tube Syringe Manifold can only
be used with 96-well plates

Mismatch between installed hardware and
protocol parameters: change the plate
type or correct the instrument settings to
match the currently installed hardware.
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Error
Code Description Help

6009 The 96-tube singe wash manifold can
only be used with 96-well plates

6010 The data is invalid or out-of-range. Service Only.
Contact BioTek TAC.

6011 This step type cannot be
downloaded.

Review the limitations to transferring
protocols to the instrument, See the LHC
Help Topic: Transferring Protocols.

6012 Illegal characters in protocol name See the LHC Help topic: Define a
Protocol.

6013 The protocol name length must be
16 characters or less. 

6016 The volume is out-of-range. Modify the volume or change the
cassette type.

6017 Invalid flow rate. Learn about the Syringe Dispense Step

6018 Invalid number of
pre-dispenses. Service Only.

Contact BioTek TAC.
These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6019 Invalid horizontal dispense position.

6020 Invalid dispense height.

6021 Invalid plate clear height.

6022 Invalid column selection value
(must be 0 or 1).

6023 Invalid protocol step type.

6024 The Definition String contains
invalid data.

6025 Manifold conflict between protocol
requirements and instrument
configuration.

Change the Washer Manifold or change
the Instrument Setting. See Appendix B
in the operator's manual.

6026 Valve module conflict between
protocol requirements and
instrument configuration.

Make sure the Buffer Switching setting
matches your instrument; see
Instrument Settings.

6028 Filter washer conflict between
protocol requirements and
instrument configuration.

Service Only.
Contact BioTek TAC.
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Error
Code Description Help

6031 Cannot use a 96-well plate with a
192-tube manifold.

Modify the Plate Type or Change the
Washer Manifold.

6032 Downloading Protocols is not
supported.

Service Only.
Contact BioTek TAC.

6040 Invalid baud rate Service Only.
Contact BioTek TAC.
These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6041 Invalid data bits selection

6042 Invalid stop bits selection

6043 Invalid parity selection

6044 Serial port error Fix the COM port setting. Check the
cabling. Click the Port link and use the
drop-down menu to see all active ports.
Customize the Predefined Protocols to
avoid this error in future.
When controlling the BioStack with the
LHC, make sure the instrument's BioStack
setting is Manual.

6045 Serial write error

6046 Serial read error

6047 Checksum error Contact BioTek TAC.

6048 Serial NAK error Make sure the COM port setting is correct
and the cable is properly connected.
Restart the instrument. If error reoccurs,
contact BioTek TAC.

6049 Excess data, or not enough data,
received.

To correct these errors:

l Reset the instrument.

l Check cables, plug in only one
communication cable at a time:
USB or serial.

l Try running a different protocol.
If error reoccurs, contact BioTek TAC.

6050 Invalid message header

6051 Invalid message object

6052 Invalid message body size

6053 Serial message timeout

6054 Port handle error

6055 Read timeout value is invalid.
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Error
Code Description Help

6056 Unauthorized to open the COM port Make sure the COM port setting is correct
and the cable is properly connected.
Restart the instrument. If error reoccurs,
contact BioTek TAC.

6057 Out-of-range parameter for the open
port function.

6058 Unable to open the COM port.

6059 Unable to clear the transmission
buffer.

6060 Unable to close the port.

6061 Port is no longer available.

6062 Unhandled exception while
transmitting message

Contact BioTek TAC

6063 The selected plate type is not allowed
with this protocol step

Modify the protocol to change the plate
type.

6065 Too few data bytes received from the
instrument

Contact BioTek TAC.

6066 Ultrasonic cleaning assembly is not
installed

The protocol may have been created for a
different instrument. Make sure the
instrument settings match the current
instrument and modify the protocol.

6074 Invalid Y-axis offset value Service Only.
Contact BioTek TAC.
These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6075 Invalid Z-axis offset value

6076 Vacuum filtration not allowed with
1536-well plates.

Modify the protocol to change the plate
type.

6087 'Move carrier home' is required when
duration exceeds 1 minute.

Contact BioTek TAC
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Error
Code Description Help

6088 Invalid Shake/Soak options selected Service Only.
Contact BioTek TAC.

These codes indicate an unexpected
software error that cannot be fixed
without BioTek support.

6089 Invalid Shake Intensity selected

6090 Invalid Washer buffer selected

6091 Invalid Washer Aspirate Delay value

6092 Invalid Washer Aspirate Travel Rate
value

6093 Invalid Wash Cycles value

6094 Invalid Wash format selected

6095 Invalid Wash Sectors selected

6096  Wash Aspirate Delay value is
required.

6100 This functionality requires the
software to be registered.

You must register the software with
BioTek. Select Help>Register
Software.
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Appendix B 
 
Warnings, Hazards, Precautions 
Avertissements, Risques et Précautions 
 
This document contains information on warnings, hazards, and precautions that may apply to the 
BioTek product(s) you have purchased. BioTek provides this appendix to ensure that you have the 
information you need to safely operate our products. If you have any questions, please contact 
BioTek directly or your local BioTek representative. Refer to the operator’s manual for contact 
information. 

Ce document contient des informations sur les avertissements, les risques et les précautions qui 
peuvent s'appliquer aux différents produit BioTek que vous avez acheté. BioTek propose ce 
document en plusieurs langues afin de s'assurer que vous avez les informations dont vous avez 
besoin pour manipuler en toute sécurité tous nos produits. Si vous avez des questions, veuillez 
contacter BioTek directement ou votre représentant local BioTek. Reportez-vous au manuel de 
l'utilisateur pour obtenir des informations sur ou nous contacter. 

Some Warnings, Hazards, and Precautions are instrument-specific. Where applicable, the 
information is preceded by the instrument type (e.g., “Detection”, “Liquid Handling”) or model 
(e.g., “EL406”, “BioStack”). If there is no such indication, the information applies to most or all 
products. 

Certaines mises en garde, risques et précautions sont spécifiques à chaque appareil. Le cas 
échéant, l'information est précédée par la catégorie d'instruments (par exemple, "Détection", 
"Liquid Handling”) ou modèle (par exemple, "EL406", "BioStack"). S'il n'y a pas une telle 
indication, l'information s'applique à tous les produits. 

Warnings, Avertissements 

 

Operate the instrument on a level, stable surface away from excessive humidity. 

Faites fonctionner l'appareil sur une surface plate et stable à abri de l'humidité 
excessive. 

When operated in a safe environment according to the instructions in this document, 
there are no known hazards associated with the instrument. However, the operator 
should be aware of certain situations that could result in serious injury; these vary 
depending on the instrument type. See Hazards and Precautions. 

Lorsque l’appareil est utilisé dans un environnement sûr, selon les instructions de ce 
document, il n'existe pas de risques connus associés à l'instrument. Toutefois, 
l'opérateur doit être conscient de certaines situations qui pourraient entraîner des 
blessures graves variable en fonction du type d'instrument. Voir Dangers et 
Précautions. 

 Detection: 
Bright sunlight or strong incandescent light can reduce the linear performance range 
of the instrument. 

Measurement values may be affected by extraneous particles (such as dust) in the 
microplate wells. A clean work area is necessary to ensure accurate readings. 

Détection: 
La lumière du soleil ou une forte lumière incandescente peut réduire la gamme de 
puissance linéaire de l'instrument. 



Les valeurs de mesure peuvent être affectées par des particules étrangères (comme la 
poussière) dans le puits de la microplaque. Un espace de travail propre est nécessaire 
pour assurer des lectures précises. 

 Liquid Handling: 
Strict adherence to instrument maintenance and qualification procedures is required to 
ensure accurate dispense volumes and risk-free operation. 

Manipulations des liquides: 
Le strict respect de maintenance des instruments et des procédures de qualification 
est nécessaire pour assurer l'exactitude des volumes de distribution et un 
fonctionnement sans risque. 

Hazards, Dangers 

 

Warning! Internal Voltage. Always turn off the power switch and unplug the power 
supply before cleaning the outer surface of the instrument or, for some readers, 
removing its top case. 

Attention! Tension interne. Toujours mettre l'appareil hors tension et débrancher le 
bloc d'alimentation avant de nettoyer la surface extérieure de l'instrument ou, pour 
certains lecteurs, en enlevant le capot supérieur. 

 

Warning! Power Rating. The instrument’s power supply or power cord must be 
connected to a power receptacle that provides voltage and current within the specified 
rating for the system. Use of an incompatible power receptacle may produce electrical 
shock and fire hazards. 

Attention! Puissance. La puissance du cordon d'alimentation de l’appareil ou 
l’alimentation doit être branchée à une prise de courant qui fournit la tension. La 
valeur spécifiée pour le système doit être impérativement utilisée. L’utilisation d'une 
prise de courant incompatible peut produire un choc électrique et un incendie. 

 Warning! Electrical Grounding. Never use a plug adapter to connect primary power 
to the external power supply or the instrument. Use of an adapter disconnects the 
utility ground, creating a severe shock hazard. Always connect the power cord directly 
to an appropriate receptacle with a functional ground. 

Attention! Prise terre. Ne jamais utiliser un adaptateur pour connecter 
l'alimentation primaire du bloc d'alimentation externe ou de l'appareil. L’utilisation 
d'un adaptateur se déconnecte de la prise terre, créant un risque d'électrocution 
grave. Toujours brancher le cordon d'alimentation directement à une prise terre. 

 Warning! Service. Only qualified technical personnel should perform service 
procedures on internal components. 

Attention! Service. Seul un personnel technique qualifié doit effectuer les procédures 
d'entretien des composants internes. 

 Warning! Accessories. Only accessories that meet the manufacturer’s specifications 
shall be used with the instrument. 

Attention! Accessoires. Seuls les accessoires qui répondent aux spécifications du 
fabricant doivent être utilisées avec l'instrument. 

 Warning! Lubricants. For instruments that have an exposed rail for the plate carrier 
or no plate chamber access door, do not apply lubricants to the microplate carrier or 
carrier track. Lubricant on the carrier mechanism or components in the carrier 
compartment will attract dust and other particles, which may obstruct the carrier path 
and cause the instrument to produce an error. 



Attention! Lubrifiants. Pour les instruments avec un rail exposé pour support de 
plaques ou sans porte d'accès à l’intérieur de la plaque, ne pas appliquer de lubrifiants 
pour microplaques ou piste de support de microplaques. Un lubrifiant sur le 
mécanisme de support ou des composants dans le compartiment transporteur peut 
attirer la poussière et d'autres particules qui peuvent obstruer la voie de transport et 
l'instrument peut être amené à produire une erreur. 

 Warning! For instruments that weigh more than 40 lb (18 kg), use two people when 
lifting and carrying the instrument. 

Attention! Pour les instruments qui pèsent plus de 40 lb (18 kg), il faut deux 
personnes pour déplacer l'instrument. 

 Warning! Liquids. Avoid spilling liquids on the instrument; fluid seepage into internal 
components creates a potential for shock hazard or instrument damage. If a spill 
occurs while a program is running, abort the program and turn off the instrument. 
Wipe up all spills immediately. Do not operate the instrument if internal components 
have been exposed to fluid. 

Attention! Liquides. Évitez de renverser des liquides sur l'instrument; l’infiltration de 
liquide dans les composants internes crée un risque d’électrocution ou d'endommager 
l'instrument. Si un liquide est accidentellement renverse sur l’appareil lorsqu'un 
programme est en cours d'exécution, interrompez le programme et éteignez l'appareil. 
Essuyez immédiatement toutes les éclaboussures. Ne pas faire fonctionner l'appareil si 
les composants internes ont été exposés à des fluides. 

 Warning! Unspecified Use. Failure to operate the equipment according to the 
guidelines and safeguards specified in this manual could result in a hazardous 
condition. 

Attention! Utilisation non spécifié. Si l’appareil n’est pas utilisé selon les lignes 
directrices et les garanties spécifiées dans ce manuel, vous risquez d’entrainer une 
situation dangereuse. 

 Warning! Software Quality Control. The operator must follow the manufacturer’s 
assay package insert when modifying software parameters and establishing reading, 
washing, or dispensing methods. Failure to conduct quality control checks could 
result in erroneous test data. 

Attention! Contrôle qualité du logiciel. L'opérateur doit suivre les conseils du 
fabricant de dosage lors de la modification des paramètres du logiciel, de la lecture, du 
lavage, de la distribution ou des méthodes. L’omission d'effectuer des contrôles 
de qualité pourrait se traduire par des données de test erronés. 

 

Warning! Potential Biohazards. Some assays or specimens may pose a biohazard. 
This hazard is noted by the symbol shown here. Adequate safety precautions should 
be taken as outlined in the assay’s package insert. Always wear safety glasses and 
appropriate protective equipment, such as chemically resistant rubber gloves and 
apron. 

Attention! Risques biologiques potentiels. Certains tests ou spécimens peuvent 
présenter un risque biologique. Ce risque est indiqué par le symbole ci-contre. Les 
précautions de sécurité adéquates doivent être prises, comme indiqué dans la notice 
du test en question. Toujours porter des lunettes de sécurité et équipements de 
protection appropriés, notamment des gants en caoutchouc, résistant aux produits 
chimiques et un tablier. 



 

 

Warning! Pinch Hazard. Some areas of this instrument, its components, and/or 
accessories can present pinch hazards when the instrument is operating. The module 
is marked with one of the symbols shown here. Keep hands/fingers clear of these 
areas when the instrument is operating. 

Attention! Pincement. Certaines zones de cet instrument, ses composants et / ou 
accessoires peuvent présenter des dangers potentiels de pincement lorsque l'appareil 
est en fonction. Le module est repéré avec l'un des symboles illustrés ici. Gardez les 
mains / doigts hors de ces zones lorsque l'appareil est en fonction. 

 

Warning! Hot Surface. For readers that use a tungsten lamp, the lamp assembly is 
hot when the instrument is turned on. Turn off the reader and allow the lamp to cool 
down before attempting to replace it. 

Attention! Surface chaude. Pour les lecteurs avec lampe au tungstène, la lampe est 
très chaude lorsque l'appareil est allumé. Éteignez le lecteur et laissez la lampe 
refroidir avant d'essayer de la remplacer. 

 Detection: 
Warning! Reader Data Reduction Protocol. For readers with keypads: The 
onboard assay software will flag properly defined controls when they are out of range. 
The software will present the data with the appropriate error flags for the operator to 
determine control and assay validity. For readers operated via computer control: 
No limits are applied to the raw measurement data. All information exported via 
computer control must be thoroughly analyzed by the operator. 

Détection: 
Attention! Protocole pour lecteur de réduction des données. Pour les lecteurs 
avec claviers: Le logiciel d'analyse inclus dans ces lecteurs, signalera lorsque les 
touches-contrôle sont hors de portée. Le logiciel signalera sur les données avec les 
drapeaux d'erreur appropriés afin que l’utilisateur puisse déterminer le contrôle et la 
validité du dosage. Pour les lecteurs pilotés via contrôle de l'ordinateur: Aucune 
limite n'est appliquée aux données brutes de mesure. Toutes les informations 
exportées via contrôle de l'ordinateur doivent être soigneusement analysés par 
l'opérateur. 

 

Instruments with Barcode Scanners: 
Warning! Laser Beam. Serious eye injury may occur if you stare directly into the 
laser beam of the barcode scanner during operation of the scanner. This hazard is 
noted by the symbol shown here. Do not look directly into the laser beam during 
operation of the scanner. 

Instruments avec lecteur de codes barres: 
Attention! Rayon laser. Des lésions oculaires graves peuvent se produire si vous 
regarder directement dans le faisceau laser du lecteur de codes barres pendant le 
fonctionnement du scanner. Ce risque est noté par le symbole ci-contre. Ne pas 
regarder directement dans le faisceau laser pendant le fonctionnement du scanner. 

 Liquid Handling: 
Warning! Ultrasonic Energy. Ultrasonic energy is present in the ultrasonic cleaner 
reservoir (if equipped) when AUTOCLEAN programs are running. Avoid putting your 
fingers in the bath. Ultrasonic energy, in this application, can be destructive to human 
tissue. 

 



Manipulations des liquides: 
Attention! Energie ultrasonique. L'énergie ultrasonique est présente dans le 
réservoir nettoyeur à ultrasons (le cas échéant) lorsque les programmes en cours 
d'exécution sont AUTOCLEAN. Évitez de mettre vos doigts dans le bain. L'énergie 
ultrasonique, dans cette application, peut être gravement dangereux pour la peau.  

 ELx405: 
Warning! Direct Drain Waste. If installed, the direct drain waste system pumps 
waste fluids from the washer directly into a sink or tank and potentially into public 
waste water systems. Because the waste may be a biohazard, you must ensure that 
you are in compliance with your local or national government’s laws regarding safe 
disposal of the waste. 

Attention! Déchets de vidange directe. Si la pompe de vidange est installée sur 
votre appareil (en Option sur certains appareils) la pompe aspire les déchets 
directement du laveur et les reverse dans un évier ou une cuve et potentiellement 
dans les systèmes publics de traitement des eaux usées. Du fait que ces déchets 
peuvent potentiellement être nocifs, vous devez vous assurer que vous êtes en 
conformité avec les lois de votre gouvernement local ou national concernant 
l'élimination sans danger des déchets. 

 Precision: 
Warning! Moving Parts. The symbol on the pipette shuttle indicates a potential for 
personal injury. At any given time during instrument operation, the pipette shuttle 
may be moving. There are potential pinch points on the mechanism and opportunities 
for skin puncture with the pipette tips. Keep hands completely out of the way of the 
pipette shuttle when the instrument is in operation. 

Attention! Pièces en mouvement. Le symbole sur la navette-pipette indique un 
risque de blessure. À tout moment de l'utilisation, la navette-pipette peut être en 
mouvement. Il y a des points de pincement potentiels sur le mécanisme et les 
possibilités de perforation de la peau avec les embouts de pipette. Gardez les mains 
complètement hors de la voie de la navette-pipette lorsque l'appareil est en fonction. 

Warning! Liquids. Do not attempt to remove or replace supplies outside the 
expected supply replenishment windows. Interruptions to instrument movement can 
result in spilled fluids. 

Attention! Liquides. Ne tentez pas de retirer ou de remplacer les consommables en 
dehors des ouvertures prévues de réapprovisionnement. Les secousses apportées à 
l’instrument peuvent entraîner des renversements de fluides. 

 

Instruments with Lasers and/or LED Lights: 
Warning! Lasers/LED Lights. Serious eye injury may occur if you stare directly at 
the laser/LED during operation of the light. This hazard is noted by the symbol shown 
here. 

Instruments avec des lasers et/ou lumières LED: 
Attention! Lasers/lumières LED. Des lésions oculaires graves peuvent se produire 
si vous regarder directement le laser / LED pendant le fonctionnement de la lumière. 
Ce risque est noté par le symbole ci-contre. 



Precautions, Précautions 

 

Caution: Service. The instrument should be serviced by BioTek authorized personnel. 
Only qualified technical personnel should perform service procedures on internal 
components.  

Attention: Service. L'appareil doit être réparé par un personnel autorisé BioTek. Seul 
le personnel technique qualifié doit effectuer les procédures d'entretien des 
composants internes. 

 Caution: Spare Parts. Only approved spare parts should be used for maintenance. 
The use of unapproved spare parts and accessories may result in a loss of warranty 
and potentially impair instrument performance or cause damage to the instrument. 

Attention: Pièces detachees. Seulement des pièces détachées approuvées doivent 
être utilisées pour l'entretien. L'utilisation de pièces et accessoires non approuvées 
peut entraîner une annulation de la garantie et peut compromettre la performance de 
l’appareil ou causer des dommages à l'appareil. 

 Caution: Environmental Conditions. Do not expose the instrument to temperature 
extremes. For proper operation, ambient temperatures should remain within the range 
listed in the Specifications section in the operator’s manual. Performance may be 
adversely affected if temperatures fluctuate above or below this range. Storage 
temperature limits are broader. 

Attention: Conditions environnementales. Ne pas exposer l'appareil à des 
températures extrêmes. Pour un bon fonctionnement, les températures ambiantes 
doivent rester dans les limites indiquées dans la section Caractéristiques techniques 
du manuel de l'opérateur. La performance peut être affectée si la température fluctue 
au-dessus ou en dessous de cette fourchette. La limite de température de stockage 
est plus flexible. 

 Caution: Sodium Hypochlorite. Do not expose any part of the instrument to the 
recommended diluted sodium hypochlorite solution (bleach) for more than 20 minutes. 
Prolonged contact may damage the instrument surfaces. Be certain to rinse and 
thoroughly wipe all surfaces. 

Attention: L'hypochlorite de sodium. Ne pas exposer les composants de 
l'instrument à la solution recommandée, l’hypochlorite de sodium dilué (eau de Javel) 
pour plus de 20 minutes. Un contact prolongé peut endommager les surfaces de 
l'appareil. Assurez-vous de rincer et essuyer soigneusement toutes les surfaces. 

 Caution: Disposal. This instrument contains printed circuit boards and wiring with 
lead solder. Dispose of the instrument according to Directive 2002/96/EC, “on waste 
electrical and electronic equipment (WEEE),” or local ordinances. 

Attention: L'élimination. Cet instrument contient des circuits imprimés et un 
câblage avec une soudure au plomb. Éliminer l'instrument conformément à la directive 
2002/96/CE, «déchets d'équipements électriques et électroniques (DEEE)," ou selon 
les lois locales. 

 Caution: Warranty. Failure to follow preventive maintenance procedures may void 
the warranty. 

Attention: Garantie. Le non-respect des procédures de maintenance préventive peut 
annuler la garantie. 



 Caution: Shipping Hardware. All shipping hardware must be removed before 
operating the instrument and reinstalled before repackaging the instrument for 
shipment. 

Attention: Hardware expédition. Tout le matériel de transport doivent être retirés 
avant de faire fonctionner l'appareil et réinstallé si expédition nécessaire. 

 Caution: Electromagnetic Environment. Per EN 61326-2-6 it is the user’s 
responsibility to ensure that a compatible electromagnetic environment for this 
instrument is provided and maintained in order that the device will perform as 
intended. 

Attention: L'environnement électromagnétique. En conformité avec la loi EN 
61326-2-6 il est de la responsabilité de l'utilisateur de s'assurer que l'environnement 
électromagnétique compatible pour cet appareil est fourni et entretenu, afin que le 
dispositif fonctionne comme prévu. 

 Caution: Electromagnetic Compatibility. Do not use this device in close proximity 
to sources of strong electromagnetic radiation (e.g., unshielded intentional RF 
sources), because these may interfere with the proper operation. 

Attention: Compatibilité électromagnétique. Ne pas utiliser cet appareil à 
proximité de sources de rayonnements électromagnétiques intenses (par exemple, les 
sources RF non blindés intentionnellement), car ceux-ci peuvent interférer avec le bon 
fonctionnement de l’appareil. 

Liquid Handling/De traitement des liquides 

 Caution: Buffer Solution. Although many precautions have been taken to ensure 
that the instrument is as corrosion-proof as possible, the instrument is not sealed and 
liquids can seep into sensitive components. Make sure that any spilled buffer solution 
is wiped off the instrument. Prolonged exposure to salt solution may corrode parts of 
the microplate carrier, movement rail, springs, and other hardware. 

Attention: Solution tampon. Bien que de nombreuses précautions ont été prises 
pour s'assurer que l'instrument est aussi résistant à la corrosion que possible, 
l'instrument n'est pas étanche et les liquides peuvent s'infiltrer dans les composants 
sensibles. Assurez-vous que toute solution tampon déversée est essuyée. Une 
exposition prolongée à la solution salée peut être corrosive aux microplaques, aux 
rails de l’appareil, aux ressorts et d'autres matériels. 

 Caution: Chemical Compatibility. Some chemicals may cause irreparable damage 
to the instrument. The following chemicals have been deemed safe for use in the 
instrument: buffer solutions (such as PBS), saline, surfactants, deionized water, 70% 
ethyl, isopropyl, or methyl alcohol, 40% formaldehyde, and 20% sodium hydroxide. 
Never use acetic acid, DMSO, or other organic solvents. These chemicals may cause 
severe damage to the instrument. ELx405: Use of wash buffers containing acetic acid 
is limited to instruments with PN 68098 Teflon® valves. Contact BioTek for more 
information and prior to using other questionable chemicals. 

Attention: Compatibilité chimique. Certains produits chimiques peuvent 
endommager à jamais l'appareil. Les produits chimiques suivants ont été jugés sûrs 
pour une utilisation avec l'appareil: des solutions tampons (tels que PBS), les solutions 
salines, des agents tensio-actifs, eau déminéralisée, éthyle, isopropyle 70%, ou de 
l'alcool de méthyle, formaldéhyde 40%, et de l'hydroxyde de sodium à 20%. Ne 
jamais utiliser de l'acide acétique, le DMSO, ou d'autres solvants organiques. Ces 
produits chimiques peuvent causer de graves endommagement à l'appareil. ELx405: 
Utilisation des tampons de lavage contenant de l'acide acétique est limitée aux 
instruments avec les vannes Teflon ® PN 68098. Contactez BioTek pour plus 
d'informations et avant d'utiliser d'autres produits chimiques douteux. 



 Caution: Bovine Serum Albumin. Solutions containing proteins, such as bovine 
serum albumin (BSA), will compromise the instrument’s performance over time unless 
a strict maintenance protocol is adhered to. See Maintenance procedures regarding 
BSA. 

Attention: Sérum albumine bovine. Solutions contenant des protéines, comme 
l'albumine sérique bovine (BSA), va compromettre les performances de l'instrument 
au fil du temps, sauf si un protocole de maintenance stricte est respectée. Voir les 
procédures de maintenance concernant BSA. 

 Caution: Power Supply. Only use the power supply shipped with the instrument, 
and operate it within the range of line voltages listed on it.  

Attention: Alimentation. Utilisez uniquement le bloc d'alimentation livré avec 
l'appareil et le faire fonctionner dans la plage de tension de ligne figurant sur celui-ci. 

 Caution: Do not run the MicroFlo Select without a cassette installed on the pump. 

Attention: Ne pas faire fonctionner la sélection MicroFlo sans cassette installé sur la 
pompe. 

Instruments with Barcode Scanners/ 
Instruments de Lecteurs de code-barres 

 Caution: Barcode Scanner Mirror. Do not scratch or damage the mirror when 
unpacking or installing the barcode scanner. 

Attention: Miroir lecteur de code-barres. Ne pas rayer ou endommager le miroir 
lors du déballage ou lors de l'installation du lecteur de code-barres. 

BioStack 

 Caution: Aligning Posts. When installing the BioStack’s four aligning posts, use 
caution not to cross thread these parts. Finger-tighten only! See the installation 
instructions. 

Attention: Messages pour alignements. Pour l'installation des quatre bloques 
BioStack, faites attention à ne pas entremêler les fils de ces pièces. Serrer 
seulement avec les doigts! Voir les instructions d'installation. 

ELx405/ELx406 

 Caution: Waste Sensor Port. (For customers who have purchased the BioStack 
Microplate Stacker for use with the instrument.) Although the waste sensor port on 
the back of the instrument is the same type as the 24-VDC power connector on the 
back of the BioStack, if an external 24-VDC power supply is plugged into the 
instrument’s port, it will permanently damage internal components.  

Attention: Port du capteur déchets. (Pour les clients qui ont acheté le BioStack 
microplaques Stacker pour une utilisation avec l'instrument.) Bien que le port du 
capteur déchets à l'arrière de l'appareil soit du même type que le connecteur 
d'alimentation 24 V cc sur le dos de la BioStack, si une alimentation externe 24 VDC 
est branché dans le port de l'instrument, les composants internes seront 
endommagés à jamais . 
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BioTek Instruments, Inc.

405 TS/LS Chemical Compatibility Chart

Table 1: Material/Where Used List

# Material Where Used
1 304 Stainless Steel Inlet screen, feeder tube to manifold, vacuum 

switch
2 316 Stainless Steel Dispense and aspirate tubes, feeder tube to 

manifold, spring in bottle fittings
3 Acetal Vacuum filtration plug
4 Aluminum (anodized) Microplate carrier, vacuum filtration carrier grill 

and retainer
5 CPVC (Chlorinated Polyvinyl 

chloride) Manifold, vacuum filtration carrier
6 Nylon Inlet fitting, vacuum switch adjustment screw, 

carrier leveling feet
7 PTFE (polytetrafluoroethylene)  

Teflon
Optional check valves (PN: 68098) for fluid 
pump, direct drain pump, fluid path

8 EPDM (Ethylene Propylene) Inlet valve, vacuum filtration 3-way valves, 
vacuum switch diaphragm

9 Neoprene Manifold channel-end seals
10 PPO (polyphenylene Oxide) 

Noryl®
Vacuum switch internal disc

11 Polycarbonate Vacuum switch body, Vacuum filtration 
intermediate waste bottle, direct drain 
intermediate waste bottle

12 Polyethylene Buffer bottle
13 Polypropylene Outlet fitting, fittings in bottles, inline fittings, 

float ball, bottle caps, vacuum filtration module 
bulkhead fittings

14 Polystyrene Flow sensor, mist shield, assay plates
15 PVC (Polyvinyl chloride) Inlet valve, waste sensor, flow sensor ball 

retainer, waste tubing, vacuum filtration plug
16 PPS (polyphenylenesulfide) 

Ryton® 
Fluid pump, vacuum filtration plug, inlet valve 
(serial # less than 207137)

17 Thermoplastic elastomer 
Santoprene® Fluid pump check valves

18 Silicone Inlet tubing, outlet tubing, o-rings, vacuum 
filtration carrier gasket, vacuum filtration 
module tubing

19 Ultem (polyetherimide) Outlet valve, CW inlet valve, vacuum filtration 
module valves

20 Viton Outlet valve, CW inlet valve



Appendix C: Chemical Compatibility

BioTek Instruments, Inc.

Table 2: Chemical Compatibility Ratings
 

Key 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
A - Excellent 
B - Good
C - Fair

D - Severe effect/Poor
ND - No data

Chemical 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20
Acetic Acid, 5% D A D B A D A ND B A A A A D D A C C A B
Acetic Anhydride B A D A D A A A B D D C B D D A A A ND D
Acetonitrile ND A ND B D A A C ND ND D A A D D A ND D D D

Ammonia 10% A A D A A A A ND A A D N A B B A A D D D
Benzyl Alcohol B B A B A B A B C D ND A A D D A A A ND A
Chloroform A A A B D A A D D D D D C D D A D D D A
Detergents 1% A A A B A A A A A A A A A A A A B A A A
Dimethylformamide A B D A D A A B D D D C A D D A D A ND C
DMSO (Dimethylsulfoxide) ND A ND A D A A B ND ND D A A D D A D C D D
Ethyl Alcohol 70% A A A A B A A A A A B B A A B A B B A B
Ethylene Oxide B B D D C D A C D A C A D C C D ND A ND C
Formaldehyde 37% A A A B A A A A B A A D A ND A A ND C A A
Hexane A A A A B B A D B B D A B D B A ND D A A
Hydrocholoric Acid 20% D D C D A D A A C B B A B C A D A D A A
Hydrofluoric Acid 20% D D D D C C A C B C D A A ND B A A D ND A
Hydrogen Peroxide 10% B B D A A A A A B A A A A A A C ND A A A
Isopropyl Alcohol 70% B A A A B D A A B A A B A A B A ND A A A
Methyl Alcohol 70% A A A A A B A A A A B A A ND A A B A A A
Methylene Chloride B B B C D C A ND D D D D B D D A D D D B
Phosphoric Acid >40% D D D C A B A A B A A A A B B A A C A A
Propylene Glycol B B B B C A A ND C ND B A A A C A ND A ND A
Sodium Chlorate A B A C A D A ND A A A N A ND A A A C ND A
Sodium Hydroxide 20% B B A D A A A B B A A A A A A A ND A A A
Sodium Hypochlorite <20% C C D D A D A B C A C A A A A C ND B B A
Sodium Hypochlorite 0.5% B B ND D A ND A B C ND C A A A A C ND B A A
Sulfuric Acid <10% D B D B A A A A B A A A A A A A A C A A
Trichloroethylene B B D D D C A ND D D ND D C D D A D D D A
Virkon 10% ND A ND D A A ND A ND ND A A A A A A ND A ND A

This ratings information was obtained from several reputable sources and our own experience at BioTek, but your 
experience may differ due to variations in concentration, temperature, and other factors. Consult the reagent/solvent 
manufacturer before use to verify its compatibility with instrument components.  
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